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1  Welcome to the Bluetooth options
The Bluetooth options R&S SMW-K60/-K117/-K178 are firmware applications that add
functionality to generate signals in accordance with the Bluetooth standard.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMW200A user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMW200A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMW200A service manual.

1.1  Key features

R&S SMW-K60 key features

Option R&S SMW-K60 provides Bluetooth signals for basic rate (BR) and enhanced
data rate (EDR) signals. These signals are in line with Bluetooth Core Specification
v4.2. Also, the option provides low energy (LE) signals for the LE 1 Msymbol/s physical
layer.

R&S SMW-K60 supports the following BR and EDR features:
● Support for three transport modes ACL+EDR, SCO and eSCO+EDR
● Support of all packet types for both the basic rate and the enhanced data rate

modes.
● Generation of signals with up to 5238 frames sequence length
● Configuration of the packet contents with a convenient packet editor or all data

packets, both with optional data whitening
● Generation of signals in line with the "Dirty Transmitter Test" specification. The test

enables you to change the start phase, the frequency drift rate and the frequency
drift deviation.

● Power ramp control with possibilities to choose ramp time, rise and fall offset
● Configuration of the clipping, filter and modulation settings

R&S SMW-K60 supports the following LE features:
● Support for two channel types, the "Advertising" and "Data" channel types
● Support of all Bluetooth packet types for LE 1 Msymbol/s physical layer (LE 1M

PHY).
● Convenient packet editor for all supported packet types including optional data

whitening

Key features

https://www.rohde-schwarz.com/manual/smw200a
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● Dirty transmitter test, compliant to the RF test specification with options to change
start phase, frequency drift rate and frequency drift deviation

● Support of CRC corruption for every 2nd packet
● Power ramp control with configurable ramp time, rise and fall offsets
● Clipping, filter and modulation settings supported

R&S SMW-K117 key features

Option R&S SMW-K117 is an extension to option R&S SMW-K60. It provides Bluetooth
LE signals in line with Bluetooth Core Specification v5.4.

Option R&S SMW-K117 supports the following LE features:
● Support for two channel types "Advertising" and "Data"
● Support of all Bluetooth packet types for uncoded LE 2 Msymbol/s physical layer

(LE 2M PHY)
● Support of all Bluetooth packet types for LE coded 1 Msymbol/s physical layer (LE

coded PHY)
● Support of CRC corruption for every 2nd packet
● Convenient packet editor for all supported packet types including optional data

whitening.
● Dirty transmitter test, compliant to the RF test specification with options to change

start phase, frequency drift rate, frequency drift deviation, and modulation index
mode.

● Support of Bluetooth Direction Finding using Constant Tone Extension methods
Angle of Arrival or Angle of Departure

R&S SMW-K178 key features

Option R&S SMW-K178 is an extension to option R&S SMW-K117. It provides Channel
Sounding of Bluetooth LE signals in line with the Bluetooth Channel Sounding specifi-
cation [2].

Option R&S SMW-K178 supports the following LE Channel Sounding features:
● Support of channel type "Channel Sounding"
● Support of Channel Sounding packet types CS SEQUENCE, Test Packet and CS

LL CONTROL PDUs
● Support of LE uncoded PHY "LE 2M 2BT" with PHY 2 Msymbol/s modulation and

bandwidth time product BT = 2
● Support CS subevent configuration
● Support CS step configuration including Mode-0, Mode-1, Mode-2 and Mode-3

configurations
● CS steps with user-defined random sequence or sounding sequence

For more information, refer to the Bluetooth Core Specification [1].

Key features
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1.2  Accessing the Bluetooth dialog

To open the dialog with Bluetooth settings

► In the block diagram of the R&S SMW200A, select "Baseband > Bluetooth".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.3  What's new

This manual describes firmware version FW 5.30.175.xx and later of the
R&S®SMW200A.

Compared to the previous version, it provides the new features listed below:
● Option Bluetooth 5.4 + Channel Sounding (R&S SMW-K178) related to the Blue-

tooth release providing Channel Sounding (CS) for Bluetooth LE devices, see
Chapter 2.3, "About Bluetooth LE Channel Sounding", on page 25.

● CS settings of option R&S SMW-K178:
– Chapter 5.1, "Channel settings", on page 44 including settings to configure

the channel type, packet type, packet PHY, CS event and CS role.
– Chapter 5.4, "CS subevent configuration", on page 91 including settings to

configure the CS subevent, channel table, CS security and channel selection.
– Chapter 5.4.5, "CS step configuration", on page 99 including CS step settings

to configure the main mode and the submode for subevent 0.
– Chapter 5.4.6, "CS step info", on page 108 including CS step information for

individual CS steps per subevent
– Chapter 5.5, "CS control data payload settings", on page 112 including settings

to configure the payload of CS_CONTROL_DATA PDUs.
● User-defined Sync Word in the test packet header for LE uncoded PHYs, see

"Sync Word" on page 131 and "User Pattern(hex)" on page 131.
● Payload type "Data List" added for a test packet, see "Payload Type" on page 131.
● Command for querying common filter type and EDR-specific filter type, see [:

SOURce<hw>]:BB:BTOoth:FILTer:FILTers? on page 284.
● Editorial changes

1.4  Documentation overview

This section provides an overview of the R&S SMW200A user documentation. Unless
specified otherwise, you find the documents at:

Documentation overview
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www.rohde-schwarz.com/manual/smw200a

1.4.1  Getting started manual

Introduces the R&S SMW200A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.4.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMW200A is not included.

The contents of the user manuals are available as help in the R&S SMW200A. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the inter-
net.

1.4.3  Tutorials

The R&S SMW200A provides interactive examples and demonstrations on operating
the instrument in the form of tutorials. A set of tutorials is available directly on the
instrument.

1.4.4  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

Documentation overview

https://www.rohde-schwarz.com/manual/smw200a
https://gloris.rohde-schwarz.com
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1.4.5  Instrument security procedures

Deals with security issues when working with the R&S SMW200A in secure areas. It is
available for download on the internet.

1.4.6  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.4.7  Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S SMW200A. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smw200a

1.4.8  Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

1.4.9  Release notes and open source acknowledgment

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

www.rohde-schwarz.com/firmware/smw200a

1.4.10  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

www.rohde-schwarz.com/application/smw200a

For some application sheets, see also:

www.rohde-schwarz.com/manual/smw200a

Documentation overview

https://www.rohde-schwarz.com/brochure-datasheet/smw200a
https://gloris.rohde-schwarz.com/calcert
https://www.rohde-schwarz.com/firmware/smw200a
https://www.rohde-schwarz.com/application/smw200a
https://www.rohde-schwarz.com/manual/smw200a
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1.4.11  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 1-1: Product search on YouTube

1.5  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMW200A user manual.

1.6  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots

https://www.youtube.com/@RohdeundSchwarz
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2  About the Bluetooth options
The R&S SMW200A provides you with the ability to generate signals in accordance
with the core specification 5.4 for Bluetooth wireless technology.

This section lists required options and provides background information on basic terms
and principles used in Bluetooth technology.

2.1  Required options

The basic equipment layout for generating Bluetooth signals includes the:
● Standard or wideband baseband generator (R&S SMW-B10/-B9) per signal path
● Baseband main module (R&S SMW-B13/-B13T
● Frequency option (e.g. R&S SMW-B1003)
● Option Bluetooth EDR (R&S SMW-K60)

One option per signal path
● Option Bluetooth 5.x (R&S SMW-K117), requires R&S SMW-K60

One option per signal path
● Option Bluetooth 5.4 + Channel Sounding (R&S SMW-K178), requires R&S SMW-

K117
One option per signal path

You can generate signals via playback of waveform files at the signal generator. To cre-
ate the waveform file with R&S WinIQSIM2, you do not need a specific option.

To play back the waveform file at the signal generator, you have two options:
● Install the R&S WinIQSIM2 option of the digital standard, for example, R&S SMW-

K255 for playing LTE waveforms.
● If supported, install the real-time option of the digital standard, for example,

R&S SMW-K55 for playing LTE waveforms.

For more information, refer to the specifications document.

2.2  About Bluetooth LE

The R&S SMW200A provides you with the ability to generate signals in accordance
with the Low Energy (LE) specification for Bluetooth wireless technology.

Bluetooth LE provides data transfer from low-power devices running on the smallest of
batteries to a larger device, for example, a PC or a mobile phone. Bluetooth LE estab-
lishes a connection, for example, to a wristwatch, a heart rate sensor, or a data transfer
from a digital camera. The generated packets do not support audio content.

A time division duplex (TDD) scheme for duplex transmission is defined. The frequency
band defined for Bluetooth devices is the unlicensed 2.4 GHz "Industrial, Scientific and
Medical" (ISM) frequency band.

About Bluetooth LE
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Table 2-1: Operating band

Frequency range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k = 0 to 39, f = k * 2 MHz + 2402 MHz

Table 2-2: Channel index

RF channel RF center frequency Data channel index Advertising channel index

0 2402 MHz - 37

1 to 11 2404 MHz to 2424 MHz 0 to 10 -

12 2426 MHz - 38

13 to 38 2428 MHz to 2478 MHz 11 to 36 -

39 2480 MHz - 39

Figure 2-1: RF channels

red = primary advertising channels
blue = data channels and secondary advertising channels

The minimum output power is -20 dBm. The maximum output power for LE is 20 dBm.
For more information on the limits of the output power level, see [1].

The following sections provide a detailed overview on LE signal characteristics:

● Packet formats for LE..............................................................................................14
● Packet types for LE.................................................................................................16
● Advertising channel packet structure...................................................................... 18
● Data channel packet structure................................................................................ 20
● Modulation scheme.................................................................................................20
● Direction finding...................................................................................................... 21

2.2.1  Packet formats for LE

Packet formats for LE uncoded PHY

The following packet format defines the LE uncoded physical layers (PHYs) LE 1M and
LE 2M. Advertising channel packets and data channel packets use this format.

CTEPreamble Access Address PDU CRC

Figure 2-2: LE uncoded PHY packet format

About Bluetooth LE
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Each packet consists of four mandatory fields: Preamble, Access Address, Protocol
Data Unit (PDU) and Cyclic Redundancy Check (CRC). For Bluetooth direction finding,
the optional field Constant Tone Extension (CTE) is at the end of the packet. See also
Chapter 2.2.6, "Direction finding", on page 21.
Table 2-3: LE uncoded PHYs and field lengths

PHY Preamble Access address PDU CRC CTE

LE 1M 1 octet 4 octets 2 octets to 257 octets 3 octets 16 µs to 160 µs

LE 2M 2 octets 4 octets 2 octets to 257 octets 3 octets 16 µs to 160 µs

When transmitting a packet, a Bluetooth receiver receives the preamble first and CTE
last. For packet transmission, the symbol rate stays the same but is different for differ-
ent PHYs. The table below provides an overview including the required option.

PHY Symbol rate Required options

LE 1M 1 Msymbol/s R&S SMW-K60

LE 2M 2 Msymbol/s R&S SMW-K117

The transmit time for an LE uncoded PHY packet is between 44 µs and 2120 µs. The
period extends by an additional period of 16 µs to 160 µs, if CTE is active.

Packet formats for LE coded PHY

The following packet format defines the PHY LE Coded. Advertising channel packets
and data channel packets use this format.

Preamble Access Address CI PDUTERM1 TERM2CRC

S = 8 coding S = 2 or S = 8 coding

FEC block 2FEC block 1

Figure 2-3: LE coded PHY packet format

Each packet consists of the Preamble, a Forward Error Correction (FEC) block 1, and
FEC block 2. The preamble is not coded. The FEC block 1 consists of three fields:
Access Address, Coding Indicator (CI), and TERM1. These fields use the S=8 coding
scheme. The CI field determines the coding scheme for the FEC block 2. The FEC
block 2 consists of three fields: PDU, CRC, and TERM2. These fields use either the
S=2 or S=8 coding scheme, depending on the value of the CI field.

The entire packet is transmitted with 1 Msymbol/s modulation. The following table cap-
tures the size and duration of the data packet fields.

About Bluetooth LE
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Table 2-4: Packet format for LE coded PHY

 Pream-
ble

Access
address

CI TERM1 PDU CRC TERM2

Number of uncoded bits 80 32 2 3 16 - 2056 24 3

Duration in µs for S=8 coding 80 256 16 24 128 - 16448 192 24

Duration in µs for S=2 coding 80 256 16 24 32 - 4112 48 6

Packets take between 462 μs and 17040 μs to transmit.

2.2.2  Packet types for LE

Test packet types

The test packet PDU consists of a PDU header and the payload field. The PDU header
indicates the payload content type and the payload length expresses in octets. RFU
field means reserved for future use.

PDU

Header
2 octets

Payload
0-255 octets

LSB MSB

PDU type
4 bits

RFU
4 bits

Length
8 bits

LE test packets are described in the "Air Interface Packets" section of the core specifi-
cation for Bluetooth wireless technology, volume 6, part B.

Advertising channel packet types

The advertising channel PDU has a 16-bit header and a variable-size payload. The
header fields of the advertising channel PDU are as shown in "Header" on page 18.
Table 2-5: Advertising packets for R&S SMW-K60

ADV_IND  SCAN_REQ

ADV_DIRECT_IND SCAN_RSP

ADV_NONCONN_IND CONNECT_IND

ADV_SCAN_IND  

Table 2-6: Advertising packets for R&S SMW-K117

ADV_EXT_IND  AUX_SCAN_REQ

AUX_ADV_IND AUX_SCAN_RSP

About Bluetooth LE
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AUX_CHAIN_IND AUX_CONNECT_REQ

AUX_SYNC_IND AUX_CONNECT_RSP

Data channel packet types

The data channel PDU has a 16-bit header, a variable size payload, and can include a
message integrity check (MIC) field as shown in "Header" on page 20.

The MIC field is not included in an unencrypted link layer (LL) connection, or in an
encrypted LL connection with a data channel PDU with a zero length payload. The MIC
field is included in an encrypted LL connection, with a data channel PDU with a non-
zero length payload. The MIC calculation is specified in the section 1 of the core speci-
fication for Bluetooth wireless technology, volume 6, part E.

Besides the data packet type, the instrument supports the following CONTROL_DATA
packet types.
Table 2-7: Control data packets for R&S SMW-K60

Opcode CONTROL_DATA  Opcode CONTROL_DATA

0x00 LL_CONNECTION_UPDATE_IND  0x07 LL_UNKNOWN_RSP

0x01 LL_CHANNEL_MAP_IND  0x08 LL_FEATURE_REQ

0x02 LL_TERMINATE_IND  0x09 LL_FEATURE_RSP

0x03 LL_ENC_REQ  0x0A LL_PAUSE_ENC_REQ

0x04 LL_ENC_RSP  0x0B LL_PAUSE_ENC_RSP

0x05 LL_START_ENC_REQ  0x0C LL_VERSION_IND

0x06 LL_START_ENC_RSP  0x0D LL_REJECT_IND

Table 2-8: Control data packets for R&S SMW-K117

Opcode CONTROL_DATA  Opcode CONTROL_DATA

0x0E LL_PERIPHERAL_FEAT_REQ  0x14 LL_LENGTH_REQ

0x0F LL_CONNECTION_PARAM_REQ  0x15 LL_LENGTH__RSP

0x10 LL_CONNECTION_PARAM_RSP  0x16 LL_PHY_REQ

0x11 LL_REJECT_EXT_IND  0x17 LL_PHY_RSP

0x12 LL_PING_REQ  0x18 LL_PHY UPDATE_IND

0x13 LL_PING_RSP  0x19 LL_MIN_USED_CHANNELS_IND

About Bluetooth LE
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2.2.3  Advertising channel packet structure

Header

PDU

Header
2 octets

Payload
1-255 octets

LSB MSB

PDU type
4 bits

RFU
1 bit

TxAdd
1 bit

ChSel
1bit

Length
8 bits

RxAdd
1 bit

● The possible PDU types, indicated in the header of advertising channel PDU, are
listed in the previous tables, see Table 2-5.

Table 2-9: PDU types and PHYs

PDU type PDU name Physical channel LE 1M LE 2M LE Coded

0000b ADV_IND Primary advertising Yes No No

0001b ADV_DIRECT_IND Primary advertising Yes No No

0010b ADV_NONCONN_IND Primary advertising Yes No No

0011b SCAN_REQ Primary advertising Yes No No

0011b AUX_SCAN_REQ Secondary advertising Yes Yes Yes

0100b SCAN_RSP Primary advertising Yes No No

0101b CONNECT_IND Primary advertising Yes No No

0101b AUX_CONNECT_REQ Secondary advertising Yes Yes Yes

0110b ADV_SCAN_IND Primary advertising Yes No No

0111b ADV_EXT_IND Primary advertising Yes No Yes

0111b AUX_ADV_IND Secondary advertising Yes Yes Yes

0111b AUX_SCAN_RSP Secondary advertising Yes Yes Yes

0111b AUX_SYNC_IND Secondary advertising Yes Yes Yes

0111b AUX_CHAIN_IND Secondary advertising Yes Yes Yes

1000b AUX_CONNECT_RSP Secondary advertising Yes Yes Yes

Others Reserved for future use

● The ChSel, TxAdd and RxAdd fields contain information specific to the PDU type.
If the ChSel, TxAdd or RxAdd fields are not defined as used in a given PDU then
they are reserved for future use.

● The Length field indicates the payload field length in octets.
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Payload

The advertising channel PDU types consist of three groups.
Table 2-10: Advertising channel PDU types

PDU type PDU name Option

Advertising PDU (legacy) ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND

R&S SMW-K60

Advertising PDU (extended) ADV_EXT_IND, AUX_ADV_IND, AUX_SYNC_IND,
AUX_CHAIN_IND

R&S SMW-K117

Scanning PDU SCAN_REQ, SCAN_RSP R&S SMW-K60

Scanning PDU AUX_SCAN_REQ, AUX_SCAN_RSP R&S SMW-K117

Initiating PDUs CONNECT_IND R&S SMW-K60

Initiating PDUs AUX_CONNECT_REQ, AUX_CONNECT_RSP R&S SMW-K117

Table 2-11: Advertising channel PDU fields and subfields

PDU name Field and parameter Option

ADV_IND, ADV_NON-
CONN_IND,
ADV_SCAN_IND

AdvA, AdvData R&S SMW-K60

ADV_DIRECT_IND AdvA, TargetA (formerly InitA) R&S SMW-K60

ADV_EXT_IND,
AUX_ADV_IND,
AUX_SYNC_IND,
AUX_CHAN_IND

Extended Header Length, AdvMode, Extended Header,
AdvData

Extended Header subfields: AdvA, TargetA, ADI,
AuxPtr, SyncInfo, Tx Power, ACAD, AdvData

R&S SMW-K117

SCAN_REQ ScanA, AdvA R&S SMW-K60

SCAN_RSP AdvA, ScanRspData R&S SMW-K60

AUX_SCAN_REQ ScanA, AdvA

Extended Header Length, AdvMode, Extended Header,
AdvData

Extended Header subfields: see above

R&S SMW-K117

CONNECT_IND InitA, AdvA, LLData

LLData subfields: AA, CRCinit, WinSize, WinOffset,
Interval, Latency, Timeout, ChM, Hop, and SCA fields

R&S SMW-K60

AUX_CONNECT_REQ InitA, AdvA, LLData

LLData subfields: see above

R&S SMW-K117

AUX_CONNECT_RSP Extended Header Length, AdvMode, Extended Header,
AdvData

Extended Header subfields: see above

R&S SMW-K117

For more information, refer to the section Advertising channel PDU in [1].
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2.2.4  Data channel packet structure

Header

PDU

Header
2 octets

Payload
0-251 octets

LSB MSB

LLID
2 bits

NESN
1 bit

MD
1 bit

SN
1 bit

Length
8 bits

RFU
3 bits

MIC
4 octets

The 16-bit header field consists of five fields:
● The LLID field of the header specifies the payload format, see "Payload"

on page 20.
● The NESN bit indicates a nextExpectedSeqNum used by the peer to acknowledge

the last PDU sent, or to request resending.
● The SN bit indicates a transmitSeqNum to identify packets sent by the link layer.
● The MD bit indicates, whether the device has more data to send.
● The Length field indicates the length of the payload and MIC if included.

Payload

● An LL data PDU is used to send L2CAP data. The LLID field is set to either 01b or
10b.
– For the LLID field set to 01b, the LL data PDU is a continuation fragment of an

L2CAP message, or an empty PDU.
The LL of the Central sends an empty PDU to the Peripheral to allow the
Peripheral to respond with any data channel PDU, including an empty PDU.

– For the LLID field set to 10b, the LL data PDU is a start of an L2CAP message
or a complete L2CAP message with no fragmentation.

● An LL control PDU is used to control the LL connection. The payload consists of
Opcode and CtrData fields. All LL control PDUs have a fixed length, depending on
the Opcode. The Opcode field identifies different types of LL Opcode PDU, see
Table 2-7.

For more information, refer to section Data channel PDU in [1].

2.2.5  Modulation scheme

The modulation is Gaussian frequency shift keying (GFSK) with a bandwidth bit period
product BT = 0.5. The modulation index is between 0.45 and 0.55. The mandatory
modulation scheme is 1 Msymbol/s modulation. It uses a shaped, binary FM to mini-
mize transceiver complexity.
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Option R&S SMW-K60 supports LE uncoded 1 Msymbol/s (LE 1M) physical layer
(PHY).

Option R&S SMW-K117 supports LE Coded 1 Msymbol/s PHY and an optional modu-
lation scheme LE uncoded 2 Msymbol/s (LE 2M) PHY.

2.2.6  Direction finding

Since Bluetooth version 5.1, a Bluetooth LE device can transmit its direction informa-
tion to a Bluetooth receiver. The information is transmitted in the direction finding
enabled packets in the LE uncoded PHY. In combination with location information sent
on profile-level, the Bluetooth LE receiver can calculate its position.

Angle of Arrival (AoA) method

A Bluetooth LE transmitter sends direction finding enabled packets using a single
antenna. A receiving Bluetooth LE peer device consists of an antenna array linked to
an RF switch which forwards the combined antennae signal to a Bluetooth LE receiver.

The peer device switches its antennae while receiving parts of the packets and captur-
ing I/Q samples. The I/Q samples are used to calculate the phase difference of the
radio signal received by different antennae of the array.

For an array of two antennae with distance d, frequency f of the radio signal and speed
of light c, the phase difference ψ calculates as follows:

The angle of arrival Θ is calculated as follows:
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Figure 2-4: Angle of Arrival method

Angle of Departure (AoD) method

A Bluetooth LE transmitter sends direction finding enabled packets using an antenna
array. A receiving Bluetooth LE device, consisting of a single antenna, captures I/Q
samples and the geometry of the antenna array from profile-level information.

For an array with two antennae with distance d, frequency f of the radio signal and
speed of light c, the phase difference ψ calculates as follows:

The angle of arrival Θ is calculated as follows:
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Figure 2-5: Angle of Departure method

The geometry of the antenna array is information that is shared between Bluetooth LE
transmitter and receiver on a profile-level. The antenna switching pattern and the
method of angle estimation is specified by Constant Tone Extension.

For more information, refer to the section Direction Finding Using Bluetooth Low
Energy in [1].

Constant tone extension

To transmit direction finding information in packets in the Bluetooth LE Uncoded PHYs,
the link layer packet format is extended by an optional field Constant Tone Extension
(CTE) as illustrated in Figure 2-2. The field has a length between 16 µs and 160 µs
and consists of a constantly modulated series of unwhitened 1s. This modulation
results in a CW tone shifted by 250 kHz (LE 1M) or 500 kHz (LE 2M) from the LE chan-
nel center frequency.

The presence, type and length of CTE is specified in the CTEInfo field available for
ADV_SYNC_IND and ADV_CHAIN_IND PDUs.

CTETime RFU CTEType

CTEInfo (8 bit)

Figure 2-6: CTEInfo field

The parts of the CTEInfo field are described in the table below. CTEType specifies if
the AoA or AoD method is used for direction finding.
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CTEInfo field Length Value Description

CTETime 5 bit 2 to 20 CTE length = 8 µs * Value

Other values are reserved for future use.

RFU 1 bit 1 to 2 Reserved for future use

CTEType 2 bit 0

1

2

3

AoA Constant tone extension

AoD Constant tone extension with 1 µs slots

AoD Constant tone extension with 2 µs slots

Reserved for future use

If Bluetooth LE devices support AoA/AoD CTE, the antennae within the array follow a
switching pattern specified by the Host. After a guard and reference period, timeslots of
1 µs or 2 µs provide periods for antenna switching and I/Q sampling.

The following figure illustrates the CTE structure for the AoA method. On the transmit-
ting side, there is no antenna switching. On the receiving side, antenna switching and
I/Q sampling alternate in the timeslots after the guard and reference period.

Figure 2-7: CTE structure for AoA method

The following figure illustrates the CTE structure for the AoD method. On the transmit-
ting side, antenna switching and I/Q sampling alternate in the timeslots after the guard
and reference period. On the receiving side, I/Q sampling is only in every second time-
slot after the guard and reference period.
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Figure 2-8: CTE structure for AoD method

For more information, refer to section 2.5 Constant Tone Extension and IQ Sampling of
core specification for Bluetooth wireless technology, volume 6, part B.

2.3  About Bluetooth LE Channel Sounding

This section provides basic information on Bluetooth LE Channel Sounding technology.
For the detailed information, refer to the Bluetooth specifications [2] and [1].

Channel Sounding architecture

Devices can use the LE Channel Sounding (CS) physical link to exchange information
for distance estimation calculations. A CS procedure, including the first CS event within
that procedure, is started offset from the timing of ACL connection event anchor points.
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A CS procedure exists only for a limited duration, and consists of CS events, CS sube-
vents, and CS steps.

CS events may contain one or more subevents. CS subevents contain two or more CS
steps. CS steps contain bilateral exchanges between the two CS peers known as the
initiator and reflector. The CS initiator transmits first in each step, followed by one or
more transmissions from the CS reflector. These transmissions may be a packet-based
GFSK-modulated exchange or a tone-based, amplitude shift keying modulated
exchange, or both.

Channel Sounding RF channels
Table 2-12: Operating frequency band

Frequency range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k = 0 to 78, f = k * 1 MHz + 2402 MHz

Some channels are not allowed for CS communication. The table Table 2-13 provides
an overview on allowed channels and not allowed channels including the channel
index and the center frequency of the channel.
Table 2-13: CS channel index and allowed channels

Channel index RF center frequency Channel allowed

0 and 1 2402 MHz and 2403 MHz No

2 to 22 2404 MHz to 2424 MHz Yes

23 to 25 2425 MHz to 2427 MHz No

26 to 76 2428 MHz to 2478 MHz Yes

77 and 78 2479 MHz and 2480 MHz No

Fractional frequency offset actuation error (FAE)

The FAE feature allows a device to adapt its frequency hopping pattern to avoid inter-
ference from other wireless devices operating in the same frequency band.

The feature uses a list of channels in the FAE table, which is periodically updated
based on the results of Channel Sounding procedures. When a device detects interfer-
ence on a particular channel, it can switch to a different channel from the FAE table to
avoid the interference.

2.4  About Bluetooth BR/EDR

The frequency band defined for Bluetooth devices is the unlicensed 2.4 GHz Industrial,
Scientific and Medical (ISM) frequency band.
Table 2-14: Operating band

Regulatory range RF channels k and center frequencies f

2400.0 MHz to 2483.5 MHz k = 0 to 78, f = k * 1 MHz + 2402 MHz
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Two modulation formats are used for Bluetooth: the mandatory basic rate (BR) and the
optional enhanced data rate (EDR). The BR mode uses binary FM modulation and pro-
vides a data rate of 1 Mbit/s. The EDR mode uses two types of PSK modulation, the
π/4-DQPSK or 8DPSK, and achieves data rates of 2 Mbit/s and 3 Mbit/s, respectively.
All modulation schemes have the symbol rate equal to 1 Msymbol/s.

A time division duplex (TDD) scheme for duplex transmission is defined for both
modes.

The following sections describe signal characteristics in detail:

● Bluetooth packet types for BR/EDR........................................................................27
● Bluetooth transport modes......................................................................................30
● Packet structure and fields......................................................................................30
● Bluetooth modulation schemes...............................................................................33

2.4.1  Bluetooth packet types for BR/EDR

2.4.1.1  ACL packets

The ACL packets are used for asymmetric links and they contain user data or control
data. The table and the figures below give an overview of the ACL packets and their
structure.
Table 2-15: ACL packet - basic rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

DM1 1 0-17 2/3   

DH1  0-27 no  1

DM3  0-121 2/3   

DH3 2 0-183 no Yes, 16-bit 3

DM5  0-224 2/3   

DH5  0-339 no  5

AUX1 1 0-29  no  

Figure 2-9: Packet structure of ACL packets - basic rate

About Bluetooth BR/EDR



About the Bluetooth optionsR&S®SMW-K60/-K117/-K178

28User Manual 1175.6803.02 ─ 26

Table 2-16: ACL packets - enhanced rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

2-DH1  0-54   1

2-DH3  0-367   3

2-DH5 2 0-679 no Yes, 16-bit 5

3-DH1  0-83   1

3-DH3  0-552   3

2-DH5  0-1021   5

Figure 2-10: Packet structure of ACL packets - enhanced data rate

2.4.1.2  SCO and eSCO packets

The SCO and eSCO packets are used for symmetric links. The SCO packets are used
for 64 kb/s speech transmission and for transparent synchronous data. The eSCO
packets are also used for 64kb/s speech transmission and transparent data at 64 kb/s
but also at other rates.

The tables and the figures below give an overview of the SCO and eSCO packets and
their structure.
Table 2-17: SCO packets

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

HV1  10 1/3   

HV2 n.a. 20  no  

HV3  30 2/3  n.a.

DV 1 (data only) 10+(0-9) 2/3 (data only) Yes, 16-bit
(data only)

 

Figure 2-11: Packet structure SCO packets

Figure 2-12: Packet structure SCO packets (data only)
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Table 2-18: eSCO packets - basic rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

EV3  1-30 no  1

EV4 n.a. 1-120 2/3 Yes, 16-bit 3

EV5  1-180 no (Data only) 3

Figure 2-13: Packet structure eSCO packets - basic rate

Table 2-19: eSCO packets - basic rate

Type Payload
Header (bytes)

User Payload
(bytes)

FEC CRC Slot number

2-EV3  1-60   1

2-EV5 n.a. 1-360 no Yes, 3

3-EV3  1-90  16-bit 1

3-EV5  1-540   3

Figure 2-14: Packet structure eSCO packets - enhanced data rate

2.4.1.3  Link control packets for ACL, SCO, eSCO transport modes

There are some common kinds of packet types. An overview of these packet types is
given in the table below.
Table 2-20: Common link control packets

Transport modes Type Payload
Header
(bytes)

FEC CRC Application

SCO, eSCO, ACL ID    Paging, inquiry, response

SCO, eSCO, ACL NULL n.a. n.a. n.a. Carries Link information to the source,
e.g. about successfully received signal
(ARQN) or the state of the receiving
buffer (FLOW)

SCO, eSCO, ACL POLL    Similar to NULL packet, used by the
Central to poll the Peripheral devices,
must be confirmed

SCO, ACL FHS 18 2/3 Yes Page Central response, inquiry
response, in roll switch
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Table 2-21: Common link control packets: packet structure

Packet Type ID Packet Types NULL and PULL Packet Types FHS

2.4.2  Bluetooth transport modes

There are three different transport modes defined in the Bluetooth core specification,
each of them with special applications:
● Synchronous connection-oriented (SCO)

The SCO transport mode is used for a symmetric point-to-point link establishment
between a Central and a specific Peripheral in the piconet.

● Extended synchronous connection-oriented (eSCO)
The eSCO transport mode is used for a symmetric or asymmetric, point-to-point
link establishment between the Central and a specific Peripheral.

● Asynchronous connection less (ACL)
The ACL transport mode is used for a point-to-multipoint link establishment
between the Central and all Peripheral participating on the piconet.

There are some common transmitted packets used by all transport modes and some
specific packets defined for each transport mode.

2.4.3  Packet structure and fields

Almost all Bluetooth transmitted packets have standard format and consist of the
access code, the header and the payload with useful information. The exceptions are
the ID packet which consists of the access code only and NULL and POLL packets
which carry only the access code and the header.

2.4.3.1  Access code

The access code is used for synchronization, DC offset compensation and identifica-
tion. The fields of the access code are shown in the figure below and their meaning is
explained in the table below.
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Table 2-22: The access code fields

Field Description Packets

Preamble A fixed zero-one pattern of 4 symbols, used to facili-
tate DC compensation

All packets

Sync word A 64-bit code word derived from a 24-bit address,
improves timing acquisition

All packets

Trailer A fixed zero-one pattern of four symbols, extended
DC compensation

All packets, except ID

2.4.3.2  Header

The header contains link control information. The fields of the header are shown in the
figure and their meaning is explained in the table below.

Table 2-23: The header fields

Field Description Packets

LT_ADDR Logical transport address, indicates the destination Peripheral for a packet in a
Central-to-Peripheral transmission slot and the source Peripheral for a Periph-
eral-to-Central transmission slot

 

TYPE Type code, specifies which packet type is used  

FLOW Flow control, used for flow control of packets over the ACL logical transport.
When the RX buffer in the recipient is full, a STOP indication must be returned.
When the RX buffer can accept data, a "Go" indication must be returned.

All packets,
except ID

ARQN Automatic repeat request number, acknowledgement indication, used to inform
the source of a successful transfer of payload data with CRC can be positive
acknowledged ACK or negative acknowledged NAK,

 

SEQN Sequential numbering scheme to order the data packet stream  

HEC Header-error-check to check the header integrity  

2.4.3.3  Payload format

The payload structure depends on the type of the data field and the data rate. Two
fields are defined in the payload: the synchronous data field and the asynchronous
data field. The ACL packets only have the asynchronous data field and the SCO and
eSCO packets only have the synchronous data field. The exception is DV of SCO
transport mode which has both data fields, synchronous and asynchronous.
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Synchronous data fields

Asynchronous data fields

Synchronous and asynchronous data fields

The meaning of some payload fields is given in the table below.
Table 2-24: The payload fields

Field Description

CRC The cyclic redundancy error check

Guard, sync The guard time and synchronization sequence, used for physical layer change of modula-
tion scheme

LLID The logical link identifier, specifies the logical link

Flow Field which controls the flow on the logical channels

The payload format and content of the FHS packet are different from other packets.
The fields of the FHS packet are shown in the figure below and their meaning is
explained in the table below.
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Table 2-25: The payload fields for the FHS packet

Field Description

Parity bits Form the first part of the sync word of the access code of the device that sends the FHS
packet

LAP Contains the lower address part of the device that sends the FHS packet

EIR An extended inquiry response, provides miscellaneous information during the inquiry
response procedure

Undefined Reserved for future use and must be set to zero

SR The scan repetition field, indicates the interval between two consecutive page scan win-
dows

Reserved Must be set to 10

UAP Contains the upper address part of the device that sends the FHS packet

NAP Contains the non–significant address part of the device that sends the FHS packet

Class of
device

Contains the class of device of the device that sends the FHS packet. This field is defined
in Bluetooth assigned numbers.

LT_ADDR Contains the logical transport address

CLK27-2 Contains the value of the native clock of the device that sends the FHS packet, sampled at
the beginning of the transmission of the access code of this FHS packet

Page scan
mode

Indicates which scan mode is used by default by the sender of the FHS packet

2.4.4  Bluetooth modulation schemes

The modulation used for the basic data rate packets is GFSK (Gaussian Frequency
Shift Keying) with a bandwidth bit period product BT = 0.5. The modulation index is
between 0.28 and 0.35.

The modulation scheme used for enhanced data rate packets changes within the
packet. The access code and packet header have a GFSK modulation scheme and are
transmitted with the basic rate 1 Mbps. The subsequent synchronization sequence,
payload and trailer sequence have a PSK type of modulation and are transmitted with
a data rate of 2 Mbps or optionally 3 Mbps.

The PSK modulation, namely π/4 rotated differential encoded quaternary phase shift
keying (π/4–DQPSK) is defined for the 2 Mbps transmission.

The PSK modulation, namely differential encoded 8-ary phase shift keying (8DPSK), is
defined for the 3 Mbps transmission.

The modulation types and corresponding packet types are given in the table below.
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Table 2-26: The modulation types and corresponding packet types

Modulation type Packet types

GFSK ID, NULL, POLL, FHS, DM1, DH1, DM3, DH3, DM5, DH5, AUX1, HV1, HV2, HV3,
DV, EV3, EV4, EV5

GFSK + π/4-DQPSK 2-DH1, 2-DH3, 2-DH5, 2-EV3, 2-EV5

GFSK + 8DPSK 3-DH1, 3-DH3, 3-DH5, 3-EV3, 3-EV5
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3  Bluetooth general settings
Access:

► Select "Baseband" > "Bluetooth".

The tab provides general settings to call default settings and the "Save"/"Recall"
settings. Also, it provides Bluetooth version information, Bluetooth mode settings
and access to further settings.

Settings:

State..............................................................................................................................35
Set To Default................................................................................................................35
Save/Recall................................................................................................................... 36
Generate Waveform......................................................................................................36
Bluetooth Version.......................................................................................................... 37
Bluetooth Mode............................................................................................................. 37
Transport Mode.............................................................................................................37
Dirty Transmitter Test.................................................................................................... 37
Filter/Clipping................................................................................................................ 37
Power Ramping.............................................................................................................38

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:STATe on page 166

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.
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Parameter Value

State Not affected by "Set To default"

Bluetooth version R&S SMW-K60: 4.2

R&S SMW-K117: 5.4

R&S SMW-K178: 5.4 + Channel Sounding

Bluetooth mode Basic Rate + EDR

Transport mode ACL(Asynchronous)+EDR

Packet type DH1

Sequence length 1 Frame

Slot timing Tx Test Mode

Data whitening Off

Dirty transmitter test Off

Filter Gauss(FSK)

Clipping state Off

Power ramping function Cosine

Trigger mode Auto

Marker mode Restart

Clock source Internal

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRESet on page 165

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog on page 165
[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD on page 165
[:SOURce<hw>]:BB:BTOoth:SETTing:STORe on page 166
[:SOURce<hw>]:BB:BTOoth:SETTing:DELete on page 165

Generate Waveform
With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension *.wv. You
can define the filename and the directory, in that you want to save the file.
Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate on page 167

Bluetooth Version
Displays the version of the standard that the firmware supports.
The displayed version for Bluetooth wireless technology depends on installed options.
For example, "Bluetooth Version" > "5.4" requires R&S SMW-K117.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:VERSion? on page 167

Bluetooth Mode
Selects the Bluetooth mode.
"Basic Rate + EDR"

Selects basic rate (BR) or enhanced data rate (EDR) Bluetooth
mode. For related settings, see Chapter 6, "Bluetooth BR/EDR con-
figuration and settings", on page 133.

"Bluetooth Low Energy"
Selects low energy (LE) Bluetooth mode. For related settings, see
Chapter 5, "Bluetooth LE configuration and settings", on page 44.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:BMODe on page 164

Transport Mode
Requires "Bluetooth Mode" > "Basic Rate + EDR".
Selects the transport mode.
"ACL(Asynchronous)+EDR"

The transport mode selected is used for a point-to-multipoint link
establishment between the Central and all the Peripheral devices par-
ticipating on the piconet.

"SCO(Synchronous)"
The transport mode selected is used for a point-to-point link estab-
lishment between a Central and a single Peripheral in the piconet.

"eSCO(Extended SCO)+EDR"
The transport mode selected is used for a symmetric or asymmetric
point-to-point link establishment between a Central and a specific
Peripheral.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TMODe on page 166

Dirty Transmitter Test
Opens a dialog to configure dirty transmitter tests.
See Chapter 4, "Dirty transmitter test settings", on page 39.

Filter/Clipping
Opens a dialog to configure the baseband filtering, the modulation settings and clip-
ping.
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The button also displays configured filters and the clipping state.
See Chapter 7.1, "Filter/clipping settings", on page 143.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:FILTers? on page 284
[:SOURce<hw>]:BB:BTOoth:CLIPping:STATe on page 283

Power Ramping
Opens a dialog to configure the power ramping.
See Chapter 7.2, "Power ramping settings", on page 149.
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4  Dirty transmitter test settings
Access:

1. Select "Bluetooth" > "General".

2. Select "Dirty Transmitter Test".

The dialog provides settings to configure dirty transmitter test settings. These set-
tings contain parameters that you can change for the central device signal. It is
used to test the connection under 'dirty transmitter' conditions, and to define the
influence on the receiver quality (bit error rate tests).

The following tables list dirty transmitter parameters according to the Bluetooth test
specification. foffset is the frequency offset, Δterror is the symbol timing error and h is the
modulation index.
Table 4-1: Dirty transmitter test parameters for BR

Set foffset Δterror/ppm h

1 75 -20 0.28

2 14 -20 0.30

3 -2 20 0.29

4 1 20 0.32

5 39 20 0.33

6 0 -20 0.34

7 -42 -20 0.29

8 74 -20 0.31

9 -19 -20 0.28

10 -75 20 0.35
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Table 4-2: Dirty transmitter test parameters for EDR

Set foffset Δterror/ppm

1 0 0

2 65 20

3 -65 -20

Table 4-3: Dirty transmitter test parameters for LE

Set foffset Δterror/ppm hstandard hstable *)

1 100 -50 0.45 0.495

2 19 -50 0.48 0.498

3 -3 50 0.46 0.496

4 1 50 0.52 0.502

5 52 50 0.53 0.503

6 0 -50 0.54 0.504

7 -56 -50 0.47 0.497

8 97 -50 0.50 0.500

9 -25 -50 0.45 0.495

10 -100 50 0.55 0.505

*) hstable requires R&S SMW-K117.

Settings:

Set To Default................................................................................................................40
Dirty Transmitter Test.................................................................................................... 41
Start Phase................................................................................................................... 41
Modulation Index Mode.................................................................................................41
Frequency Drift Rate..................................................................................................... 41
Frequency Drift Deviation(+/-).......................................................................................41
Number Of Packets Per Set/Number Of Steps Per Set................................................ 42
Dirty Transmitter Setting................................................................................................42

└ State................................................................................................................42
└ Carrier Frequency Offset (kHz).......................................................................42
└ Symbol Timing Error (ppm).............................................................................43
└ Modulation Index.............................................................................................43

Set To Default
Calls the default settings for the dirty transmitter test. Default settings are according to
the specification for Bluetooth wireless technology. The setting corresponds to the
selected Bluetooth mode.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:STDefault on page 170



Dirty transmitter test settingsR&S®SMW-K60/-K117/-K178

41User Manual 1175.6803.02 ─ 26

Dirty Transmitter Test
Enables the dirty transmitter test.
The setting is available for the following packet types:
● BR: DH1, DH3, DH5

For basic rate packets, each enabled set of parameters in the "Dirty Transmitter
Setting" is used for a duration of 20 ms. After 20 ms, the following enabled set is
used, continuing with the first enabled set after the sequence is completed.

● EDR: 2-DH1, 2-DH3, 2-DH5, 3-DH1, 3-DH3, 3-DH5, 2-EV3, 2-EV5, 3-EV3, 3-EV5
For EDR packets, the parameter sets apply for 20 packets each.

● LE: See the tables Table 5-1 and Table 5-2.
For LE packets, each enabled set of parameters in the "Dirty Transmitter Setting" is
used. After transmitting a configured number of packets or steps, the enabled set is
used. After the sequence is completed, the transmission continues with the first
enabled set.
You can set up to 50 packets or steps, see "Number Of Packets Per Set/Number
Of Steps Per Set" on page 42.

For more information, refer to the Bluetooth Core Specification [1].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState on page 168

Start Phase
Enters a start phase.
The start phase of the sine wave used to drift the modulated Bluetooth signal around
center frequency + carrier frequency offset is set here.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase on page 170

Modulation Index Mode
Requires option R&S SMW-K117 and "Bluetooth Mode" > "Bluetooth Low Energy".
Specifies the mode of the modulation index h that is standard or stable.
"Standard" Standard modulation index hstandard with a range from 0.450 to 0.550.

"Stable" Stable modulation index hstable with a range from 0.495 to 0.505.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode on page 169

Frequency Drift Rate
Sets the frequency drift rate.
A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset with the set frequency drift rate.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate on page 169

Frequency Drift Deviation(+/-)
Sets the frequency drift deviation.
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A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset. The maximum deviation reached during the drift equals the set
frequency drift deviation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation on page 169

Number Of Packets Per Set/Number Of Steps Per Set
Setting the parameter requires "Bluetooth Mode" > "Bluetooth Low Energy" and one of
the following:
"Number Of Packets Per Set"

Requires "Channel Type" > "Advertising" or "Data".
Sets the number of transmitted packets per enabled dirty transmitter
set.

"Number Of Steps Per Set"
Requires "Channel Type" > "Advertising" or "Data".

Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet on page 170

Dirty Transmitter Setting
Indicates the dirty transmitter parameters according to the Bluetooth test specification.

State ← Dirty Transmitter Setting
Enables the corresponding parameter set.
If deactivated, the parameters are skipped in the sequence, and the next active set is
used.
Remote commands ...:LONG:SET<ch>:... are used for BR and LE packets. The
instrument provides a configuration of up to 10 sets (SET1 to SET10).
Remote commands ...:SHORt:SET<ch>:... are used for EDR packets. The
instrument provides a configuration of up to 3 sets (SET1 to SET3).
For basic rate packets, each enabled set applies to 20ms of signal. For EDR packets,
each enabled set applies to 20 packets.
For LE, each enabled set applies to 50 test packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STATe
on page 172
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STATe
on page 173

Carrier Frequency Offset (kHz) ← Dirty Transmitter Setting
Determines a carrier frequency offset.
The center frequency of the modulated RF carrier is offset by the specified value.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:CFOFfset
on page 171
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:CFOFfset
on page 173
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Symbol Timing Error (ppm) ← Dirty Transmitter Setting
Sets the symbol timing error in ppm.
The symbol timing error modifies the symbol clock frequency by the specified value.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STERror
on page 173
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STERror
on page 174

Modulation Index ← Dirty Transmitter Setting
Sets the modulation index.
The modulation index h specifies the frequency deviation, defined as:

 is the symbol rate and  is the frequency deviation.
The modulation index can vary between 0.28 and 0.35.
For more information, refer to the Bluetooth Core Specification [1].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:MINDex
on page 171
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5  Bluetooth LE configuration and settings
Access:

1. Select "Baseband" > "Bluetooth".

2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

The remote commands required to define these settings are described in Chapter 8,
"Remote control commands", on page 161.

Settings:

● Channel settings..................................................................................................... 44
● Advertising event and frame configuration..............................................................51
● Advertising and data packet configuration.............................................................. 58
● CS subevent configuration......................................................................................91
● CS control data payload settings...........................................................................112
● Test packet configuration...................................................................................... 129

5.1  Channel settings

Access:

1. Select "Bluetooth" > "General".

2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

3. Select "Channel".

Channel settings
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The tab provides settings to configure channel settings and general packet set-
tings.

To display Bluetooth LE event or frame sequences

Depending on the channel type packet type and packet format, the "Channel" tab dis-
plays a chart at the bottom that illustrates sequences of the corresponding events or
frames. The following steps provide examples to illustrate default sequences for differ-
ent channel types.

1. To display the sequence for an advertising channel, select the following:

a) Select "Channel Type" > "Advertising".
b) Select, for example, "Packet Type" > "ADV_DIRECT_IND".

The chart displays one sequence of ADV_DIRECT_IND packets including markers
for event start and event stop.

2. To display the sequence for a data channel, select the following:

a) Select "Channel Type" > "Data".
b) Select, for example, "Packet Type" > "DATA".

The chart displays one sequence of data PDUs including markers for event start
and event stop.

3. To display the sequence for a Channel Sounding channel, select the following:

a) Select "Channel Type" > "Channel Sounding".
b) Select, for example, "Packet Type" > "CS SEQUENCE".

The chart displays one sequence of CS events including event offset, CS sube-
vents and subevent lengths.

Channel settings
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Settings:

Channel Type................................................................................................................ 46
Packet Type.................................................................................................................. 46
Packet Format...............................................................................................................48
Duty Cycle.....................................................................................................................48
Sequence Length.......................................................................................................... 48
Bluetooth Controller Role.............................................................................................. 48
Bluetooth Controller State............................................................................................. 49
Corrupted CRC Every 2nd Packet................................................................................ 49
Payload Type................................................................................................................ 49
Duration.........................................................................................................................49
Modulation Format........................................................................................................ 49
Event Configuration/Frame Configuration.....................................................................50
CS Subevent Configuration...........................................................................................50
Test Packet Configuration............................................................................................. 50
Event Intervals/Event_Interval...................................................................................... 50
Connection Interval....................................................................................................... 50
Event Offset...................................................................................................................50
Role...............................................................................................................................50

Channel Type
Determines the channel type.
"Advertising" Selects channel type advertising.
"Data" Selects the data channel type.

Devices in a connected state transmit the data channel packets in
connection events with a start point and an interval.

"Channel Sounding"
Requires R&S SMW-K178.
Selects channel type Channel Sounding.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CTYPe on page 176

Packet Type
Selects the packet type that is the PDU type.
Available packet types depend on the channel type and installed options, see the fol-
lowing tables:
● For non-control data PDUs, see Table 5-1.
● For LE CONTROL_DATA PDUs, see Table 5-2.
● For LE Channel Sounding CS_CONTROL_DATA PDUs, see Table 5-3.
Table 5-1: Channel types and packet/PDU types

Channel type Packet/PDU type Option

Advertising ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND, SCAN_REQ, SCAN_RSP, CON-
NECT_IND

R&S SMW-K60

Advertising ADV_EXT_IND *), AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_REQ, AUX_SCAN_RSP,
AUX_CONNECT_REQ, AUX_CONNECT_RSP

R&S SMW-K117

Channel settings
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Channel type Packet/PDU type Option

Advertising TEST PACKET R&S SMW-K60

Advertising CONTINUOUS R&S SMW-K60

Data DATA R&S SMW-K60

Data CONTROL_DATA, see Table 5-2. See Table 5-2.

Data TEST PACKET R&S SMW-K60

Data CONTINUOUS R&S SMW-K60

Channel Sounding TEST PACKET R&S SMW-K178

Channel Sounding CS SEQUENCE R&S SMW-K178

Channel Sounding CS_CONTROL_DATA, see Table 5-3. R&S SMW-K178

*) PDU type ADV_EXT_IND is available for LE 1M PHY and LE coded PHY.
CONTROL_DATA packets/PDUs depend on the controller role and installed options.
Table 5-2: CONTROL_DATA PDU and controller role

CONTROL_DATA PDU Controller role Option

LL_CONNECTION_UPDATE_IND, LL_CHAN-
NEL_MAP_IND, LL_ENC_REQ, LL_FEATURE_REQ,
LL_PAUSE_ENC_REQ

Central R&S SMW-K60

LL_ENC_RSP, LL_UNKNOWN_RSP, LL_FEATURE_RSP,
LL_PAUSE_ENC_RSP

Peripheral R&S SMW-K60

LL_TERMINATE_IND, LL_START_ENC_REQ,
LL_START_ENC_RSP, LL_VERSION_IND,
LL_REJECT_IND

Central or Peripheral R&S SMW-K60

LL_PHY UPDATE_IND Central R&S SMW-K117

LL_PERIPHERAL_FEAT_REQ, LL_CONNEC-
TION_PARAM_RSP, LL_PHY_RSP, LL_MIN_USED_CHAN-
NELS_IND

Peripheral R&S SMW-K117

LL_CONNECTION_PARAM_REQ, LL_REJECT_EXT_IND,
LL_PING_REQ, LL_PING_RSP, LL_LENGTH_REQ,
LL_LENGTH__RSP, LL_PHY_REQ, LL_CTE_REQ,
LL_CTE_RSP, LL_PERIODIC_SYNC_IND,
LL_CLOCK_ACCURACY_REQ, LL_CLOCK_ACCU-
RACY_RSP

Central or Peripheral R&S SMW-K117

CS_CONTROL_DATA packets/PDUs are available for initiator and reflector Channel
Sounding devices.
Table 5-3: CS_CONTROL_DATA PDU

CS_CONTROL_DATA PDU Option

LL_CS_SEC_REQ, LL_CS_SEC_RSP, LL_CS_CAPABILITIES_REQ,
LL_CS_CAPABILITIES_RSP, LL_CS_CONFIG_REQ, LL_CS_CONFIG_RSP,
LL_CS_REQ, LL_CS_RSP, LL_CS_IND, LL_CS_TERMINATE_IND,
LL_CS_FAE_REQ, LL_CS_FAE_RSP, LL_CS_CHANNEL_MAP_IND

R&S SMW-K178

Channel settings
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How to: "To display Bluetooth LE event or frame sequences" on page 45
For more information, refer to the specifications document.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:UPTYpe on page 177

Packet Format
Selects the packet format that is the format according to the physical layer (PHY) that
supports the packet type or PDU type.
"LE 1M" LE uncoded PHY with 1 Msymbol/s modulation.
"LE 2M" Requires R&S SMW-K117.

LE uncoded PHY with 2 Msymbol/s modulation and bandwidth time
product BT = 0.5.

"LE Coded" Requires R&S SMW-K117.
LE coded PHY with 1 Msymbol/s modulation.

"LE 2M 2BT" Requires R&S SMW-K178.
LE uncoded PHY with 2 Msymbol/s modulation and bandwidth time
product BT = 2. The BT value in the GFSK filter settings is fixed to a
value "B*T" = "2.00".
See also "B*T" on page 144.

See also Table 2-9.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PFORmat on page 177

Duty Cycle
Requires R&S SMW-K117 and "Packet Type" > "ADV_DIRECT_IND".
Specifies the duty cycle for directed advertising.
"High" Transmits the "ADV_DIRECT_IND" packet expecting an advertising

event interval.
"Low" Transmits the "ADV_DIRECT_IND" packet expecting an advertising

event interval and advertising event delay.
See also "Advertising Event Interval" on page 52.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DCYCle on page 176

Sequence Length
Selects the number of frames or events depending on the packet type. The signal
repeats after this number.
The packet types SCAN_REQ, CONNECT_IND, AUX_SCAN_REQ and AUX_CON-
NECT_REQ define the sequence length in frames. All other packets use events.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:USLength on page 179

Bluetooth Controller Role
Requires "Channel Type" > "Advertising"/"Data".
Sets or displays the Bluetooth LE controller role depending on the channel type.

Channel settings
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Bluetooth controller
role

Channel type PDU type

Advertiser (read-only) Advertising ADV_IND, ADV_DIRECT_IND, ADV_NON-
CONN_IND, ADV_SCAN_IND, SCAN_RSP,
ADV_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_RSP, AUX_CON-
NECT_RSP, TEST PACKET

Scanner (read-only) Advertising SCAN_REQ, AUX_SCAN_REQ

Initiator (read-only) Advertising CONNECT_IND, AUX_CONNECT_IND

Central Data DATA, CONTROL_DATA

Peripheral Data DATA, CONTOL_DATA

See also "Payload" on page 19 and Table 5-2.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:BCRole on page 175

Bluetooth Controller State
Requires "Packet Type" > "Data"/"CONTROL_DATA".
Displays the state of the Bluetooth controller.
"Connected" The controller is connected and uses a data channel.
"Disconnected" The controller is disconnected.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:BCText? on page 164

Corrupted CRC Every 2nd Packet
If enabled, sets the ratio of packets with CRC faults to 50%. 50% of packets are gener-
ated with correct CRC. This setting is appropriate for packet error rate (PER) report
integrity tests.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CCRC:STATe on page 176

Payload Type
Requires "Packet Type" > "CONTINUOUS".
Sets the pattern for continuous packets. The transmitted packets do not contain packet
header information.
For supported payload types, refer to "Payload Type" on page 131.

Duration
Requires "Packet Type" > "CONTINUOUS".
Sets the duration of the continuous packet transmission.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DURation on page 180

Modulation Format
Requires "Packet Type" > "CONTINUOUS".

Channel settings
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Specifies the physical layer.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:MFORmat on page 179

Event Configuration/Frame Configuration
Opens the "Event Configuration" dialog, if the sequence length of the packet type is
expressed in events or opens the "Frame Configuration" dialog, if it is expressed in
frames, see Chapter 5.2, "Advertising event and frame configuration", on page 51.
Also, the button displays the data whitening state, see "Data Whitening" on page 59.

CS Subevent Configuration
Requires "Channel Type" > "Channel Sounding".
Opens the "CS Subevent Configuration" dialog, see Chapter 5.4, "CS subevent config-
uration", on page 91.

Test Packet Configuration
Requires "Packet Type" > "TEST PACKET".
Opens the "Test Packet Configuration" dialog, see Chapter 5.6, "Test packet configura-
tion", on page 129.
For Channel Sounding test packet settings, see "User Payload Pattern" on page 104
and "Select Data List" on page 104 for mode-1 subevents or mode-3 subevents. All
other settings are the same as for a CS subevent, see Chapter 5.4, "CS subevent con-
figuration", on page 91.

Event Intervals/Event_Interval
Requires R&S SMW-K178 and "Channel Type" > "Channel Sounding".
Sets the number of LE connection event intervals.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:EINTerval on page 191

Connection Interval
Requires R&S SMW-K178 and "Channel Type" > "Channel Sounding".
Sets the time of the LE connection interval. The anchor points of two consecutive CS
events define the length of this interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CINTerval on page 191

Event Offset
Requires R&S SMW-K178 and "Channel Type" > "Channel Sounding".
Sets the time between the anchor point of the LE connection event and the beginning
of the CS event.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:EOFFset on page 192

Role
Requires R&S SMW-K178 and "Channel Type" > "Channel Sounding".

Channel settings
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Sets the role of the Channel Sounding device.
"Initiator" Channel Sounding device initiates a CS procedure.
"Reflector" Channel Sounding device responds to a CS procedure.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:ROLE on page 192

5.2  Advertising event and frame configuration

Access:

1. Select "Bluetooth" > "General".

2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

3. In the "Channel" tab, select "Event Configuration" for event-type packets or "Frame
Configuration" for frame-type packets.

The "Event Configuration" or "Frame Configuration" dialog provides settings to con-
figure advertising channel events or frames or data channel events. Also it pro-
vides access to the packet configuration.
At the bottom of the dialog, the graphics show the distribution of the packets, the
physical channel mapping and the channel indices. The channel table gives an
overview of the used channels and their assignments.

Settings:

● Advertising event and frame settings......................................................................51
● Connection settings.................................................................................................54
● Channel table settings.............................................................................................56

5.2.1  Advertising event and frame settings

Access:

1. Select "Channel" > "Channel Type" > "Advertising".

Advertising event and frame configuration
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2. Select "Event Configuration" for event-type packets or "Frame Configuration" for
frame-type packets.

Figure 5-1: Event configuration for an advertising channel (advertiser)

Figure 5-2: Frame configuration for an advertising channel (scanner)

The "Advertising Settings" tab provides general settings to configure advertising
channel events or frames or data channel frames. Also it provides access to the
packet configuration.

Settings:

Advertising Event Interval............................................................................................. 52
Advertising Event Delay................................................................................................ 53
Periodic Advertising Interval..........................................................................................53
Scan Window................................................................................................................ 53
Scan Interval................................................................................................................. 53
Advertising Packet Interval............................................................................................53
Transmit Window Offset................................................................................................ 54
Transmit Window Size...................................................................................................54
Packet Configuration.....................................................................................................54

Advertising Event Interval
Requires a legacy or an extended advertising PDU, see Table 2-10.

Advertising event and frame configuration
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Sets the time interval between two consecutive advertising events, regarding the start-
ing points.
Remote command: 
For packet type ADV_DIRECT_IND and duty cycle high:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval on page 183
For all others:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval on page 183

Advertising Event Delay
Requires a legacy or an extended advertising PDU, see Table 2-10.
Sets a time delay between the start times of two consecutive advertising events. The
advertising event interval extends by this value.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay on page 182

Periodic Advertising Interval
Requires option R&S SMW-K117 and packet type AUX_SYNC_IND.
Sets the time interval between the start of two PDUs from the same advertising set.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
on page 187

Scan Window
Requires a scanning PDU with packet type SCAN_REQ or AUX_SCAN_REQ. The
PDU AUX_SCAN_REQ also requires option R&S SMW-K117.
Sets the length of the window during which the scanner is operating in the advertising
channel.
Note that the scan window is less or equal to the value of the scan interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINdow on page 189

Scan Interval
Requires a scanning PDU with packet type SCAN_REQ or AUX_SCAN_REQ. The
PDU AUX_SCAN_REQ also requires option R&S SMW-K117.
Sets the time interval between the starting points of two consecutive windows during
which the scanner is operating in an advertising channel.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTerval on page 188

Advertising Packet Interval
Requires a scanning PDU with packet type SCAN_RSP or AUX_SCAN_RSP. The
PDU AUX_SCAN_REQ also requires option R&S SMW-K117.
Sets the time interval between packets starting points of two consecutive packets in
the advertising channel.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval on page 184

Advertising event and frame configuration
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Transmit Window Offset
Requires packet type CONNECT_IND, AUX_CONNECT_REQ or AUX_CON-
NECT_RSP.
Displays the start point of the transmit window. For related settings, see "Transmit Win-
dow Offset" on page 77.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
on page 247

Transmit Window Size
Requires packet type CONNECT_IND, AUX_CONNECT_REQ or AUX_CON-
NECT_RSP.
Displays the start point of the transmit window for configuring advertising frames. For
related settings, see "Transmit Window Size" on page 77.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfo? on page 190

Packet Configuration
Opens the dialog to configure packets. See Chapter 5.3, "Advertising and data packet
configuration", on page 58.

5.2.2  Connection settings

Access:

1. Select "Channel" > "Channel Type" > "Data".

2. Select "Event Configuration".

The "Connection Settings" tab provides general settings to configure data channel
events. Also it provides access to the packet configuration.
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Settings:

No. Of Tx Packets/Event...............................................................................................55
Connection Event Interval............................................................................................. 55
LL Connection Mode..................................................................................................... 55
Long Term Key(hex)......................................................................................................56
Selected Data Channel Index....................................................................................... 56

No. Of Tx Packets/Event
Sets the number of TX packets per event.
Each connection contains at least one data channel packet. The maximum number of
packets per event is determined by the duration of the connection event interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber on page 188

Connection Event Interval
Requires packet type CONNECT_IND, AUX_CONNECT_REQ or DATA.
Set the time interval between the start points of two consecutive connection events.
Subsequent transmissions within an event are separated by this parameter to separate
connecting event starting points in time.
See also "Connection Event Interval" on page 78.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
on page 230

LL Connection Mode
Select the link layer connection mode.
To provide safe transmission of payload data, you can encrypt the data in the packet. If
encrypted, the payload data follows a 32-bit message integrity check (MIC field).
The following table shows data packets with limited encrypting or unencrypting. All
other data packets allow encrypting and unencrypting the data packet.
Table 5-4: Limited data packet encryption (R&S SMW-K60)

Packet type Encrypted Unencrypted

LL_ENC_REQ No Yes

LL_ENC_RSP No Yes

LL_START_ENC_REQ No Yes

LL_START_ENC_RSP Yes No

LL_PAUSE_ENC_REQ No Yes

LL_PAUSE_ENC_RSP Yes No
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"Un-encrypted" Payload data is transmitted without encoding. Example of packet type
data:

"Encrypted" The link layer connection runs in encrypted mode. Example of packet
type data:

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode on page 184

Long Term Key(hex)
For "LL Connection Mode" > "Un-encrypted", indicates the long-term key.
For "LL Connection Mode" > "Encrypted", sets the long-term key.
This key is the time that the controller needs to receive the long-term key from the
host. After this time, the controller is ready to enter into the last phase of encryption
mode setup.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey on page 185

Selected Data Channel Index
Displays the number of the first active data channel.
The data channel is selected for each connection event. The Central device and
Peripheral device determine the used data channel by selecting from the list of used
channels, see "Channel Table" on page 57.
Displays the data channel index currently selected.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SDCI? on page 188

5.2.3  Channel table settings

Access:

1. Follow the directions in Chapter 5.2, "Advertising event and frame configuration",
on page 51.
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2. Select "Channel Table"

The channel table displays all possible channels and their characteristics. Also you
can select the channel that you want to use for the generated packets.

Settings:

Channel Table
The channel table displays channel characteristics including the channel state.
Each row lists the configuration for a channel as per the data channel index. LSB rep-
resents data channel index 0 and the bit in position 36 represents data channel
index 36.
If you use the channel ("Used"), the channel bit is 1. If you do not use the channel
("Unused"), the channel bit is 0. The bits in positions 37, 38 and 39 are zero during
transmission and a receiver ignores them.
For a graphical representation
"Center Frequency"

Displays the center frequency of a channel.
"Channel Index"

Displays the channel index.
"Channel Type"

Displays the channel type.
"Channel State"

Sets if you use the channel ("Used") or not ("Unused"). You can only
use one channel.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:
CHANnel<ch0>:STATe on page 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:
CHANnel<ch0>:STATe on page 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DCMTable:CHANnel<ch0>:STATe
on page 182
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5.3  Advertising and data packet configuration

Access:

1. Select "Bluetooth" > "General".

2. "Bluetooth Mode" > "Bluetooth LE".

3. In the "Channel" tab, select the channel type, for example, "Channel Type" >
"Advertising".

4. Select "Event Configuration" event-type packets or "Frame Configuration" for
frame-type packets.

The "Event Configuration" or "Frame Configuration" dialog opens.

5. Select "Packet Configuration"

The dialog provides settings to configure the parameters of the selected packet
type.

Settings:

● Packet configuration settings.................................................................................. 58
● Header settings.......................................................................................................60
● CTEInfo settings......................................................................................................62
● Legacy advertising PDU payload settings...............................................................63
● Extended advertising PDU payload settings...........................................................66
● Scanning PDU payload settings..............................................................................74
● Initiating PDU payload settings............................................................................... 76
● Data channel PDU payload settings....................................................................... 79
● FeatureSet configuration settings........................................................................... 89

5.3.1  Packet configuration settings

Access:

► Select "Packet Configuration".

The "Packet Configuration" tab provides settings to configure the general packet
parameters. Also, it displays the main fields and field lengths of the selected packet
type.
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Settings:

Data Whitening..............................................................................................................59
Access Address............................................................................................................ 59
CRC Initial Value(hex)...................................................................................................60

Data Whitening
Enables data whitening.
Evenly distributed white noise is ideal for the transmission and real data can be forced
to look similar to white noise with different methods called "Data Whitening". Applied to
the PDU and CRC fields of all packet types, whitening is used to avoid long equal
sequences in the data bitstream.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening
on page 218

Access Address
Sets the access address of the link layer connection.
Bluetooth LE transmissions are based on an interface packet format that consists of a
preamble (8 bits) the access address (32 bits), the PDU and CRC (24 bits).
Access address is used to identify communications on a physical channel, and to
exclude or ignore packets on different physical channels. The channels are using the
same PHY channels in physical proximity.
The structure of the access address depends on the packet type:
● Data channel packets

The access address is a pseudo-random LL connection address, generated by the
initiator of the LL connection. The address has to follow some specific rules, which
are described in the Bluetooth LE technology.

● Advertising channel packets
The address is fixed to 01101011011111011001000101110001 with the leftmost bit
sent first and being the LSB.

This parameter is relevant for packet types in event or frame configurations of a data
channel or an advertising channel. See also Table 5-1.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress
on page 218

CRC Initial Value(hex)
Requires data channel PDU or an advertising channel PDU. For an advertising chan-
nel, also requires packet type CONNECT_IND or AUX_CONNECT_REQ.
Sets the initialization value for the 24-bit cyclic redundancy check (CRC) calculation. A
receiver receives a packet correctly after it passes the CRC.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue
on page 218

5.3.2  Header settings

Access:

1. Select "Packet Configuration".

2. Select "Header".

The tab provides settings to configure the packet header settings.

Settings:

NESN Start Value..........................................................................................................60
SN Start Value...............................................................................................................61
Channel Selection......................................................................................................... 61
CTEInfo Present............................................................................................................61
CTEInfo Configuration...................................................................................................61
Tx Address Type/Rx Address Type...............................................................................61

NESN Start Value
Requires a data channel packet that is not a test packet.
Sets the next expected sequence number (NESN). This number is the start value of
the next expected packet from the same device in the LL connection. You can set this
parameter for the first event. From the second event and later events, the field is
empty.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue
on page 219
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SN Start Value
Requires a data channel packet that is not a test packet.
Sets the sequence number of the packet. You can set this parameter for the first event.
From the second event and later events, the field is empty.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue
on page 219

Channel Selection
Requires option R&S SMW-K117.
Sets the algorithm of channel selection for advertising channel packets, see
Table 2-10.
"Algorithm #1" Channel selection only for connection events.
"Algorithm #2" Channel selection for connection events and periodic advertising

packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection

CTEInfo Present
Requires a data channel packet or a test packet.
Enables the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.
See also "Constant tone extension" on page 23.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent
on page 220

CTEInfo Configuration
Requires "CTEInfo Present" > "On".
Opens the "CTEInfo Configuration" dialog to configure CTE length and the CTE
method. See Chapter 5.3.3, "CTEInfo settings", on page 62.

Tx Address Type/Rx Address Type
Requires an advertising channel packet, see Table 2-10.
Selects the address type of a Bluetooth LE device. Depending on the Bluetooth con-
troller role, either the Tx or Rx or both address types are assigned.
The format of the device address differs depending on the selected address type. The
address type and corresponding packet types are as follows:
● "Tx" for the packet types ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,

ADV_SCAN_IND, SCAN_REQ, SCAN_RSP and CONNECT_IND
Within R&S SMW-K117 also with the packet types ADV_EXT_IND,
AUX_ADV_IND, AUX_CHAIN_IND, AUX_SYNC_IND, AUX_SCAN_REQ,
AUX_SCAN_RSP and AUX_CONNECT_REQ

● "Rx" for the packet types ADV_DIRECT_IND, SCAN_REQ and CONNECT_IND
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"Public" Allocates a unique 48-bit address to each Bluetooth LE device. Public
addresses use an organizational unique identifier (OUI) obtained from
the IEEE registration authority.

"Random" Allocates a 48-bit random static device address to each Bluetooth LE
device. A random address is optional. It can be directly generated by
the beacon.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe
on page 242

5.3.3  CTEInfo settings

Access:

1. Select "Packet Configuration".

2. Select "Header".

3. Select "CTEInfo Present" > "On".

4. Select "CTEInfo Configuration".

The dialog provides constant tone extension (CTE) settings for direction finding
including the CTE length and the CTE method. The settings are relevant for data
event configuration and all data channel packet types including test packets.
See also "Constant tone extension" on page 23.

Settings:

CTETime....................................................................................................................... 62
CTEType....................................................................................................................... 63
Antenna Number........................................................................................................... 63
AntennaX Gain..............................................................................................................63

CTETime
Sets the CTETime that is the length of the constant tone extension field.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe
on page 220

CTEType
Sets the type of constant tone extension. The type specifies the CTE AoA/AoD method
and for AoD the length of the switching and I/Q sampling slots.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe
on page 221

Antenna Number
Requires "CTEType" > "AoD(1us)"/"AoD(2us)".
Sets the number of antennas for the angle of departure (AoD) direction finding method.
You can select up to four antennas for direction finding.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber on page 221

AntennaX Gain
Requires "CTEType" > "AoD(1us)"/"AoD(2us)".
Sets the gain of the antenna "AntennaX", where X is 0 to 3 depending on the number
of antennas. You can set the antenna gain information of up for four individual anten-
nas for direction finding.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0> on page 221

5.3.4  Legacy advertising PDU payload settings

Access:

1. Select a legacy advertising PDU:

a) In the "Channel" tab, select "Channel Type" > "Advertising".
b) Select a legacy advertising PDU, for example "Packet Type" > "ADV_IND".

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".

3. Select "Payload".

The tab provides settings to configure the payload of the legacy advertising PDUs.
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For an overview of supported legacy advertising PDUs, see Table 2-10.

Settings:

Advertiser's Device Addr...............................................................................................64
Target's Device Addr..................................................................................................... 65
Data Source.................................................................................................................. 65
Data Length...................................................................................................................65

Advertiser's Device Addr
Sets the 48-bit device address of the advertiser.
This device address identifies the Bluetooth device. Devices use a public device
address or a random device address, see "Tx Address Type/Rx Address Type"
on page 61. For more information, see [1].
With Bluetooth wireless technology up to the version 4.2, the following address formats
are defined:
● "Public Address Type" is the unique 48-bit identity address of each Bluetooth LE

device.
The registration authority IEEE provides the address that consists of the following:
– LSB: 24 bits = company_assigned
– MSB: 24 bits = company_id

● "Random Address Type" is an optional 48-bit random static device address.
● "Private Address Type" is a resolvable 48-bit optional address.

A private address consists of the:
– LSB: 24 bits = hash
– MSB: 24 bits = random

Since version 5.0, the device address format is in accordance with BD_ADDR for
BR/EDR with the exception that LAP values does not apply. Unless the public device
address is also used for a BR/EDR controller.
● NAP: Selects the non-significant address part. The length of NAP is 16 bits or 4

hexadecimal figures.
● UAP: Selects the upper address part. The length of UAP is 8 bits or two hexadeci-

mal figures.
● LAP: Selects the lower address part. The length of LAP is 24 bits or 6 hexadecimal

figures.
The NAP+UAP can take any values except the 64 reserved LAP values: #H9E8B00 –
#H9E8B3F.
For the address formats of Bluetooth version 5.0 and later, install option R&S SMW-
K117.
For advertising channel PDU types, see "Payload" on page 19.
Remote command: 
Company_Assigned and Company_Id in the device address of an advertiser:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID
on page 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned
on page 225
NAP+UAP and LAP in the device address of an advertiser:
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap
on page 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP
on page 226

Target's Device Addr
TargetA field of the device address that is a scanner's device address or an initiator's
device address.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap
on page 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP
on page 226

Data Source
Selects the data source for data in the corresponding data subfield of the Payload field.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMW200A user manual.
● Section "File and data management" in the R&S SMW200A user manual.
● Section "Data list editor" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA
on page 231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:
DPATtern on page 231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:
DSELection on page 232

Data Length
Selects the length of the corresponding data subfield of the Payload field.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth
on page 232

5.3.5  Extended advertising PDU payload settings

Option: R&S SMW-K117

Access:

1. Select an extended advertising PDU:

a) In the "Channel" tab, select "Channel Type" > "Advertising".
b) Select an extended advertising PDU, for example "Packet Type" >

"ADV_EXT_IND".

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".

3. Select "Payload".

The tab provides settings to configure the payload of the extended advertising
PDUs.

For an overview of supported extended advertising PDUs, see Table 2-10.

● General settings......................................................................................................66
● Extended header settings....................................................................................... 67
● AdvDataInfo configuration settings......................................................................... 71
● AuxPtr configuration settings.................................................................................. 71
● SyncInfo configuration settings............................................................................... 73

5.3.5.1  General settings

Access:

► Select "Payload".
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The tab provides general settings to configure the payload of the extended adver-
tising PDUs.

Advertising Mode.......................................................................................................... 67
Extended Header.......................................................................................................... 67
Data Source.................................................................................................................. 67
Data Length...................................................................................................................67

Advertising Mode
Selects the mode of the advertisement in the AdvMode field.
"Non-conn&Non-scan"

Non-connectable and non-scannable
"Conn&Non-scan"

Connectable and non-scannable
"Non-conn&Scan"

Non-connectable and scannable
"Chained data" Fixed value for an AUX_CHAIN_IND PDU.
"Scan response"

Fixed value for an AUX_SCAN_RSP PDU.
"Connection response"

Fixed value for an AUX_CONNECT_RSP PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe
on page 227

Extended Header
Enables the extended header of an extended advertising PDU.
If enabled, displays a table with extended header settings, see Chapter 5.3.5.2, "Exten-
ded header settings", on page 67.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:
STATe on page 233

Data Source
See "Data Source" on page 65.

Data Length
See "Data Length" on page 65.

5.3.5.2  Extended header settings

Access:

► Select "Payload" > "Extended Header" > "On".
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If enabled, the R&S SMW200A signals the extended header for extended advertis-
ing PDUs.

The "Extended Header" table provides general settings to configure the extended
header. It also provides access to further settings of fields within the extended
header.

Settings:

AdvA..............................................................................................................................68
TargetA..........................................................................................................................68
CTEInfo......................................................................................................................... 68
AdvDataInfo.................................................................................................................. 69
AuxPtr........................................................................................................................... 69
SyncInfo/SyncInfo Configuration...................................................................................69
TxPow(dBm)................................................................................................................. 69
ACAD Length................................................................................................................ 70
ACAD............................................................................................................................ 70
AList / Pattern................................................................................................................70

AdvA
Enables the flag of the advertiser's device address (AdvA) subfield. If enabled, this
subfield is present in the Extened Header field.
For related settings, see "Advertiser's Device Addr" on page 64.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
AADDress:STATe on page 234

TargetA
Requires an advertising channel PDU that contains the TargetA field, see Table 2-11.
Enables the flag of the target's device address (TargetA) subfield. If enabled, this sub-
field is present in the Extened Header field.
For related settings, see "Advertiser's Device Addr" on page 64.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TADDress:STATe on page 235

CTEInfo
Requires a data channel packet including a test packet. See also "Constant tone
extension" on page 23.
Enables the flag of the CTEInfo subfield. If enabled, this subfield is present in the Ext-
ened Header field.
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Selecting "Conf" opens the CTEInfo configuration dialog to define the CTE length and
the CTE method for direction finding. See Chapter 5.3.3, "CTEInfo settings",
on page 62.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
CINFo:STATe on page 235

AdvDataInfo
Enables the flag of the advertising data information (AdvDataInfo) subfield. If enabled,
this subfield is present in the Extened Header field.
Select "Conf" to open further AdvDataInfo settings, see Chapter 5.3.5.3, "AdvDataInfo
configuration settings", on page 71.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
ADINfo:STATe on page 234

AuxPtr
Enables the flag of the AuxPtr subfield. If enabled, this subfield is present in the Ext-
ened Header field.
The presence of the AuxPtr subfield indicates that some or all advertisement data is in
a following auxiliary packet. The contents of the AuxPtr subfield describe this auxiliary
packet.
Select "Conf" to open further AuxPtr settings, see Chapter 5.3.5.4, "AuxPtr configura-
tion settings", on page 71.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
APTR:STATe on page 234

SyncInfo/SyncInfo Configuration
Requires packet type AUX_ADV_IND or LL_PERIODIC_SYNC_IND.
Enables the flag of the SyncInfo subfield. If enabled, this subfield is present in the Ext-
ened Header field. The presence of theSyncInfo field indicates the presence of a peri-
odic advertisement.
Select "Conf" to open further SyncInfo settings, see Chapter 5.3.5.5, "SyncInfo configu-
ration settings", on page 73.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
SINFo:STATe on page 235

TxPow(dBm)
Enables signaling and sets the required transmit power.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TPOWer:STATe on page 235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer
on page 246
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ACAD Length
Specifies the length of an additional controller advertising data (ACAD) field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth
on page 227

ACAD
Sets the pattern for additional controller advertising data (ACAD).
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMW200A user manual.
● Section "File and data management" in the R&S SMW200A user manual.
● Section "Data list editor" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD
on page 224

AList / Pattern
Sets one of the following:
● For "ACAD" > "Data List", selects the data list source file and directory.
● For "ACAD" > "Pattern", sets the pattern.
See also "ACAD" on page 70.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:
APATtern on page 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:
ASELection on page 225
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5.3.5.3  AdvDataInfo configuration settings

Access:

1. Select "Payload" > "Extended Header".

2. Select "AdvDataInfo" > "On".

3. Select "AdvDataInfo" > "Conf".

The "AdvDataInfo Configuration" section opens.

The section provides AdvDataInfo field settings and displays the structure of the
field graphically.

Settings:

Advertising Data ID(hex)
Sets the "Advertising Data ID" in the AdvDataInfo field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID
on page 226

Advertising Set ID(hex)
Sets the "Advertising Set ID" in the AdvDataInfo field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID
on page 229

5.3.5.4  AuxPtr configuration settings

Access:

1. Select "Payload" > "Extended Header".

2. Select "AuxPtr" > "On".

3. Select "AuxPtr" > "Conf".
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The "AuxPtr Configuration" dialog opens.

The "AuxPtr Configuration" tab provides AuxPtr field settings and displays the
structure of the field graphically.
The "Secondary Advertising Channel Table" tab lists the configuration of all 37 LE
channels and allows you to enable the channel that you want to use for secondary
advertising. For related settings, see Chapter 5.2.3, "Channel table settings",
on page 56.

Settings:

Clock Accuracy............................................................................................................. 72
Offset Units....................................................................................................................72
AUX Offset.................................................................................................................... 72
AUX PHY...................................................................................................................... 72

Clock Accuracy
Sets the clock accuracy of the advertiser used between the packet containing this data
and the auxiliary packet.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy
on page 229

Offset Units
Sets the units used by the AUX offset, see "AUX Offset" on page 72.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits
on page 228

AUX Offset
Sets the time from the start of the packet containing the AuxPtr field to the approximate
start of the auxiliary packet.
The parameter "Offset Units" affects the length of the AUX offset. Set the value at least
to the length of the packet plus 300 μs.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset
on page 228

AUX PHY
Specifies the physical layer used to transmit the auxiliary packet.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY
on page 228

5.3.5.5  SyncInfo configuration settings

Access:

1. Select "Payload" > "Extended Header".

2. Select "SyncInfo" > "On".

3. Select "SyncInfo" > "Conf".

The "SyncInfo Configuration" dialog opens.

The "SyncInfo Configuration" tab provides SyncInfo field settings and displays the
structure of the field graphically.
The "Secondary Advertising Channel Table" tab lists the configuration of all 37 LE
channels and allows you to enable the channel that you want to use for secondary
advertising. For related settings, see Chapter 5.2.3, "Channel table settings",
on page 56.

Sync Packet Offset........................................................................................................73
Offset Units....................................................................................................................74
Offset Adjust..................................................................................................................74
Periodic Adv Interval..................................................................................................... 74
Sleep Clock Accuracy................................................................................................... 74
Access Address............................................................................................................ 74
CRC Initial Value(hex)...................................................................................................74
Event Counter............................................................................................................... 74

Sync Packet Offset
Specifies the time from the start of the AUX_ADV_IND packet containing the SyncInfo
field to the start of the AUX_SYNC_IND packet.
The sync packet offset consists of multiples of the offset units, see "Offset Units"
on page 74.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
on page 246

Offset Units
Sets the offset units of the sync packet offset, see "Sync Packet Offset" on page 73.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits
on page 245

Offset Adjust
Adjusts the "Sync Packet Offset" automatically to the next value, which is a multiple of
the "Offset Units".
If "Offset Adjust" > "On", the "Sync Packet Offset" is 2.4567 s and "Offset Units" >
"300 us".
If "Offset Units" > "30 us", disables the offset adjust.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust
on page 242

Periodic Adv Interval
See "Periodic Advertising Interval" on page 53.

Sleep Clock Accuracy
See "Sleep Clock Accuracy" on page 79.

Access Address
See "Access Address" on page 59.

CRC Initial Value(hex)
See "CRC Initial Value(hex)" on page 60.

Event Counter
Counts the AUX_SYNC_IND packets that the SyncInfo field describes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter
on page 233

5.3.6  Scanning PDU payload settings

Access:

1. Select a scanning PDU:

a) In the "Channel" tab, select "Channel Type" > "Advertising".
b) Select a scanning PDU, for example "Packet Type" > "ADV_SCAN_REQ".
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2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".

3. Select "Payload".

The tab provides settings to configure the payload of the scanning PDUs.

For an overview of supported scanning PDUs, see Table 2-10.

Settings:

Scanner's Device Addr..................................................................................................75
Advertiser's Device Addr...............................................................................................75
Data Source.................................................................................................................. 75
Data Length...................................................................................................................75
Extended Header.......................................................................................................... 76

Scanner's Device Addr
Requires a SCAN_REQ PDU or an AUX_SCAN_REQ PDU.
Sets the 48-bit device address of the scanner.
For more information, see "Advertiser's Device Addr" on page 64.
Remote command: 
Company_Assigned and Company_Id in the device address of a scanner:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned
on page 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID
on page 225
NAP+UAP and LAP in the device address of a scanner:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap
on page 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP
on page 226

Advertiser's Device Addr
See "Advertiser's Device Addr" on page 64.

Data Source
Requires a SCAN_RSP PDU or an AUX_SCAN_RSP PDU.
For related settings, see "Data Source" on page 65.

Data Length
Requires a SCAN_RSP PDU or an AUX_SCAN_RSP PDU.
For related settings, see "Data Length" on page 65.
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Extended Header
Requires an AUX_SCAN_RSP PDU.
For related settings, see "Extended Header" on page 67 and Chapter 5.3.5.2, "Exten-
ded header settings", on page 67.

5.3.7  Initiating PDU payload settings

Access:

1. Select a scanning PDU:

a) In the "Channel" tab, select "Channel Type" > "Advertising".
b) Select a scanning PDU, for example "Packet Type" > "CONNECT_IND".

2. Select "Event Configuration"/"Frame Configuration" > "Packet Configuration".

3. Select "Payload".

The tab provides settings to configure the payload of the initiating PDUs.

For an overview of supported initiating PDUs, see Table 2-10.

Settings:

Initiator's Device Addr................................................................................................... 77
Advertiser's Device Addr...............................................................................................77
Transmit Window Size...................................................................................................77
Transmit Window Offset................................................................................................ 77
Connection Event Interval............................................................................................. 78
Peripheral Latency........................................................................................................ 78
LL Connection Timeout................................................................................................. 78
Show Data Channel Map Table/Hide Data Channel Map Table....................................79
Hop Length....................................................................................................................79
Sleep Clock Accuracy................................................................................................... 79
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Data Source.................................................................................................................. 79
Data Length...................................................................................................................79
Extended Header.......................................................................................................... 79

Initiator's Device Addr
Sets the 48-bit device address of the initiator.
For more information, see "Advertiser's Device Addr" on page 64.
Remote command: 
Company_Assigned and Company_Id in the device address of an initiator:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned
on page 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID
on page 225
NAP+UAP and LAP in the device address of an initiator:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap
on page 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP
on page 226

Advertiser's Device Addr
See "Advertiser's Device Addr" on page 64.

Transmit Window Size
Requires packet type CONNECT_IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_RSP. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
Sets the size of the transmit window for configuring advertising frames. The "Frame
Configuration" dialog also displays this setting.
The scan window size is less or equal to the value of the connection interval, see "Con-
nection Event Interval" on page 78.
Remote command: 
For advertising channels:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe
on page 248
For data channels:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize
on page 241

Transmit Window Offset
Requires packet type CONNECT_IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_RSP. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
Sets the start point of the transmit window for configuring advertising frames. The
"Frame Configuration" dialog also displays this setting.

Advertising and data packet configuration



Bluetooth LE configuration and settingsR&S®SMW-K60/-K117/-K178

78User Manual 1175.6803.02 ─ 26

Remote command: 
For advertising channels:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
on page 247
For data channels:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset
on page 241

Connection Event Interval
Requires packet type CONNECT_IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_REQ. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_REQ also require option
R&S SMW-K117.
Set the time interval between the start points of two consecutive connection events.
Also, this setting separates subsequent transmissions within an event to separate con-
necting event starting points in time.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval
on page 240

Peripheral Latency
Requires packet type CONNECT_IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_REQ. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_REQ also require option
R&S SMW-K117.
Sets the number of consecutive connection events that the Peripheral can ignore for
asymmetric link layer connections.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency
on page 245
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
on page 241

LL Connection Timeout
Requires packet type CONNECT_IND, AUX_CONNECT_REQ, LL_CONNEC-
TION_UPDATE_IND, LL_CONNECTION_PARAM_REQ or LL_CONNEC-
TION_PARAM_REQ. The PDUs AUX_CONNECT_REQ, LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_REQ also require option
R&S SMW-K117.
Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout
on page 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout
on page 240
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Show Data Channel Map Table/Hide Data Channel Map Table
Requires packet type CONNECT_IND or LL_CHANNEL_MAP_IND.
Shows or hides the data channel map table. For related settings, see Chapter 5.2.3,
"Channel table settings", on page 56.
Remote command: 
n.a.

Hop Length
Requires packet type CONNECT_IND.
Sets the difference from the current channel to the next channel.
The Central and the Peripherals determine the data channel in use for every connec-
tion event from the channel map. Hop_length is set for the LL connection and commu-
nicated in the CONNECT_IND packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth
on page 236

Sleep Clock Accuracy
Requires packet type CONNECT_IND or LL_PERIODIC_SYNC_IND.
Sets the clock accuracy of the Central device with a specified encoding. The Peripheral
device uses this parameter to determine the required listening windows in the LL con-
nection. It is a controller design parameter known by the controller.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy
on page 244

Data Source
Requires an AUX_CONNECT_RSP PDU.
For related settings, see "Data Source" on page 65.

Data Length
Requires an AUX_CONNECT_RSP PDU.
For related settings, see "Data Length" on page 65.

Extended Header
Requires an AUX_CONNECT_RSP PDU.
For related settings, see "Extended Header" on page 67 and Chapter 5.3.5.2, "Exten-
ded header settings", on page 67.

5.3.8  Data channel PDU payload settings

Access:

1. Select "Channel Type" > "Data".
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2. Select "Event Configuration" for event-type packets or "Frame Configuration" for
frame-type packets.

The "Event Configuration" or "Frame Configuration" dialog opens.

3. Select "Packet Configuration"

The dialog provides settings to configure the payload of advertising PDUs.

For an overview of supported advertising PDUs, see Table 2-10.

Settings:

Transmit Window Size...................................................................................................81
Transmit Window Offset................................................................................................ 81
Connection Event Interval............................................................................................. 81
Peripheral Latency........................................................................................................ 81
LL Connection Timeout................................................................................................. 81
Connection Instant........................................................................................................ 82
Show Data Channel Map Table/Hide Data Channel Map Table....................................82
Error Code(hex)............................................................................................................ 82
Random Vector(hex)..................................................................................................... 82
Encrypted DIVersifier(hex)............................................................................................ 82
Session Key iD(hex)......................................................................................................83
Initialization Vector(hex)................................................................................................ 83
Unknown Type(hex)...................................................................................................... 83
FeatureSet Length........................................................................................................ 83
FeatureSet Configuration.............................................................................................. 83
Version Number(hex).................................................................................................... 83
SubVersion Number(hex)..............................................................................................84
Company Id(hex)...........................................................................................................84
Min. Interval...................................................................................................................84
Max. Interval..................................................................................................................84
Preferred Periodicity......................................................................................................84
Ref. Connection Event Count........................................................................................85
Show Offset Setting Table/Hide Offset Setting Table.................................................... 85
Offset Setting Table.......................................................................................................85
Reject Opcode.............................................................................................................. 85
MaxRxOctets/MaxTxOctets.......................................................................................... 85
MaxRxTime/MaxTxTime................................................................................................86
TX PHYS/RX PHYS...................................................................................................... 86
M_TO_S_PHY/S_TO_M_PHY......................................................................................86
PHYs............................................................................................................................. 87

Advertising and data packet configuration



Bluetooth LE configuration and settingsR&S®SMW-K60/-K117/-K178

81User Manual 1175.6803.02 ─ 26

Min Used Channels.......................................................................................................87
ID(hex).......................................................................................................................... 87
SyncInfo Configuration..................................................................................................87
Connection Event Count............................................................................................... 87
Last Pa Event Counter.................................................................................................. 88
SID(hex)........................................................................................................................ 88
Address Type................................................................................................................ 88
Sleep Clock Accuracy................................................................................................... 88
PHY...............................................................................................................................88
Advertiser's Device Addr...............................................................................................89
Sync Connection Event Counter................................................................................... 89
MinCTELenReq.............................................................................................................89
CTETypeReq.................................................................................................................89

Transmit Window Size
Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
For related settings, see "Transmit Window Size" on page 77.

Transmit Window Offset
Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
For related settings, see "Transmit Window Offset" on page 77.

Connection Event Interval
Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
For related settings, see "Connection Event Interval" on page 78.

Peripheral Latency
Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
For related settings, see "Peripheral Latency" on page 78.

LL Connection Timeout
Requires packet type LL_CONNECTION_UPDATE_IND, LL_CONNEC-
TION_PARAM_REQ or LL_CONNECTION_PARAM_RSP. The PDUs LL_CONNEC-
TION_PARAM_REQ and LL_CONNECTION_PARAM_RSP also require option
R&S SMW-K117.
For related settings, see "LL Connection Timeout" on page 78.
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Connection Instant
Requires packet type LL_CONNECTION_UPDATE_IND, LL_CHANNEL_MAP_IND or
LL_PHY_UPDATE_IND. The PDU LL_PHY_UPDATE_IND also requires option
R&S SMW-K117.
Sets a connection instant for indicating the connection event at which the new connec-
tion parameters are taken in use.
Both the Central and the Peripheral have a 32-bit connection event counter per LL con-
nection. For the first event of the LL connection, the instant is zero and increments by
one on every elapsed connection event interval of the LL connection.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
on page 230

Show Data Channel Map Table/Hide Data Channel Map Table
Requires packet type LL_CHANNEL_MAP_IND.
Shows or hides the data channel map table. For related settings, see Chapter 5.2.3,
"Channel table settings", on page 56.
Remote command: 
n.a.

Error Code(hex)
Requires packet type LL_TERMINATE_IND, LL_REJECT_IND or
LL_REJECT_EXT_IND.
Sets an 8-bit error code. For an LL_TERMINATE_IND packet, informs the remote
device about the termination of the connection. For an LL_REJECT_IND packet, indi-
cates a rejected request.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe
on page 232

Random Vector(hex)
Requires the packet type LL_ENC_REQ and a Central Bluetooth controller.
Sets the random vector of the Central device for device identification.
The parameter is an initialization vector provided by the host in the
HCI_ULP_Start_Encryption command.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor
on page 244

Encrypted DIVersifier(hex)
Requires the packet type LL_ENC_REQ and a Central Bluetooth controller.
Sets the encrypted diversifier of the Central device for device identification. The param-
eter is an initialization vector provided by the host in the HCI_ULP_Start_Encryption
command.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
EDIVersifier on page 233

Session Key iD(hex)
Requires the packet type LL_ENC_REQ and a Central Bluetooth controller or
LL_ENC_RSP and a Peripheral Bluetooth controller.
Sets the portion of the Central or the portion of the Peripheral of the session key diver-
sifier (SKDm/SKDs).
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD
on page 238

Initialization Vector(hex)
Requires the packet type LL_ENC_REQ and a Central Bluetooth controller or
LL_ENC_RSP and a Peripheral Bluetooth controller.
Sets the portion of the Central or the portion of the Peripheral of the initialization vector
(IVm/IVs).
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector
on page 237

Unknown Type(hex)
Requires the packet type LL_UNKNOWN_RSP and a Peripheral Bluetooth controller.
Enables indication of an invalid control packet. The "CtrType" field indicates the value
of the LL control packet that caused the transmission of this packet.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe
on page 247

FeatureSet Length
Requires the packet type LL_FEATURE_REQ, LL_FEATURE_RSP or LL_PERIPH-
ERAL_FEATURE_REQ.
Displays the length of the feature set.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength
on page 236

FeatureSet Configuration
Requires the packet type LL_FEATURE_REQ, LL_FEATURE_RSP or LL_PERIPH-
ERAL_FEATURE_REQ.
Opens a dialog to enable or disable features within the link layer control PDU. See
"FeatureSet configuration table" on page 90.

Version Number(hex)
Requires packet type LL_VERSION_IND.
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Sets the version of the Bluetooth controller. It is an 8-bit value in hexadecimal repre-
sentation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber
on page 247

SubVersion Number(hex)
Requires packet type LL_VERSION_IND.
Sets a unique 16-bit value for each implementation or revision of an implementation of
the Bluetooth controller.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber
on page 246

Company Id(hex)
Requires packet type LL_VERSION_IND.
Sets the 16-bit company identifier of the manufacturer of the Bluetooth controller.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID
on page 230

Min. Interval
Requires option R&S SMW-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.
Displays the minimum allowed connection interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval
on page 185

Max. Interval
Requires option R&S SMW-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.
Sets the maximum allowed connection interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval
on page 185

Preferred Periodicity
Requires option R&S SMW-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.
Sets the preferred periodicity. This value is typically a multiple of the value of the con-
nection interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
PPERiodicity on page 187
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Ref. Connection Event Count
Requires option R&S SMW-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.
Sets connection event counter relative to the calculation of all valid offset fields Offset0
to Offset5.
See also "Offset Setting Table" on page 85.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount
on page 187

Show Offset Setting Table/Hide Offset Setting Table
Requires option R&S SMW-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.
Shows or hides the offset setting table, see "Offset Setting Table" on page 85.
Remote command: 
n.a.

Offset Setting Table
Requires option R&S SMW-K117 and packet types LL_CONNECTION_PARAM_REQ
or LL_CONNECTION_PARAM_RSP.
Sets the possible positions of the offset points of the LE connection. At these points,
you can update connection parameters relative to the reference connection event
count, see "Ref. Connection Event Count" on page 85.
"State" Enables the offset point state.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:OFFSet<ch0>:STATe on page 186

"Offset(ms)" Sets the offset value.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:OFFSet<ch0>:VALue on page 186

Reject Opcode
Requires option R&S SMW-K117 and packet type LL_REJECT_EXT_IND.
Sets the Opcode of a rejected control data PDU. For Opcode settings, see Table 2-7.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode
on page 243

MaxRxOctets/MaxTxOctets
Requires option R&S SMW-K117 and packet types LL_LENGTH_REQ or
LL_LENGTH_RSP.
Sets the maximum allowed payload length of a received packet (RX) or a transmitted
packet (TX).
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets
on page 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets
on page 238

MaxRxTime/MaxTxTime
Requires option R&S SMW-K117 and packet types LL_LENGTH_REQ or
LL_LENGTH_RSP.
Sets the maximum allowed time to receive (RX) a packet or to transmit (TX) a packet.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime
on page 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime
on page 239

TX PHYS/RX PHYS
Requires option R&S SMW-K117 and packet types LL_PHY_REQ or LL_PHY_RSP.
Sets preferred physical layers in receive direction (Rx) and transmit direction (Tx). For
permitted PHYs, see Table 2-9.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:
STATe on page 243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:
STATe on page 243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:
LCOD:STATe on page 243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:
STATe on page 243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:
STATe on page 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:
LCOD:STATe on page 244

M_TO_S_PHY/S_TO_M_PHY
Requires option R&S SMW-K117 and packet type LL_PHY_UPDATE_IND.
Sets the physical layers of the Central-to-Peripheral (C_TO_P) direction and Periph-
eral-to-Central (P_TO_C) direction.
For available PHYs, see Table 2-9.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
L1M:STATe on page 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
L2M:STATe on page 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:
LCOD:STATe on page 239
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
L1M:STATe on page 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
L2M:STATe on page 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:
LCOD:STATe on page 239

PHYs
Requires option R&S SMW-K117 and packet type LL_MIN_USED_CHANNELS_IND.
Sets the physical layers for which the Peripheral device has a minimum used channels
requirement. See also "Min Used Channels" on page 87.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:
STATe on page 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:
STATe on page 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:
STATe on page 242

Min Used Channels
Requires option R&S SMW-K117 and packet type LL_MIN_USED_CHANNELS_IND.
Sets the minimum number of channels to be used on the specified "PHYs" on page 87.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels
on page 239

ID(hex)
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Sets the ID of the identifier specified by the Host in the CtrData field. The value is in
hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID
on page 249

SyncInfo Configuration
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
For related settings, see "SyncInfo/SyncInfo Configuration" on page 69 and Chap-
ter 5.3.5.5, "SyncInfo configuration settings", on page 73.

Connection Event Count
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Specifies the connEventCount field in the CtrData field.
The count value is specified within the following range:
currEvent - 2^14 < connEventCount < currEvent+ 2^14
CurrEvent is the counter value for the connection event during transmission or retrans-
mission of the PDU.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount
on page 248

Last Pa Event Counter
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Sets the lastPaEventCounter field in the CtrData field.
The lastPaEventCounter value is typically equal to the PaEventCounter value in the
AUX_SYNC_IND PDU.
The values for lastPaEventCounter and EventCounter are as follows:
● Equal values
● Values with a difference of 1 (modulo 65536)
● Values representing LL_PERIODIC_SYNC_IND and AUX_SYNC_IND timing of

less than 5 seconds
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter
on page 249

SID(hex)
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Sets the SID field in the CtrData field. The value is in hexadecimal representation.
The SID is typically equal to the Advertising SID subfield of the advertising set pointing
to periodic advertising.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID
on page 251

Address Type
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Sets the address type in the CtrData field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe
on page 248

Sleep Clock Accuracy
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
For related settings, see "Sleep Clock Accuracy" on page 79.

PHY
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Sets the PHY field in the CtrData field. The value is set in a hexadecimal representa-
tion.
The PHY information indicates the PHY type during periodic advertising. The selection
is exclusive; enabling one PHY disables the other enabled PHY.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:
STATe on page 250
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:
STATe on page 250
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:
STATe on page 250

Advertiser's Device Addr
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
For related settings, see "Advertiser's Device Addr" on page 64.

Sync Connection Event Counter
Requires option R&S SMW-K117 and packet type LL_PERIODIC_SYNC_IND.
Sets the event counter for the sync connection.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter
on page 250

MinCTELenReq
Requires option R&S SMW-K117 and packet type LL_CTE_REQ.
Sets the minimum CTE length in the CtrData field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
on page 249

CTETypeReq
Requires option R&S SMW-K117 and packet type LL_CTE_REQ.
Sets the 2-bit constant tone extension type in the CtrData field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq
on page 220
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
on page 249

5.3.9  FeatureSet configuration settings

Option: R&S SMW-K117

Access:

1. In the "Channel" tab, select "Channel Type" > "Data".

2. Select a link layer control PDU that contains feature set information. These PDUs
are available for central or peripheral controllers.

3. For a central controller, proceed as follows:
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a) Select "Bluetooth Controller Role" > "Central".
b) Select "Packet Type" > "LL_FEATURE_REQ" or "LL_PERIPHERAL_FEA-

TURE_REQ".

4. For a peripheral controller, proceed as follows:

a) Select "Bluetooth Controller Role" > "Peripheral".
b) Select "Packet Type" > "LL_FEATURE_RSP" or "LL_PERIPHERAL_FEA-

TURE_REQ".

5. Select "Event Configuration" > "Packet Configuration".

6. Select "Payload" > "FeatureSet Configuration".

Opens a dialog to enable or disable features within the link layer control PDU. A
table lists all features that are available within the feature set of the PDU.

Settings:

FeatureSet configuration table
Displays available features within the link layer control PDU.
For configurable features, see the table Table 5-5. To enable the feature, select "Valid"
> "On" to the right of the feature.
Table 5-5: Link layer features: Bit number and feature

Bit Link layer feature Bit Link layer feature

0 LE encryption 14 Channel selection algorithm #2

1 Connection parameter request procedure 15 LE power class 1

2 Extended reject indication 16 Minimum Number of Used Channels procedure

3 Peripheral-initiated feature exchange 17 Connection CTE request

4 LE ping 18 Connectionless CTE response

5 LE data packet length extension 19 Connectionless CTE transmitter

6 LL privacy 20 Connectionless CTE receiver

7 Extended scanner filter policies 21 Antenna switching during CTE transmission (AoD)

8 LE 2M PHY 22 Antenna switching during CTE reception (AoD)

9 Stable modulation index - transmitter 23 Receiving constant tone extensions

10 Stable modulation index - receiver 24 Periodic advertising Sync transfer - sender

11 LE coded PHY 25 Periodic advertising Sync transfer - recipient
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Bit Link layer feature Bit Link layer feature

12 LE extended advertising 26 Sleep clock accuracy updates

13 LE periodic advertising 27 Remote public key validation

Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
FSBit<ch0>:STATe on page 236

5.4  CS subevent configuration

Option: R&S SMW-K178

Access:

1. Select "Bluetooth" > "General".

2. Select "Bluetooth Mode" > "Bluetooth Low Energy".

3. Select "Channel".

4. Select "Channel Type" > "Channel Sounding".

5. Select "Cs Subevent Configuration".

The dialog provides settings to configure Channel Sounding subevents.

For more information, refer to the Bluetooth Channel Sounding specification [2].

Settings:

● Subevent settings....................................................................................................91
● Channel table..........................................................................................................95
● CS security settings................................................................................................ 96
● Channel selection settings...................................................................................... 98
● CS step configuration..............................................................................................99
● CS step info...........................................................................................................108

5.4.1  Subevent settings

Access:

1. Select "Cs Subevent Configuration".
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2. Select "Subevent Settings".

The tab provides settings to configure subevent settings.

Settings:

Subevent Length........................................................................................................... 92
Subevent Interval.......................................................................................................... 92
Step Scheduling............................................................................................................ 93
Number of Subevents................................................................................................... 93
Subevent table.............................................................................................................. 93
Subevent....................................................................................................................... 94
Number of Steps........................................................................................................... 94
Subevent Space (µs).....................................................................................................94
T_FCS (µs)....................................................................................................................94
Mode-0 Steps................................................................................................................94
CS Step Config............................................................................................................. 94
CS Step Info..................................................................................................................94

Subevent Length
Sets the subevent length that is the duration of a CS subevent.
You can set values in multiples of 625 µs. Settable subevent lengths depend on the
number of event intervals, the connection interval, the event offset and the subevent
interval.
For more information, refer to the Bluetooth Channel Sounding specification [2].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:SLENgth on page 193

Subevent Interval
Sets the subevent interval. This interval is the time in multiples of 625 µs between the
beginning of a CS subevent and the beginning of the next CS subevent within the
same CS event.
For "Number of Subevents" = "1", the subevent interval is 0μs. For "Number of Sube-
vents" higher than "1", settable subevent intervals depend on the number of event
intervals, the connection interval, the event offset and the subevent length.
For more information, refer to the Bluetooth Channel Sounding specification [2].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:SINTerval on page 193
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Step Scheduling
Sets the CS step scheduling mode.
"Auto" Automatic CS step scheduling. The subevent length, the subevent

interval and the number of subevents are configurable.
The number of CS steps is 2.

"Manual" Manual CS step scheduling. The table Table 5-6 lists fixed CS param-
eters.
Table 5-6: CS parameters for manual step scheduling

Parameter Value

"Subevent Length" 1250 µs

"Subevent Interval" 0 µs

"Number of Subevents" 1

"Event Intervals" 2

"Connection Interval" 7.5 ms

"Event Offset" 500 µs

The number of CS steps is configurable.
For more information, refer to the Bluetooth Channel Sounding specification [2].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:SSCHeduling on page 194

Number of Subevents
Sets number of subevents. Settable values depend on the subevent interval.
For more information, refer to the Bluetooth Channel Sounding specification [2].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:SNUMber on page 194

Subevent table
Lists properties and settings of all configured subevents in a table. The number of rows
equals the number of subevents.

The table allows you to check or configure the following parameters for each subevent
individually:
● "Subevent" on page 94
● "Number of Steps" on page 94
● "Subevent Space (µs)" on page 94
● "T_FCS (µs)" on page 94
● "Mode-0 Steps" on page 94
● "CS Step Config" on page 94
● "CS Step Info" on page 94
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Subevent
Displays the subevent number "Subevent x" within a subevent interval. "x" ranges from
0 to 31 depending on the number of subevents, see "Number of Subevents"
on page 93.
Remote command: 
Via suffix SUBevent<ch>

Number of Steps
Sets or display the number of CS steps. Setting requires "Step Scheduling" > "Man-
ual". Settable minimum values are 1 or equal to the number of non-zero Mode-0 steps,
see "Mode-0 Steps" on page 94.
For more information, refer to the Bluetooth Channel Sounding specification [2].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:NOSTep on page 194

Subevent Space (µs)
Displays the subevent space in microseconds.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SSPace? on page 195

T_FCS (µs)
Sets the frequency change period (T_FCS) between consecutive CS steps. The period
ranges from 15 µs to 150 µs.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:TFCS on page 195

Mode-0 Steps
Sets the number of Mode-0 CS steps.
For "Step Scheduling" > "Auto", the range is 1 to 3. For "Step Scheduling" > "Manual",
the range is 0 to 3. For non-zero Mode-0 CS steps ("Mode-0 Steps" ≠ "0"), the mini-
mum number of CS steps equals the configured Mode-0 CS steps.
For more information, refer to the Bluetooth Channel Sounding specification [2].
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZSTeps on page 195

CS Step Config
Opens a dialog to configure CS steps, see Chapter 5.4.5, "CS step configuration",
on page 99.

CS Step Info
Opens a dialog that provides information on configured CS steps per subevent in a
table, see Chapter 5.4.6, "CS step info", on page 108.
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5.4.2  Channel table

Access:

1. Select "CS Subevent Configuration".

2. Select "Channel Table".

The tab lists general settings for all 78 Bluetooth LE channels in a table.

Settings:

Channel.........................................................................................................................95
Center Frequency (MHz)...............................................................................................95
Channel Index............................................................................................................... 96
Channel Type................................................................................................................ 96
Channel Allowed........................................................................................................... 96

Channel
Displays the channel number that consists of "Channel" and the channel index.
For example, for "Channel 0" the channel index is 0 and the center frequency is
2402 MHz. See also Table 2-13.
Remote command: 
Via suffix CHNNL<ch>

Center Frequency (MHz)
Displays the center frequency of the channel.
See also Table 2-13.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CFRequency?
on page 205
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Channel Index
Displays the channel index of the channel.
See also Table 2-13.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CINDex?
on page 206

Channel Type
Displays the channel type that is Channel Sounding for all channels.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CTYPe?
on page 206

Channel Allowed
Enables transmission of the subevent via the selected channel.
See also Table 2-13.
"Yes" Enables transmission of the subevent for the selected channel.
"No" Disables transmission of the subevent for the selected channel.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CALLowed
on page 206

5.4.3  CS security settings

Access:

1. Select "CS Subevent Configuration".

2. Select "CS Security".

The tab provides settings to configure CS security settings.
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Settings:

CS_IV_C(hex)............................................................................................................... 97
CS_IV_P(hex)............................................................................................................... 97
CS_IN_C(hex)...............................................................................................................97
CS_IN_P(hex)............................................................................................................... 97
CS_PV_C(hex)..............................................................................................................97
CS_PV_P(hex)..............................................................................................................97

CS_IV_C(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.
Sets the CS_IV_C parameter. The parameter is 64-bit in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CIVC on page 207

CS_IV_P(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_RSP.
Sets the CS_IV_P parameter. The parameter is 64-bit in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CIVP on page 207

CS_IN_C(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.
Sets the CS_IN_C parameter. The parameter is a 32-bit in hexadecimal representa-
tion.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CINC on page 208

CS_IN_P(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_RSP.
Sets the CS_IN_P parameter. The parameter is a 32-bit in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CINP on page 208

CS_PV_C(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.
Sets the CS_PV_C parameter. The parameter is 64-bit in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CSPVc on page 209

CS_PV_P(hex)
Requires packet type CS SEQUENCE or LL_CS_SEC_RSP.
Sets the CS_PV_P parameter. The parameter is 64-bit in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CPVP on page 209
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5.4.4  Channel selection settings

Access:

1. Select "CS Subevent Configuration".

2. Select "Channel Selection".

The tab provides settings to configure channel selection.

Settings:

CSFilteredChM(hex)..................................................................................................... 98
ChM_Repetition............................................................................................................ 98
ChSel............................................................................................................................ 98
Ch3cShape................................................................................................................... 99
Ch3cJump..................................................................................................................... 99

CSFilteredChM(hex)
Displays the value of the field CSFilteredChM.
This value determines the bit map for the Channel Sounding channel map update pro-
cedure. The parameter is 64-bit in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CFCHm? on page 209

ChM_Repetition
Sets the 3-bit ChM_Repetition field.
The value equals the number of cycles of the ChM field for non-Mode-0 CS steps
within a CS procedure.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CMRepetition on page 210

ChSel
Sets the algorithm to select the channels.
"Algorithm #3b"

Sets for Algorithm #3b channel selection algorithm.
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"Algorithm #3c"
Sets for Algorithm #3c channel selection algorithm.

Table 5-7: Algorithm #3c parameters

CSChannelJump seq1StartCh seq2StartCh maxRepsAllowed saltRate

2 1 76 1 2

3 77 0 1 2

4 78 0 2 2

5 78 0 2 2

6 76 1 3 2

7 74 1 3 2

8 76 0 3 2

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CSEL on page 210

Ch3cShape
Requires "ChSel" > "Algorithm #3c".
Sets the bits of the Ch3cShape field. The field has a length of 4 bits and sets the shap-
ing method of the rising and falling ramps of the channels.
The resulting shapes are incorporated into a shuffled channel map so that they appear
random, preserving equal channel distribution qualities.
"Hat Shape" Channel with a rising ramp and a falling ramp.
"X Shape" Channel with interleaved rising and falling ramps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CTCShape on page 211

Ch3cJump
Requires "ChSel" > "Algorithm #3c".
Determines the number of skipped channels when rendering the channel shapes. The
Ch3cJump field has a length of 1 octet and relates to the channel index values. See
also Table 5-7.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CTCJump on page 210

5.4.5  CS step configuration

Access:

1. Select "CS Subevent Configuration".

2. Select "Subevent Settings" > "Subevent 0" > "CS Step Config...".
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The "CS Step Config" tab of the "Structure for Subevent x" dialog opens.

The tab provides CS step settings for the first subevent "Subevent 0". If configured,
all following subevents share CS step configuration as subevent 0.

Settings:

● General settings....................................................................................................100
● Mode-0 config settings..........................................................................................102
● Mode-1 config settings..........................................................................................102
● Mode-2 config settings..........................................................................................104
● Mode-3 config settings..........................................................................................106

5.4.5.1  General settings

Access:

► Select "CS Step Config" > "General".

The tab provides CS step general settings for each subevent.

Settings:

Main_Mode................................................................................................................. 100
Sub_Mode...................................................................................................................101
Main_Mode_Max_Steps............................................................................................. 101
Main_Mode_Min_Steps.............................................................................................. 101
Main_Mode_Steps...................................................................................................... 101
Main_Mode_Repetition............................................................................................... 101
Sub_Mode_Steps........................................................................................................101

Main_Mode
Sets the main mode of the CS step.
"Mode-1" Mode-1 mode with no submode available.
"Mode-2" Mode-2 mode with submodes "Mode-1" and "Mode-3" available.
"Mode-3" Mode-3 mode with submode "Mode-2" available.
The table Table 5-8 provides an overview on available submodes per main mode.
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Table 5-8: CS step main modes and submodes

"Main_Mode" "Sub_Mode"

"Mode-1" "None"

"Mode-2" "None", "Mode-1", "Mode-3"

"Mode-3" "None", "Mode-2"

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMODe on page 196

Sub_Mode
Sets the submode of the main mode.
The table Table 5-8 provides an overview on available submodes per main mode.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMODe on page 197

Main_Mode_Max_Steps
Sets the maximum number of main mode steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMASteps on page 197

Main_Mode_Min_Steps
Sets the minimum number of main mode steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMISteps on page 197

Main_Mode_Steps
Displays the number of main mode CS steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMSTeps? on page 198

Main_Mode_Repetition
Sets the main mode repetition.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMRepetition on page 198

Sub_Mode_Steps
Sets the number of submode CS steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMSTep? on page 198
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5.4.5.2  Mode-0 config settings

Access:

► Select "CS Step Config" > "Mode-0 Config".

The tab provides Mode-0 CS step settings.

Settings:

T_IP1
Sets the time "T_IP1" for Mode-0 CS steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZERo:TIPO on page 198

5.4.5.3  Mode-1 config settings

Access:

1. Select "CS Step Config" > "General".

2. Select Mode-1 in the CS step main mode or submode:
● Select "Main_Mode" > "Mode-1".
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● Select "Main_Mode" > "Mode-2" and "Sub_Mode" > "Mode-1".

The tab provides Mode-1 CS step settings.

Settings:

T_IP1...........................................................................................................................103
Sequence Length........................................................................................................ 103
Sequence Type........................................................................................................... 103
User Payload Pattern.................................................................................................. 104
Select Data List........................................................................................................... 104

T_IP1
Sets the time "T_IP1" for Mode-1.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MONE:TIPO on page 198

Sequence Length
Sets the sequence length. The length is discrete and depends on the sequence type.

Sequence type Sequence length

Sounding sequence 32 bits, 96 bits

Random sequence 32 bits, 64 bits, 96 bits and 128 bits

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SEQLength on page 200

Sequence Type
Sets the sequence type.
"Sounding Sequence"

Sounding sequence
"Random Sequence"

Random sequence
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:STYPe on page 200

CS subevent configuration
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User Payload Pattern
Displaying the parameter "User Payload Pattern" requires the following:
● "Packet Type" > "TEST PACKET".
● "Main_Mode" > "Mode-1" or "Mode-3".

"Sub_Mode" > "Mode-1" or "Mode-3".
● In the "Mode-1 Config" or "Mode-3 Config", select "Sequence Type" > "Random

Sequence".
Sets a predefined pattern or user-defined data list as the data source for the user pay-
load.
"PRBS 9 sequence"/"PRBS 15 sequence"

Pseudo random bit sequences of the length 9 or 15 - transmission of
identical packet series.

Predefined pattern
"Repeated 11110000 sequence", "Repeated 10101010 sequence",
"Repeated 11111111 sequence", "Repeated 00000000 sequence",
"Repeated 00001111 sequence" or "Repeated 01010101 sequence"

"Use CS_SYNC_User_Payload"
Selects binary data from a user-defined data list file, see "Select Data
List" on page 104.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPPattern on page 201

Select Data List
Requires "User Payload Pattern" > "Use CS_SYNC_User_Payload".
See "Data Source" on page 65.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPAYload on page 200

5.4.5.4  Mode-2 config settings

Access:

1. Select "CS Step Config" > "General".

2. Select Mode-2 in the CS step main mode or submode:
● Select "Main_Mode" > "Mode-2".

CS subevent configuration
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● Select "Main_Mode" > "Mode-3" and "Sub_Mode" > "Mode-2".

The tab provides Mode-2 CS step settings.

Settings:

T_SW.......................................................................................................................... 105
N_AP...........................................................................................................................105
T_PM...........................................................................................................................105
T_IP2...........................................................................................................................105

T_SW
Sets the time "T_SW" for Mode-2.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TSW? on page 199

N_AP
Sets the number of antenna path in the N_AP field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:NAP? on page 199

T_PM
Sets the time "T_PM" for Mode-2.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TPM on page 199

T_IP2
Sets the time "T_IP2" for Mode-2 CS steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TIPT on page 200
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5.4.5.5  Mode-3 config settings

Access:

1. Select "CS Step Config" > "General".

2. Select Mode-3 in the CS step main mode or submode:
● Select "Main_Mode" > "Mode-3".
● Select "Main_Mode" > "Mode-2" and "Sub_Mode" > "Mode-3".

The tab provides Mode-3 CS step settings.

Settings:

T_SW.......................................................................................................................... 106
N_AP...........................................................................................................................106
T_PM...........................................................................................................................107
T_IP2...........................................................................................................................107
Sequence Length........................................................................................................ 107
Sequence Type........................................................................................................... 107
User Payload Pattern.................................................................................................. 107
Select Data List........................................................................................................... 108

T_SW
Sets the time "T_SW" for Mode-3.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TSW? on page 199

N_AP
Sets the "N_AP".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:NAP? on page 199
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T_PM
Sets the time "T_PM" for Mode-3.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TPM on page 199

T_IP2
Sets the time "T_IP2" for Mode-3.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TIPT on page 200

Sequence Length
Sets the sequence length. The length is discrete and depends on the sequence type.

Sequence type Sequence length

Sounding sequence 32 bits, 96 bits

Random sequence 32 bits, 64 bits, 96 bits and 128 bits

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SEQLength on page 200

Sequence Type
Sets the sequence type.
"Sounding Sequence"

Sounding sequence
"Random Sequence"

Random sequence
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:STYPe on page 200

User Payload Pattern
Displaying the parameter "User Payload Pattern" requires the following:
● "Packet Type" > "TEST PACKET".
● "Main_Mode" > "Mode-1" or "Mode-3".

"Sub_Mode" > "Mode-1" or "Mode-3".
● In the "Mode-1 Config" or "Mode-3 Config", select "Sequence Type" > "Random

Sequence".
Sets a predefined pattern or user-defined data list as the data source for the user pay-
load.
"PRBS 9 sequence"/"PRBS 15 sequence"

Pseudo random bit sequences of the length 9 or 15 - transmission of
identical packet series.

Predefined pattern
"Repeated 11110000 sequence", "Repeated 10101010 sequence",
"Repeated 11111111 sequence", "Repeated 00000000 sequence",
"Repeated 00001111 sequence" or "Repeated 01010101 sequence"

CS subevent configuration
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"Use CS_SYNC_User_Payload"
Selects binary data from a user-defined data list file, see "Select Data
List" on page 104.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPPattern on page 201

Select Data List
Requires "User Payload Pattern" > "Use CS_SYNC_User_Payload".
See "Data Source" on page 65.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPAYload on page 200

5.4.6  CS step info

Access:

1. Select "CS Subevent Configuration".

2. Select "Subevent settings" > "CS Step Config".

The "CS Step Config" dialog opens.

The dialog provides CS step settings for each subevent.

Settings:

5.4.6.1  Step table

Access:

► Select "CS Step Info" > "Step Table".

The tab provides the step table that lists the properties and settings for individual
CS steps per subevent. The number of rows equals the number of CS steps per
subevent. The table allows you to check or configure the following settings for each
CS step.

CS subevent configuration
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Settings:

Step.............................................................................................................................109
Mode Type.................................................................................................................. 109
Channel Index............................................................................................................. 110
CS Access Address.....................................................................................................110
Sounding Sequence Content/Random Sequence Content......................................... 110
Companion Signal....................................................................................................... 110
CS Tone Ext.................................................................................................................112

Step
Displays the number of the CS step "Step x". "x" depends on the number of main mode
steps, see "Main_Mode_Steps" on page 101.
Remote command: 
Via suffix STEP<st0>

Mode Type
Displays the mode type for individual CS steps.
The displayed mode type depends on the number of Mode-0 CS steps and the config-
ured main mode in the CS step configuration. See "Mode-0 Steps" on page 94 and
"Main_Mode" on page 100.

Example: 
This example assumes manual step scheduling for one subevent with three CS steps
and one mode-0 step. The CS step main mode is mode-3. Set as follows:
"Step Scheduling" > "Manual", "Number of Subevents" = "1", "Number of Steps" = "3",
"Mode-0 Steps" = "1" and "Main_Mode" > "Mode-3".

Select "CS Step Info..." to open the CS step table. The table displays the information
for three CS steps. The first step "Step 0" has the "Mode Type" > "Mode-0". The sec-
ond step "Step 1" and the third step "Step 2" have the "Mode Type" > "Mode-3"

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:MTYPe?
on page 202

CS subevent configuration
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Channel Index
Sets or displays the channel index for individual CS steps.
Setting the index requires "Step Scheduling" > "Manual"
See also Table 2-13.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CINDex
on page 203

CS Access Address
Sets or displays the 32-bit CS access address for individual CS steps.
Setting the address requires "Step Scheduling" > "Manual"
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CAADdress
on page 203

Sounding Sequence Content/Random Sequence Content
Displays the 128-bit content of a sounding sequence or a random sequence. The con-
tent depends on the subevent mode.
For CS test packets, you can set the content for a sounding sequence and random
sequence, see "Sequence Type" on page 103.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:SCONtent
on page 203

Companion Signal
Sets the companion signal and the data source.

CS subevent configuration



Bluetooth LE configuration and settingsR&S®SMW-K60/-K117/-K178

111User Manual 1175.6803.02 ─ 26

"Companion Signal"
Enables or disables the companion signal. This signal consists of one
or two signals that deviate symmetrically from the carrier frequency of
the wanted signal.
The carrier frequency is the center frequency of the channel that
relates to the channel index, see "Channel Index" on page 110.
You can select between the following values:
● "None":

Disables the companion signal.
● "-2"/"2"/"-2 and 2":

Requires "Packet Format" > "LE 1M".
Enables the companion signal with a deviation of -2 MHz or
2 MHz from the carrier frequency of the wanted signal. "-2 and 2"
enables two companion signals that deviate symmetrically from
the carrier by 2 MHz.

● "-4"/"4"/"-4 and 4":
Requires "Packet Format" > "LE 2M" or "LE 2M 2BT".
Enables the companion signal with a deviation of -4 MHz or
4 MHz from the carrier frequency of the wanted signal. "-4 and 4"
enables two companion signals that deviate symmetrically from
the carrier by 4 MHz.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:
STEP<st0>]:CSIGnal on page 204
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"Data Source" Requires "Companion Signal" ≠ "None".
Selects the data source.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog.
The dialog lists file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list inter-

nally or to edit an existing one.
– Use the standard "File Manager" function to transfer external

data lists to the instrument.
See also:
● Section "About data signals" in the R&S SMW200A user manual.
● Section "File and data management" in the R&S SMW200A user

manual.
● Section "Data list editor" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DATA
on page 204
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:PATTern
on page 205
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DLISt
on page 204

CS Tone Ext.
Displaying the CS tone extension requires the following:
● "Step Scheduling" > "Manual".
● "Number of Steps" higher than "Mode-0 Steps"

For example, "Number of Steps" = "2", "Mode-0 Steps" = "1".
● "Main_Mode" > "Mode-2" or "Mode-3"
Enables CS tone extension for mode-2 and mode-3 CS steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CTEXtension
on page 205

5.5  CS control data payload settings

Option: R&S SMW-K178

CS control data payload settings
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Access:

1. Select "Packet Configuration".

2. Select "Payload".

The tab provides settings to configure the packet/PDU payload.

● CS security payload settings.................................................................................113
● CS capabilities payload settings............................................................................113
● CS configuration payload settings.........................................................................119
● CS payload settings.............................................................................................. 122
● CS IND payload settings.......................................................................................126
● CS terminate payload settings.............................................................................. 128
● CS FAE payload settings...................................................................................... 128
● CS channel map payload settings.........................................................................129

5.5.1  CS security payload settings

For packet type LL_CS_SEC_REQ and LL_CS_SEC_RSP, the "Payload" tab provides
CS security settings. The table below lists available CS security settings per LL Control
PDU.

LL Control PDU CS security settings

LL_CS_SEC_REQ "CS_IV_C(hex)", "CS_IN_C(hex)", "CS_PV_C(hex)"

LL_CS_SEC_RSP "CS_IV_P(hex)", "CS_IN_P(hex)", "CS_PV_P(hex)"

For related settings, see Chapter 5.4.3, "CS security settings", on page 96.

5.5.2  CS capabilities payload settings

For packet type LL_CS_CAPABILITIES_REQ and LL_CS_CAPABILITIES_RSP, the
"Payload" tab provides the following settings.

CS control data payload settings
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Settings:

● CpbData 1 settings................................................................................................114
● CpbData 2 settings................................................................................................116
● CpbData 3 settings................................................................................................117

5.5.2.1  CpbData 1 settings

Mode_Types................................................................................................................114
RTT_Capability............................................................................................................114
RTT_AA_Only............................................................................................................. 114
RTT_Sounding_N........................................................................................................115
RTT_Random_Sequence_N....................................................................................... 115
NADM_Sounding_Capability.......................................................................................115
NADM_Random_Sequence_Capability...................................................................... 115
CS_SYNC_PHY_Capability........................................................................................ 115
Num_Ant......................................................................................................................115
Max_Ant_Path.............................................................................................................115
Role............................................................................................................................. 116
Companion_Signal...................................................................................................... 116

Mode_Types
Displays the LL Control packet mode type that is Mode-3.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MTYPe? on page 260

RTT_Capability
Sets the bits in the RTT_Capability field.
These bits determine the time values for the RTT_AA_Only_N field, the RTT_Sound-
ing_N field and the RTT_Random_Sequence_N field. See the table Table 5-9 for an
overview.
Table 5-9: RTT_Capability bit numbers and RTT fields

"RTT_Capability" "RTT_AA_Only" "RTT_Sounding_N" "RTT_Random_Sequence_N"

0 150ns, 10ns, 0ns 0ns 0ns

1 0ns 150ns, 10ns, 0ns 0ns

2 0ns 0ns 150ns, 10ns, 0ns

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RCAPability on page 264

RTT_AA_Only
Displays or sets the time values of the RTT_AA_Only_N field.
Setting the value depends on the bits of the RTT_Capability field. See the table
Table 5-9 for an overview.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RAONly on page 263

CS control data payload settings
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RTT_Sounding_N
Displays or sets the time values of the RTT_Sounding_N field.
Setting the value depends on the bits of the RTT_Capability field. See the table
Table 5-9 for an overview.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RSOunding on page 266

RTT_Random_Sequence_N
Displays or sets the time values of the RTT_Random_Sequence_N field.
Setting the value depends on the bits of the RTT_Capability field. See the table
Table 5-9 for an overview.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RRSequence on page 266

NADM_Sounding_Capability
Sets the NADM sounding sequence capability.
"No-NADM" NADM disabled
"NADM" NADM enabled
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NSCapability on page 261

NADM_Random_Sequence_Capability
Sets the NADM random sequence capability.
"No-NADM" NADM disabled
"NADM" NADM enabled
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NRSCapability on page 261

CS_SYNC_PHY_Capability
Displays the value of the CS_SYNC_PHY_Capability field that is the LE 2M PHY.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSPCapability? on page 268

Num_Ant
Sets the bits of the Num_Ant field. This field indicates the number of antenna elements
of the Channel Sounding device.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NANT on page 260

Max_Ant_Path
Sets the maximum Num_Ant paths.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MAPath on page 258
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Role
See "Role" on page 50.

Companion_Signal
Enables the companion signal.
See also "Companion Signal" on page 110.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSIGnal on page 257

5.5.2.2  CpbData 2 settings

No_FAE....................................................................................................................... 116
Channel Selection Algorithm #3c................................................................................ 116
Sounding_PCT_Estimate............................................................................................ 116
RFU............................................................................................................................. 117
Num_Configs...............................................................................................................117
Max_Procedures_Supported.......................................................................................117
T_SW...........................................................................................................................117

No_FAE
Sets the No_FAE bit. This bit indicates if the transmitting LE device supports a frac-
tional frequency offset actuation error (FAE) or not.
"On" No_FAE bit is 1. The transmitting LE device only supports an FAE of

zero.
"Off" No_FAE bit is 0. The transmitting LE device supports FAE values as

listed in an FAE table.
See also "Channel FAE Table" on page 129.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NFAE on page 261

Channel Selection Algorithm #3c
Enables the channel selection algorithm #3c.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSAThreec on page 257

Sounding_PCT_Estimate
Sets the Sounding_PCT_Estimate bit. This bit indicates if the device supports phase
correction term (PCT) estimates from a sounding sequence or not.
"On" The Sounding_PCT_Estimate bit is 1. The device supports PCT esti-

mates from a sounding sequence.
"Off" The Sounding_PCT_Estimate bit is 0. The device does not support

PCT estimates from a sounding sequence.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SPEStimate on page 268
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RFU
Sets the bits that are reserved for future use (RFU).
The number of RFU bits can vary depending on the CS_Control_Data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU on page 264

Num_Configs
Sets the Num_Configs field that relates to the number of independent CS configura-
tions.
This number equals the CS configurations supported by the link layer transmitting this
PDU for this specific ACL connection.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NCONfig on page 260

Max_Procedures_Supported
Sets the bits in the Max_Procedures_Supported field.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPSupported on page 259

T_SW
Sets the T_SW field values that relate to the duration of the antenna switch period.
The local controller uses this period when switching antennas during active transmis-
sions.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TSW on page 266

5.5.2.3  CpbData 3 settings

Show T_IP1 Capability Table/Hide T_IP1 Capability Table......................................... 117
T_IP1_Capability Table................................................................................................117
Show T_IP2 Capability Table/Hide T_IP2 Capability Table......................................... 118
T_IP2_Capability Table................................................................................................118
Show T_FCS Capability Table/Hide T_FCS Capability Table..................................... 118
T_FCS_Capability Table..............................................................................................118
Show T_PM Capability Table/Hide T_PM Capability Table......................................... 118
T_PM_Capability Table................................................................................................119

Show T_IP1 Capability Table/Hide T_IP1 Capability Table
Shows or hides the "T_IP1_Capability Table".
The table provides settings to enable T_IP1 capability for bit positions that relate to
eight T_IP1 times. See also "T_IP1" on page 102.

T_IP1_Capability Table
The table provides settings to enable the T_IP1 capability including the T_IP1 time per
bit position. You can enable T_IP1 capabilities for bit position 0 to bit position 7.
"Bit Position" Displays the bit position.
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"T_IP1" Displays the T_IP1 time of the bit position.
"T_IP1 Capability"

Enables the T_IP1 capability per bit position.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPO:
CAPability on page 254

Show T_IP2 Capability Table/Hide T_IP2 Capability Table
Shows or hides the "T_IP2_Capability Table".
The table provides settings to enable T_IP2 capability for bit positions that relate to
eight T_IP2 times. See also "T_IP2" on page 105.

T_IP2_Capability Table
The table provides settings to enable the T_IP2 capability including the T_IP2 time per
bit position. You can enable T_IP2 capabilities for bit position 0 to bit position 7.
"Bit Position" Displays the bit position.
"T_IP2" Displays the T_IP2 time of the bit position.
"T_IP2 Capability"

Enables the T_IP2 capability per bit position.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPT:
CAPability on page 255

Show T_FCS Capability Table/Hide T_FCS Capability Table
Shows or hides the "T_FCS_Capability Table".
The table provides settings to enable T_FCS capability for bit positions that relate to 10
T_FCS times. See also "T_FCS (µs)" on page 94.

T_FCS_Capability Table
The table provides settings to enable the T_FCS capability including the T_FCS time
per bit position. You can enable T_FCS capabilities for bit position 0 to bit position 9.
"Bit Position" Displays the bit position.
"T_FCS" Displays the T_FCS time of the bit position.
"T_FCS Capability"

Enables the T_FCS capability per bit position.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TFCapability
on page 254

Show T_PM Capability Table/Hide T_PM Capability Table
Shows or hides the "T_PM_Capability Table".
The table provides settings to enable T_PM capability for bit positions that relate to
three T_PM times. See also "T_PM" on page 105.
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T_PM_Capability Table
The table provides settings to enable the T_PM capability including the T_PM time per
bit position. You can enable T_PM capabilities for bit position 0 to bit position 2.
"Bit Position" Displays the bit position.
"T_PM" Displays the T_PM time of the bit position.
"T_PM Capability"

Enables the T_PM capability per bit position.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TPCapability
on page 255

5.5.3  CS configuration payload settings

For packet type LL_CS_CONFIG_REQ and LL_CS_CONFIG_RSP, the "Payload" tab
provides the following settings.

Settings:

● Cfg Data 1 settings................................................................................................119
● Cfg Data 2 settings................................................................................................121
● Cfg Data 3 settings................................................................................................122

5.5.3.1  Cfg Data 1 settings

Config_ID.....................................................................................................................119
State............................................................................................................................ 119
ChM_Repetition.......................................................................................................... 120
Main_Mode................................................................................................................. 120
Sub_Mode...................................................................................................................120
Main_Mode_Min_Steps.............................................................................................. 120
Main_Mode_Max_Steps............................................................................................. 120
Main_Mode_Repetition............................................................................................... 120
Mode_0_Steps............................................................................................................ 120
PHY.............................................................................................................................120
RTT_Type....................................................................................................................121
Role.............................................................................................................................121

Config_ID
Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID on page 256

State
Enables the CS configuration ID, see "Config_ID" on page 119.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CCID:STATe on page 256

CS control data payload settings
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ChM_Repetition
Sets the 3-bit ChM_Repetition field.
The value equals the number of cycles of the ChM field for non-Mode-0 CS steps
within a CS procedure.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CMRepetition on page 210

Main_Mode
Sets the main mode of the CS control PDU.
"Mode-1" Mode-1 mode with no submode available.
"Mode-2" Mode-2 mode with submodes "Mode-1" and "Mode-3" available.
"Mode-3" Mode-3 mode with submode "Mode-2" available.
For an overview on available submodes per main mode, see Table 5-8.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMODe on page 258

Sub_Mode
Sets the submode of the main mode.
For an overview on available submodes per main mode, see Table 5-8.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SMODe on page 268

Main_Mode_Min_Steps
Sets the minimum number of main mode steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMISteps on page 258

Main_Mode_Max_Steps
Sets the maximum number of main mode steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMASteps on page 258

Main_Mode_Repetition
Sets the main mode repetition.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMRepetition on page 259

Mode_0_Steps
Sets the number of Mode-0 steps.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MZSTeps on page 260

PHY
Displays the PHY field value that is also the packet format.

CS control data payload settings
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This value indicates the TX PHY of the remote device, to which the Pwr_Delta field in
this PDU applies.
See also "Packet Format" on page 48.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PHY? on page 263

RTT_Type
Selects the RTT type determined by the 4-bit RTT_Type field. This field indicates the
round trip time (RTT) variant within the CS procedure. The table Table 5-10 provides
an overview.
Table 5-10: RTT_Type and RTT variant

RTT_Type value RTT variant <RttType>

0x00 RTT CS Access Address only timing RAAOT

0x01 RTT with 32-bit sounding sequence R32SS

0x02 RTT with 96-bit sounding sequence R96SS

0x03 RTT with 32-bit random sequence R32RS

0x04 RTT with 64-bit random sequence R64RS

0x05 RTT with 96-bit random sequence R96RS

0x06 RTT with 128-bit random sequence R128RS

All other Reserved for future use. RAAOT

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RTYPe on page 264

Role
Selects the CS role, see "Role" on page 50.

5.5.3.2  Cfg Data 2 settings

Companion_Signal......................................................................................................121
RFU.............................................................................................................................122
ChSel.......................................................................................................................... 122
T_IP1...........................................................................................................................122
T_IP2...........................................................................................................................122
T_FCS.........................................................................................................................122
T_PM...........................................................................................................................122

Companion_Signal
Enables the companion signal.
See also "Companion Signal" on page 110.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSIGnal on page 257

CS control data payload settings
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RFU
Sets the bits that are reserved for future use (RFU).
The number of RFU bits can vary depending on the CS_Control_Data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU on page 264

ChSel
See "ChSel" on page 98.

T_IP1
See "T_IP1" on page 102.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TIONe on page 265

T_IP2
See "T_IP2" on page 105.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TITWo on page 265

T_FCS
See "T_FCS (µs)" on page 94.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TFCS on page 265

T_PM
See "T_PM" on page 105.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TPM on page 265

5.5.3.3  Cfg Data 3 settings

Show Channel Table/Hide Channel Table
Shows or hides the channel table. For related settings, see Chapter 5.2.3, "Channel
table settings", on page 56.
Remote command: 
n.a.

5.5.4  CS payload settings

For packet type LL_CS_REQ and LL_CS_RSP, the "Payload" tab provides the follow-
ing settings.

CS control data payload settings
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Settings:

Config_ID.................................................................................................................... 123
RFU.............................................................................................................................123
connEventCount..........................................................................................................123
Offset_Min...................................................................................................................123
Offset_Max..................................................................................................................124
Max_Procedure_Len...................................................................................................124
Event_Interval............................................................................................................. 124
Subevent_Per_Event.................................................................................................. 124
Subevent_Interval....................................................................................................... 124
Subevent_Len............................................................................................................. 125
Procedure_Interval......................................................................................................125
Procedure_Count........................................................................................................ 125
ACI.............................................................................................................................. 125
PHY.............................................................................................................................125
Preferred_Peer_Ant.................................................................................................... 125
Pwr_Delta....................................................................................................................126

Config_ID
Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID on page 256

RFU
Sets the bits that are reserved for future use (RFU).
The number of RFU bits can vary depending on the CS_Control_Data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU on page 264

connEventCount
Sets the 16-bit connEventCount field bits in a hexadecimal representation.
The connEventCount field sets a connection event counter value that meets the follow-
ing requirement:

currEvent – 214 < connEventCount < currEvent + 214 (mod 65536)
The currEvent parameter is the counter value for the connection event for PDUs that
transmit or retransmit this field. The currEventCount value is greater than the currEvent
value of the event that transmits the LL_CS_REQ PDU first.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CECount on page 256

Offset_Min
Sets the time value of the Offset_Min field. The value has a length of 3 octets or 9 bits.
The field corresponds to the proposed minimum time (μs) from the ACL anchor point of
a certain connection event to the start of the first CS subevent. The connEventCount
field references this connection event.

CS control data payload settings
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The Offset_Min time value is greater than or equal to 500 μs and less than 4 s.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMIN on page 262

Offset_Max
Sets the time value of the Offset_Max field. The value has a length of 3 octets or 9 bits.
The field corresponds to the proposed maximum time between the ACL anchor point
and the offset of the first CS step of the first CS subevent. The anchor point marks a
certain connection event.
The Offset_Max time value is in microseconds. The value is greater than or equal to
the Offset_Min value and is less than the LE connection interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMAX on page 262

Max_Procedure_Len
Sets the time value of the Max_Procedure_Len field. The value has a length of 2 octets
or 6 bits.
The Max_Procedure_Len field is the proposed maximum extent of the entire CS proce-
dure in units of 625 μs. This value is equivalent to the time extent from the beginning of
the transmission of the first CS step to the end of the transmission of the final CS step.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPLength on page 259

Event_Interval
Sets the 16-bit Event_Interval field, see "Event Intervals/Event_Interval" on page 50.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:EINTerval on page 191

Subevent_Per_Event
For packet type LL_CS_REQ, displays the number of subevents per event.
For packet type LL_CS_RSP, sets the number of subevents per event.
The Subevents_Per_Event field indicates the number of CS subevents in each CS
event.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SNUMber on page 267

Subevent_Interval
Sets or displays the subevent interval. Setting requires "Subevent_Per_Event" ≠ "1".
For "Subevent_Per_Event" = "1", the subevent interval is 0 μs.
The subevent interval is the time gap, in units of 625 μs, between the start of two con-
secutive CS subevents. These subevents start from the same LE anchor point.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SINTerval on page 267

CS control data payload settings
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Subevent_Len
Sets the subevent length in the Subevent_Len field. The value has a length of 3 octets
or 9 bits.
The Subevent_Len field implies the maximum duration of each CS subevent in micro-
seconds. It is greater than or equal to 1250 μs and less than 4 s.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SLENgth on page 267

Procedure_Interval
Sets the procedure interval in the Procedure_Interval field. The value has a length of 2
octets or 6 bits.
The Procedure_Interval field implies the time in units of connection intervals between
the start of consecutive CS procedures.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PINTerval on page 263

Procedure_Count
Sets the bits in the Procedure_Count field. The value has a length of 2 octets.
The Procedure_Count field implies the number of consecutive CS procedures to
invoke. A value of 0 indicates that CS procedures continue to be invoked until they ter-
minate.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PCOunt on page 262

ACI
Sets the antenna configuration index (ACI) field. The value has a length of 1 octet or 0
to 7 in decimal representation.
The ACI field indicates the preferred ACI to use in the CS procedure.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ACI on page 256

PHY
See "PHY" on page 120.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PHY? on page 263

Preferred_Peer_Ant
Sets the bits in the Preferred_Peer_Ant field. The value has a length of 1 octet or 3
bits.
The Preferred_Peer_Ant field is a bit-mapped field and indicates the preferred peer-
ordered antenna elements. The peer uses these elements for the antenna configura-
tion as in the ACI field.
The table Table 5-11 lists all possible values and their meaning.

CS control data payload settings
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Table 5-11: Preferred_Peer_Ant field values

Bit number Description <PrePeerAnt>

0 Use the first ordered antenna element ANT0

1 Use the second ordered antenna element ANT1

2 Use the third ordered antenna element ANT2

3 Use the fourth ordered antenna element ANT3

All other bits Reserved for future use -

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PPANtenna on page 263

Pwr_Delta
Sets the bits in the Pwr_Delta field. The value has a length of 1 octet or 3 bits.
The Pwr_Delta field indicates the difference between the transmit power level of the
remote device for the CS tones and RTT packets and the transmit power level for the
PHY is in the PHY field.
The value in the Pwr_Delta field is a signed integer in dB. A positive value indicates a
higher transmit power level for the CS tones and RTT packets. A negative value indi-
cates a lower transmit power level for the CS tones and RTT packets, compared to the
transmit power level for the PHY indicated by the PHY field. A Pwr_Delta value of 0x00
indicates that the two transmit power levels are the same.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PDELta on page 262

5.5.5  CS IND payload settings

For packet type LL_CS_IND, the "Payload" tab provides the following settings.

Settings:

Config_ID.................................................................................................................... 126
RFU.............................................................................................................................127
connEventCount..........................................................................................................127
Offset...........................................................................................................................127
Event_Interval............................................................................................................. 127
Subevents_Per_Event................................................................................................ 127
Subevent_Interval....................................................................................................... 127
Subevent_Len............................................................................................................. 127
ACI.............................................................................................................................. 127
PHY.............................................................................................................................128
Pwr_Delta....................................................................................................................128

Config_ID
Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.

CS control data payload settings
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID on page 256

RFU
Sets the bits that are reserved for future use (RFU).
The number of RFU bits can vary depending on the CS_Control_Data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU on page 264

connEventCount
See "connEventCount" on page 123.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CECount on page 256

Offset
Sets the time value of the Offset field. The value has a length of 3 octets or 9 bits.
The field corresponds to the proposed minimum time (μs) from the ACL anchor point of
a certain connection event to the start of the first CS subevent. The connEventCount
field references this connection event.
The Offset time value is greater than or equal to 500 μs and less than 4 s.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:EOFFset on page 257

Event_Interval
Sets the 16-bit Event_Interval field, see "Event Intervals/Event_Interval" on page 50.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:EINTerval on page 191

Subevents_Per_Event
See "Subevent_Per_Event" on page 124.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SNUMber on page 267

Subevent_Interval
See "Subevent_Interval" on page 124.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SINTerval on page 267

Subevent_Len
See "Subevent_Len" on page 125.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SLENgth on page 267

ACI
See "ACI" on page 125.

CS control data payload settings
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ACI on page 256

PHY
Displays the LE physical layer that is the LE uncoded PHY LE1M.
See also "Packet Format" on page 48.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PFORmat on page 177

Pwr_Delta
See "Pwr_Delta" on page 126.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PDELta on page 262

5.5.6  CS terminate payload settings

For packet type LL_CS_TERMINATE_IND, the "Payload" tab provides the following
settings.

Settings:

Config_ID.................................................................................................................... 128
RFU.............................................................................................................................128
Error Code(hex).......................................................................................................... 128

Config_ID
Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID on page 256

RFU
Sets the bits that are reserved for future use (RFU).
The number of RFU bits can vary depending on the CS_Control_Data PDU.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU on page 264

Error Code(hex)
Sets an 8-bit error code. For an LL_CS_TERMINATE_IND packet, informs the remote
device about the termination of the connection.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ECODe on page 257

5.5.7  CS FAE payload settings

For packet type LL_CS_FAE_RSP, the "Payload" tab provides the following settings.

CS control data payload settings
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Settings:

Show Channel FAE Table/Hide Channel FAE Table................................................... 129
Channel FAE Table..................................................................................................... 129

Show Channel FAE Table/Hide Channel FAE Table
Shows or hides the fractional frequency offset actuation error (FAE) channel table.
See "Channel FAE Table" on page 129.

Channel FAE Table
The FAE channel table provides settings to set the fractional frequency offset actuation
error (FAE) per channel.
"Channel Index"

See "Channel Index" on page 96.
"Channel FAE" Sets the FAE of the channel.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:CHANnel<ch0>]:CFAE on page 255

5.5.8  CS channel map payload settings

For packet type LL_CS_CHANNEL_MAP_IND, the "Payload" tab provides the follow-
ing settings.

Settings:

Show Channel Mapping Table/Hide Channel Mapping Table..................................... 129
Connection Instant...................................................................................................... 129

Show Channel Mapping Table/Hide Channel Mapping Table
Shows or hides the channel-mapping table to set channel characteristics.
See Chapter 5.4.2, "Channel table", on page 95.

Connection Instant
See "Connection Instant" on page 82.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
on page 230

5.6  Test packet configuration

Access:

1. Select "Bluetooth" > "General".

2. "Bluetooth Mode" > "Bluetooth Low Energy".

Test packet configuration
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3. Select "Channel" > "Packet Type" > "TEST PACKET".

4. Select "Test Packet Configuration".

The dialog provides settings to configure test packets. The graphic below the set-
tings shows the test packet structure and fields.

Settings:

Packet Configuration...................................................................................................130
Packet Interval............................................................................................................ 130
Symbols per a Bit........................................................................................................ 130
Header........................................................................................................................ 131
CTEInfo Present..........................................................................................................131
CTEInfo Configuration.................................................................................................131
Sync Word...................................................................................................................131
User Pattern(hex)........................................................................................................131
Payload....................................................................................................................... 131
Payload Type.............................................................................................................. 131
Payload Length........................................................................................................... 132

Packet Configuration
The "Packet Configuration" section provides settings to configure the packet interval
and the number of symbols per bit "S".

Packet Interval
Sets the time interval between two consecutive test packets, regarding the starting
points.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval
on page 271

Symbols per a Bit
Requires option R&S SMW-K117 and "Packet Format" > "LE Coded".
Sets the number of symbols per bit "S" for forward error correction (FEC) coding for LE
coded packets. See also Table 2-4.

Test packet configuration
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit
on page 269

Header
The "Header" section provides settings to configure the header of the test packet.

CTEInfo Present
Requires a data channel packet or a test packet.
Enables the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.
See also "Constant tone extension" on page 23.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent
on page 220

CTEInfo Configuration
Requires "CTEInfo Present" > "On".
Opens the "CTEInfo Configuration" dialog to configure CTE length and the CTE
method. See Chapter 5.3.3, "CTEInfo settings", on page 62.

Sync Word
Requires an LE uncoded PHY, see "Packet Format" on page 48.
Sets the 32-bit Sync Word in the packet header field.
"0x94826E8E" Fixed value in hexadecimal representation.
"User Pattern" Allows a user-defined value, see "User Pattern(hex)" on page 131.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword
on page 270

User Pattern(hex)
Requires "Sync Word" > "User Pattern".
Sets a user-defined value of the 32-bit Sync Word. This value is an 8-digit hexadecimal
input.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt
on page 270

Payload
The "Payload" section provides settings to configure the payload of the test packet.

Payload Type
Selects the data source used for the payload test packets.
"PRBS 9"/"PRBS 15"

Pseudo random bit sequences of the length 9 or 15 - transmission of
identical packet series.

Test packet configuration
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Predefined pattern
11110000, 10101010, 11111111, 00000000, 00001111 or 01010101

"Data List" See "Data Source" on page 65.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource
on page 271

Payload Length
Sets the payload length of the test packet.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength
on page 271

Test packet configuration
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6  Bluetooth BR/EDR configuration and set-
tings
Access:

1. Select "Baseband" > "Bluetooth".

2. Select "Bluetooth Mode" > "Basic Rate + EDR".

The remote commands required to define these settings are described in Chapter 8,
"Remote control commands", on page 161.

Settings:

● Channel settings................................................................................................... 133
● Packet configuration..............................................................................................135

6.1  Channel settings

Access:

1. Select "Bluetooth" > "General".

2. Select "Bluetooth Mode" > "Basic Rate + EDR".

3. Select "Bluetooth" > "Channel".

The tab provides settings to configure Bluetooth BR/EDR channel settings. These
settings include the packet type, the sequence length and the slot timing. The
graphic at the bottom of the tab shows the frame structure of the selected packet
type.
Also, the tab provides further access to the BR/EDR packet configuration, see
Chapter 6.2, "Packet configuration", on page 135.

Channel settings
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For Bluetooth LE channel settings, see Chapter 5.1, "Channel settings", on page 44.

Settings:

Packet Type................................................................................................................ 134
Sequence Length........................................................................................................ 134
Slot Timing.................................................................................................................. 134
Packet Configuration...................................................................................................135

Packet Type
Selects the packet type.
The available packets depend on the selected Transport Mode.
All packet types as defined in the Bluetooth specification are supported. For an over-
view, see Chapter 2.4.1, "Bluetooth packet types for BR/EDR", on page 27.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PTYPe on page 272

Sequence Length
Selects the sequence length in frames of the generated signal. The signal repeats after
the specified number of frames.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:SLENgth on page 272

Slot Timing
Selects the timing mode for the RX slot.
The graphic below shows the frame structure of the selected Packet Type and slot tim-
ing.

TX test mode Loopback test mode

A transmitted packet has a duration of N × 625 μs where "N" is an odd integer larger
than 0. N depends on the type of the transmitted packet. In "Tx Test" mode, N = 1 for
RX slots.
"Tx Test Mode"

The transmitted RX package takes 625 symbols, regardless of the
selected packet type.

"Loopback Test Mode"
Extends the RX slot time according to the selected packet type.
For example, the RX slot of Packet Type > DH3 takes 3 x 625 sym-
bols.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:STIMing on page 273

Channel settings
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Packet Configuration
Access the "Packet Configuration" dialog, see Chapter 6.2, "Packet configuration",
on page 135.
The current data source for the packet and the data whitening state are displayed next
to the button.
Remote command: 
n.a.

6.2  Packet configuration

Access:

1. Select "Bluetooth" > "General".

2. Select "Bluetooth Mode" > "Basic Rate + EDR".

3. Select "Bluetooth" > "Channel" > "Packet Configuration".

The dialog contains the parameters for configuring the packet type.
Available settings vary according to the selected Packet Type and data source.

Settings:

Packet Configuration...................................................................................................136
└ Data Source for Packet.................................................................................136
└ Data Whitening............................................................................................. 136
└ Synchronize LAP with BD_ADDR.................................................................136
└ LAP for Sync Word....................................................................................... 136
└ Bluetooth Device Address (BD_ADDR)........................................................137

Header........................................................................................................................ 137
└ Logical Transport Address............................................................................ 137
└ Flow Control..................................................................................................137

Packet configuration
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└ Acknowledgment...........................................................................................138
└ SEQN Start Value......................................................................................... 138

Payload....................................................................................................................... 138
└ Data Source..................................................................................................138
└ Data Length.................................................................................................. 139
└ EIR packet follows........................................................................................ 139
└ Flow Control..................................................................................................139
└ Scan Repetition Mode...................................................................................140
└ Class of Device.............................................................................................140

DV Payload................................................................................................................. 140
└ Data Source (Voice Field).............................................................................140
└ Data Source..................................................................................................141
└ Data Length.................................................................................................. 142
└ Flow Control..................................................................................................142

Data.............................................................................................................................142
└ Packet Length...............................................................................................142

Packet Configuration
In this section, specify general Bluetooth BR/EDR packet properties.

Data Source for Packet ← Packet Configuration
The data sent for each packet can be comfortably edited with the packet editor, or filled
with a predefined "ALL" data sequence.
"Packet Editor" Enables the editing mode to configure the packet fields individually.
"All Data" Fills the generated packets with the selected data source. This mode

is useful if you need to load predefined data contents from a data list
file or the data contents of the packet are not of interest.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacket on page 278

Data Whitening ← Packet Configuration
Activates the data whitening.
Evenly distributed white noise is ideal for the transmission, and real data can be forced
to look similar to white noise with different methods called "Data Whitening".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHitening on page 278

Synchronize LAP with BD_ADDR ← Packet Configuration
Requires "Packet Type" > "FHS".
Activates synchronization of the LAP for Sync Word and the Bluetooth Device Address
> LAP.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SLAP on page 281

LAP for Sync Word ← Packet Configuration
Requires "Packet Type" > "FHS".

Packet configuration



Bluetooth BR/EDR configuration and settingsR&S®SMW-K60/-K117/-K178

137User Manual 1175.6803.02 ─ 26

Sets the 24-bit lower address part (LAP) in the 64-bit sync word separately, if "Syn-
chronize LAP with BD_ADDR > OFF".
The LAP is obtained automatically from the Bluetooth device address "BD_ADDR >
LAP", if "Synchronize LAP with BD_ADDR > ON".
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWord on page 279

Bluetooth Device Address (BD_ADDR) ← Packet Configuration
Enters the Bluetooth device address. Each Bluetooth device has allocated a unique
48-bit Bluetooth device address (BD_ADDR).
The BD_ADDR can take any values except the 64 reserved LAP values: 0x9E8B00 –
0x9E8B3F.
"NAP" Selects non-significant address part.

The length of NAP is 16 bits or 4 hexadecimal figures.
"UAP" Selects the upper address part.

The length of UAP is 8 bits or two hexadecimal figures.
"LAP" Selects the lower address part.

The length of LAP is 24 bits or 6 hexadecimal figures.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap on page 274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUap on page 275
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap on page 274

Header
Access:
Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR > Packet Configu-
ration > Header".

Provides header settings.

Logical Transport Address ← Header
Available for all packet types except ID packet.
Enters the logical transport address for the header.
Each Peripheral that is active in a piconet is assigned a primary logical transport
address (LT_ADDR). The all-zero LT_ADDR is reserved for broadcast messages.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress on page 279

Flow Control ← Header
Available for all packet types except ID packet.
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Sets the FLOW bit in the header. This bit indicates the start or stop of transmission of
packets over the ACL logical transport.
"Go" Allows the other devices to transmit new data.
"Stop" Stops the other devices from transmitting data temporarily.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFControl on page 279

Acknowledgment ← Header
Available for all packet types except ID packet.
Sets the ARQN bit of the packet header.
"NAK" Request to retransmit the previous payload.
"ACK" Previous payload has been received successfully.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement on page 274

SEQN Start Value ← Header
Available for all packet types except ID packet.
Sets the start value of the header SEQN bit.
The SEQN bit is present in the header to filter out retransmissions in the destination.
The signal generator is altering this bit automatically on consecutive frames, if a
sequence length of at least two frames is set.
"0" The SEQN bit starts with 0.
"1" The SEQN bit starts with 1.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValue on page 281

Payload
Access:
Select "Bluetooth > General > Bluetooth Mode > Basic Rate + EDR > Packet Configu-
ration > Payload".

Provides payload settings.

Data Source ← Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Selects the data source used for the payload.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
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● "PNxx"
An internally generated pseudo-random noise sequence.

● "Pattern"
An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMW200A user manual.
● Section "File and data management" in the R&S SMW200A user manual.
● Section "Data list editor" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA on page 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern on page 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection on page 276

Data Length ← Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Enters the payload data length in bytes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth on page 277

EIR packet follows ← Payload
Available for FHS packets.
Indicates that an extended inquiry response packet can follow.
"Yes" Indicates that an EIR packet follows.
"No" Indicates that EIR does not follow.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows
on page 278

Flow Control ← Payload
(Available for all packets types except ID, POLL, NULL, FHS, HV1, HV2, HV3, EV3,
EV4, EV5, 2-EV3, 2-EV5, 3-EV3, 3-EV5 packets.)
Sets the FLOW bit in the payload (flow control per logical link)
"Go" Indicates start of transmission of ACL packets after a new connection

has been established.
"Stop" Indicates stop of transmission of ACL packets before an additional

amount of payload data is sent.
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl on page 280

Scan Repetition Mode ← Payload
Available for FHS packets.
The 2-bit scan repetition field indicates the interval between two consecutive page
scan windows, determines the behavior of the paging device.
"R0" The scan interval is equal to the scan window TW_page_scan (contin-

uous scan) and maximal 1.28s.
"R1" The scan interval is maximal 1.28s.
"R2" The scan interval is maximal 2.56s.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMode on page 281

Class of Device ← Payload
Available for FHS packets.
A parameter received during the device discovery procedure, indicates the type of
device and which types of service that are supported.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:CODevice on page 275

DV Payload
Access:
Select "Bluetooth > Transport Mode = SCO > Channel > Packet Type = DV > Packet
Configuration > Data Source for Packet = Packet Editor > DV Payload".

Provides DV payload settings.

Data Source (Voice Field) ← DV Payload
(Available for DV packets)
Selects the data source for the voice field.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
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Use the "Pattern" box to set the bit pattern.
● "Data List"/"Select Data List"

Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMW200A user manual.
● Section "File and data management" in the R&S SMW200A user manual.
● Section "Data list editor" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa on page 282
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPAttern on page 277
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSElection
on page 277

Data Source ← DV Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Selects the data source used for the payload.
The following standard data sources are available:
● "All 0"/"All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to set the bit pattern.

● "Data List"/"Select Data List"
Binary data from a list file, internally or externally generated.
Select "Select Data List" to open the standard "Select List" dialog. The dialog lists
file with file extension *.dm_iqd if existing.
– Navigate to the list file and tap "Select" to select the file.
– Use the "New" and "Edit" functions to create a data list internally or to edit an

existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "About data signals" in the R&S SMW200A user manual.
● Section "File and data management" in the R&S SMW200A user manual.
● Section "Data list editor" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA on page 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern on page 276
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection on page 276
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Data Length ← DV Payload
(Available for all packet types except ID, POLL, NULL and FHS packets)
Enters the payload data length in bytes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth on page 277

Flow Control ← DV Payload
(Available for all packets types except ID, POLL, NULL, FHS, HV1, HV2, HV3, EV3,
EV4, EV5, 2-EV3, 2-EV5, 3-EV3, 3-EV5 packets.)
Sets the FLOW bit in the payload (flow control per logical link)
"Go" Indicates start of transmission of ACL packets after a new connection

has been established.
"Stop" Indicates stop of transmission of ACL packets before an additional

amount of payload data is sent.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl on page 280

Data
Access:
Select "Packet Configuration > Data Source for Packet = All Data > Data".

Provides data settings.

Packet Length ← Data
(Available in "All Data" mode and for all packet types except ID packet.)
Enters the packet length in symbols.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENgth on page 280
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7  Signal control and signal characteristics
This section lists settings provided for configuring the baseband filter and configuring
power ramping of bluetooth bursts. Also settings are listed for defining the signal gen-
eration start and for generating signals necessary for synchronization with other instru-
ments.

It covers the following topics:

● Filter/clipping settings............................................................................................143
● Power ramping settings.........................................................................................149
● Trigger settings..................................................................................................... 151
● Marker settings......................................................................................................156
● Clock settings........................................................................................................159
● Local and global connectors settings....................................................................160

7.1  Filter/clipping settings

Access:

1. Select "Baseband" > "Bluetooth".

2. Select "General" > "Filter"/"Clipping".

The dialog provides settings to configure the baseband filter, the modulation set-
tings and to enable clipping.

Filter/clipping settings
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Settings:

7.1.1 Common filter settings................................................................................................ 144

7.1.2 DPSK filter settings..................................................................................................... 145

7.1.3 Modulation settings..................................................................................................... 146

7.1.4 Clipping settings..........................................................................................................148

7.1.1  Common filter settings

Access:

1. Select "General" > "Filter"/"Clipping".

2. Select "Filter" > "GFSK section".

The section provides settings to configure the common baseband GFSK filter.

Settings:

Filter............................................................................................................................ 144
B*T.............................................................................................................................. 144
Impulse Length............................................................................................................145
Oversampling.............................................................................................................. 145

Filter
Displays the filter type that is GFSK. This type is common to the Bluetooth baseband
signal.
Remote command: 
n.a.

B*T
Sets the rolloff factor or bandwidth time product ("B*T") for the filter type that supports
this parameter.
For supporting predefined filters, this parameter can have a different default value for
each of the predefined filters.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 on page 286
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine on page 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss on page 287
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[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs on page 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs on page 288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss on page 288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine on page 288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase on page 289

Impulse Length
Displays the number of filter tabs.
If enabled, the most sensible parameter values are selected. The value depends on
the coherence check.
Disable it to set the values manually.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATe] on page 285
[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth on page 285

Oversampling
Sets the upsampling factor.
If enabled, the most sensible parameter values are selected. The value depends on
the coherence check.
Disable it to change the value manually.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling:AUTO[:STATe] on page 285
[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling on page 285

7.1.2  DPSK filter settings

Access:

1. Select a Bluetooth EDR packet that supports a π/4 DQPSK filter or 8DPSK filter:
See Table 7-1.

2. Select "General" > "Filter"/"Clipping".

3. Select "Filter" > "π/4 DQPSK section" or "8DPSK section".

The section provides settings to configure the π/4 DQPSK filter or 8DPSK filter.

Filter/clipping settings
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Table 7-1: DPSK filter for Bluetooth EDR packets

Transport mode Packet type DPSK filter type

ACL+EDR 2-DH1, 2-DH3, 2-DH5

3-DH1, 3-DH3, 3-DH5

π/4 DQPSK

8DPSK

eSCO+EDR 2-EV3, 2-EV5

3-EV3, 3-EV5

π/4 DQPSK

8DPSK

Settings:

Filter............................................................................................................................ 146
Roll Off Factor/B*T...................................................................................................... 146
Cut Off Frequency Factor............................................................................................146

Filter
Selects the filter type for DQPSK sections or 8DPSK sections in EDR packets.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:TYPE on page 284

Roll Off Factor/B*T
Sets the rolloff factor or bandwidth time product ("B*T") for the filter type that supports
this parameter.
For supporting predefined filters, this parameter can have a different default value for
each of the predefined filters.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 on page 286
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine on page 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss on page 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs on page 287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs on page 288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss on page 288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine on page 288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase on page 289

Cut Off Frequency Factor
Requires a lowpass filter.
Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs on page 288

7.1.3  Modulation settings

Access:

1. Select "General" > "Filter"/"Clipping".

Filter/clipping settings
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2. Select "Modulation Settings".

The tab provides settings to configure modulation settings.

Settings:

Modulation Type..........................................................................................................147
Frequency Deviation................................................................................................... 147
Modulation Index.........................................................................................................147
Symbol Rate Variation.................................................................................................148

Modulation Type
Displays the modulation format used for the current packet selection.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:MTYPe on page 286

Frequency Deviation
Enter the frequency deviation of the frequency modulated part.
The frequency deviation can be varied in a range from 100.0 kHz to 200.0 kHz accord-
ing to the Bluetooth specification.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:MSETtings:FDEViation on page 286

Modulation Index
Displays the modulation index resulting from the entered frequency deviation value.
Modulation index is calculated from the given frequency deviation and symbol rate val-
ues.
The modulation index h is defined as:

Where  is the "symbol rate" and  is the "frequency deviation".
According to the Bluetooth specification, the modulation index is allowed to vary
between 0.28 and 0.35.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:FILTer:MINDex on page 286
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Symbol Rate Variation
Enter the symbol rate.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:SRATe:VARiation on page 289

7.1.4  Clipping settings

Access:

1. Select "General" > "Filter"/"Clipping".

2. Select "Clipping".

The tab provides settings to configure clipping.

Settings:

State............................................................................................................................148
Clipping Level..............................................................................................................148
Clipping Mode............................................................................................................. 149

State
Switches baseband clipping on and off.
Baseband clipping is a simple and effective way of reducing the crest factor of the sig-
nal. Since clipping is done before to filtering, the procedure does not influence the
spectrum. The EVM however increases.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLIPping:STATe on page 283

Clipping Level
Sets the limit for clipping.
This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLIPping:LEVel on page 283
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Clipping Mode
Selects the clipping method. The dialog displays a graphical illustration on how this two
methods work.
● "Vector | i + jq |"

The limit is related to the amplitude | i + q |. The I and Q components are mapped
together, the angle is retained.

● "Scalar | i | , | q |"
The limit is related to the absolute maximum of all the I and Q values | i | + | q |.
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLIPping:MODE on page 283

7.2  Power ramping settings

Access:

► Select "Bluetooth" > "General" > "Power Ramping".

The dialog provides settings to configure power ramping.

To monitor power ramping for LE Channel Sounding

1. Select "Bluetooth" > "General" > "Bluetooth Mode" > "Bluetooth Low Energy".

2. Select "Bluetooth" > "Channel" > "Channel Type" > "Channel Sounding".

3. Select "Bluetooth" > "General" > "Power Ramping".

LE Channel Sounding uses fixed power ramping parameter as in the table below.

Parameter Value

"Ramp Function" "Cosine"

"Ramp Time" "5 Symbols"

"Rise Offset" "0 Symbols"

"Fall Offset" "0 Symbols"

Power ramping settings
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Settings:

Ramp Function............................................................................................................150
Ramp Time..................................................................................................................150
Rise Offset...................................................................................................................150
Fall Offset....................................................................................................................150

Ramp Function
Selects the form of the transmitted power, i.e. the shape of the rising and falling edges
during power ramp control.
"Linear" The transmitted power rises and falls with linear fashion.
"Cosine" The transmitted power rises and falls with a cosine-shaped edge.

This setting causes a more favorable spectrum than the "Linear" set-
ting.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction on page 290

Ramp Time
Sets the ramp time, which extends the burst by a corresponding number of 0 padding
symbols at the beginning and the end of a burst. During this period of time, power
ramping is based on the specified ramp function.
Do not switch the transmitted power abruptly at the end or the start of a burst, since the
switching operation generates excessively strong non-harmonics. The switching opera-
tion is therefore stretched over several symbol clocks.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe on page 291

Rise Offset
Sets the offset of the rising edge of a burst. The offset is specified by the selected num-
ber of symbols.
Negative values shift the rising edge to earlier positions, which results in a correspond-
ing number of added 0 padding symbols before the burst.
Positive values shift the rising edge to later positions, which results in a corresponding
number of skipped symbols at the beginning of the burst.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset on page 290

Fall Offset
Sets the offset of the falling edge of a burst. The offset is specified by the selected
number of symbols.
Negative values shift the falling edge to earlier positions, which results in a correspond-
ing number of skipped symbols at the end of the burst.
Positive values shift the falling edge to later positions, which results in a corresponding
number of added 0 padding symbols following the burst.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset on page 290

Power ramping settings
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7.3  Trigger settings

Access:

► Select "Baseband" > "Bluetooth" > "Trigger In".

This tab provides settings to select and configure the trigger, like trigger source,
trigger mode and trigger delays, and to arm or trigger an internal trigger manually.
The header of the tab displays the status of the trigger signal and trigger mode. As
in the tabs "Marker" and "Clock", this tab provides also access to the settings of the
related connectors.

Routing and activating a trigger signal

1. Define the effect of a trigger event and the trigger signal source.

a) Select "Trigger In" > "Mode".
b) Select "Trigger In" > "Source".

2. For external trigger signals, define the connector for signal input. See Chapter 7.6,
"Local and global connectors settings", on page 160.
You can map trigger signals to one or more USER x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMW200A starts baseband signal generation after the configured trigger
event.

About baseband trigger signals

This section focuses on the available settings.

For detailed information on baseband trigger signals, see section About trigger signals"
in the R&S SMW200A user manual.

Settings:

Trigger Settings Common to All Basebands............................................................... 152
Mode........................................................................................................................... 152
Signal Duration Unit.................................................................................................... 152
Signal Duration............................................................................................................153
Running/Stopped........................................................................................................ 153
Time Based Trigger.....................................................................................................153
Trigger Time................................................................................................................ 153
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Arm..............................................................................................................................154
Execute Trigger...........................................................................................................154
Source.........................................................................................................................154
Sync. Output to Ext. Trigger/Sync. Output to Trigger..................................................154
External Inhibit/Trigger Inhibit......................................................................................155
External Delay/Trigger Delay...................................................................................... 156

Trigger Settings Common to All Basebands
To enable simultaneous signal generation in all basebands, the R&S SMW200A cou-
ples the trigger settings in the available basebands in any instrument's configuration
involving signal routing with signal addition. For example, in MIMO configuration, rout-
ing and summing of basebands or of streams.
The icon  indicates that common trigger settings are applied.
You can access and configure the common trigger source and trigger mode settings in
any of the basebands. An arm or a restart trigger event applies to all basebands, too.
You can still apply different delay to each of the triggers individually.

Mode
Selects the trigger mode. The mode determines the effect of a trigger event on the sig-
nal generation.
For more information, see chapter "About trigger signals" in the R&S SMW200A user
manual.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:BTOoth[:TRIGger]:SEQuence on page 293

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Trigger settings
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit on page 296

Signal Duration
Requires trigger "Mode" > "Single".
Enters the length of the trigger signal sequence.
Use this parameter, for example, for the following applications:
● To output the trigger signal partly.
● To output a predefined sequence of the trigger signal.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth on page 295

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe on page 294

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".
Activates time-based triggering with a fixed time reference.
The R&S SMW200A triggers signal generation when its operating system time ("Cur-
rent Time") matches a specified time trigger ("Trigger Time"). As trigger source, you
can use an internal trigger or an external global trigger.
How to: Chapter "Time-based triggering" in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe] on page 295

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".
Sets date and time for a time-based trigger signal.
Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMW200A. If you set an earlier trigger time than the current
time, time-based triggering is not possible.
How to: Chapter "Time-based triggering" in the R&S SMW200A user manual.

"Date" Sets the date of the time-based trigger in format YYYY-MM-DD.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE on page 294

Trigger settings
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"Time" Sets the time of the time-based trigger in format hh:mm:ss.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME on page 294

Arm
Stops the signal generation until subsequent trigger event occurs.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute on page 296

Execute Trigger
For internal trigger source, executes trigger manually.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute on page 296

Source
The following sources of the trigger signal are available:
● "Internal"

The trigger event is internal. Tap "Execute Trigger" to trigger signal generation
manually.

● "Internal (Baseband A/B)"
The trigger event is provided by the trigger signal from the other basebands.
If common trigger settings are applied, this trigger source is disabled.

● "External Global Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the USER x connectors.

● "External Local Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the local T/M/C connector.
With coupled trigger settings, the signal has to be provided at the T/M/C1/2/3 con-
nectors.

● "External Local Clock"
The trigger event is the active edge of an external local clock signal provided and
configured at the local T/M/C connector.
With coupled trigger settings, the signal has to be provided at the T/M/C1 connec-
tor.

● "Baseband Sync In"
Requires "Multi Instrument Trigger" > "Secondary" for primary-secondary instru-
ment mode.
Triggers signal generation at the secondary instrument by the active edge of the
baseband synchronization signal of the primary instrument.

"External Local Clock/Trigger" require R&S SMW-B10.
How to: "Routing and activating a trigger signal" on page 151
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce on page 293

Sync. Output to Ext. Trigger/Sync. Output to Trigger
Enables signal output synchronous to the trigger event.
● "On"

Trigger settings
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Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

● "Off"
The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-
ces are sequences with signal duration comparable with the processing time of the
instrument.

In primary-secondary instrument mode, this setting ensures that once achieved, syn-
chronization is not lost if the baseband signal sampling rate changes.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut
on page 296

External Inhibit/Trigger Inhibit
Applies for an external trigger signal or trigger signal from the other path.
Sets the duration with that any following trigger event is suppressed. In "Retrigger"
mode, for example, a new trigger event does not cause a restart of the signal genera-
tion until the specified inhibit duration does not expire.
For more information, see chapter "Basics on signals, modulation formats and filters" in
the user manual.

Trigger settings
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Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:INHibit on page 297
[:SOURce<hw>]:BB:BTOoth:TRIGger:OBASeband:INHibit on page 297

External Delay/Trigger Delay
Delays the trigger event of the signal from:
● The external trigger source
● The other path
● The other basebands (internal trigger), if common trigger settings are used.
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces
● Postpone the signal generation start in the basebands compared to each other
● Compensate delays and align the signal generation start in multi-instrument setup
For more information, see chapter "Basics on ..." in the R&S SMW200A user manual.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay on page 297
[:SOURce<hw>]:BB:BTOoth:TRIGger:OBASeband:DELay on page 296

7.4  Marker settings

Access:

► Select "Baseband" > "Bluetooth" > "Marker".

This tab provides settings to select and configure the marker output signal includ-
ing marker mode and marker delay.

Routing and activating a marker signal

1. To define the signal shape of an individual marker signal "x", select "Marker" >
"Marker x" > "Mode".

2. Optionally, define the connector for signal output. See Chapter 7.6, "Local and
global connectors settings", on page 160.
You can map marker signals to one or more USER x or T/M connectors.

3. Enable baseband signal generation. In the block diagram, set "Baseband" > "On".

Marker settings
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The R&S SMW200A adds the marker signal to the baseband signal. Also,
R&S SMW200A outputs this signal at the configured USER x connector.

About marker output signals

This section focuses on the available settings.

For detailed information on baseband trigger signals, see section About trigger signals"
in the R&S SMW200A user manual.

Settings:

Mode........................................................................................................................... 157
Delay........................................................................................................................... 158

Mode
Sets the marker mode that defines the shape and periodicity of the marker signals.
You can configure marker modes for up to 3 markers. The marker configuration
changes with the selected marker mode.
How to: "Routing and activating a marker signal" on page 156
"Restart" A marker signal is generated at the start of each signal sequence.
"Event/Frame Start"

A marker signal is generated at the start of each event/frame. The
term event corresponds to a Bluetooth LE event, the term frame cor-
responds to a Bluetooth BR/EDR frame.

"Event/Frame Active Part"/"Event/Frame Inactive Part"
The marker masks the active/inactive part of the event/frame. At the
start of each burst, the marker signal changes to high/low. It changes
back to low/high after the end of each burst.
Shift the marker signal at the start/end of each burst with the parame-
ters "Rising/Falling Edge Shift".
Also, for Bluetooth LE data packets higher than one, configure the
"Packet Index". The index corresponds to the transmitted Tx event
during the connection interval.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift
on page 299
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift
on page 302
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex
on page 301

Marker settings
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"Pulse" A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed below it.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:
DIVider on page 301
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:
FREQuency? on page 301

"Pattern" A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
which opens when pattern is selected.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern
on page 300

"On/Off Ratio"
A regular marker signal that is defined by an On/Off ratio is gener-
ated. A period lasts one On and Off cycle.
If "Marker Mode > On/Off Ratio", specify the "On Time" and "Off
Time", which are expressed as number of samples.

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime
on page 300
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:OFFTime
on page 300

Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE on page 299

Delay
Delays the marker signal at the marker output relative to the signal generation start.
Variation of the parameter "Marker x" > "Delay" causes signal recalculation.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay on page 299

Marker settings
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7.5  Clock settings

Access:

► Select "Baseband" > "Bluetooth" > "Clock".

This tab provides settings to select and configure the clock signal, like the clock
source and clock mode.

Defining the clock

1. Select "Clock" > "Source" to define the source of the clock signal.

2. For external clock signals, define the connector for the signal input. See Chap-
ter 7.6, "Local and global connectors settings", on page 160.
You can map clock signals to one or more USER x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMW200A starts baseband signal generation with a symbol rate that
equals the clock rate.

About clock signals

This section focuses on the available settings.

For detailed information on baseband trigger signals, see section About trigger signals"
in the R&S SMW200A user manual.

Settings:

Clock Source...............................................................................................................159
Clock Mode................................................................................................................. 160
Measured External Clock............................................................................................ 160

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
● "External Local Clock"

Option: R&S SMW-B10
The instrument expects an external clock reference at the local T/M/C connector.

"External Local Clock" requires R&S SMW-B10.

Clock settings
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How to: "Defining the clock" on page 159
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce on page 303

Clock Mode
Option: R&S SMW-B10
Sets the type of externally supplied clock.
Remote command: 
[:SOURce<hw>]:BB:BTOoth:CLOCk:MODE on page 302

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.
Remote command: 
CLOCk:INPut:FREQuency?

7.6  Local and global connectors settings

Opens a dialog to configure local connectors or global connectors.

The button is available in the following dialogs or tabs:
● "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block

diagram.
● "Trigger In", "Marker" and "Clock" tabs of baseband signal configuration dialogs

that you can open via the "Baseband" block in the block diagram. These tabs are
available, for example, for "ARB" baseband signals.

See also chapter "Local and global connectors settings" in the user manual.

Local and global connectors settings
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8  Remote control commands
The following commands are required to perform signal generation with the Bluetooth
options in a remote environment. We assume that the R&S SMW200A has already
been set up for remote operation in a network as described in the R&S SMW200A doc-
umentation. A knowledge about the remote control operation and the SCPI command
syntax is assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMW200A user manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

ENTity<ch> 1 to 4 Entity in a multiple entity configuration with separate base-
band sources

ENTity3|4 require option R&S SMW-K76.

SOURce<hw> [1] to 4 Available baseband signals

Only SOURce1 is possible if the keyword ENTity is used.

OUTPut<ch> 1 to 3 Available marker signals

Using SCPI command aliases for advanced mode with multiple entities
You can address multiple entity configurations by using the SCPI commands starting
with the keyword :SOURce or the alias commands starting with the keyword :ENTity.
Note that the meaning of the keyword :SOURce<hw> changes in the second case.
For details, see section "SCPI Command Aliases for Advanced Mode with Multiple
Entities" in the R&S SMW200A user manual.

Programming examples

This section provides simple programming examples. The purpose of the examples is
to present all commands for a given task. In real applications, you typically use an
appropriate subset of these commands.

For verification and testing purposes, a software tool executed these programming
examples. To keep the example as simple as possible, the examples report clean SCPI
syntax elements. Non-executable command lines, for example comments, start with
two characters //.

Before executing a SCPI sequence, most remote control programs reset or preset the
instrument to a definite state. The commands *RST and SYSTem:PRESet are equiva-
lent for this purpose. *CLS also resets the status registers and clears the output buffer.
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The following chapters describe the commands specific to the Bluetooth options
R&S SMW-K60, R&S SMW-K117 and R&S SMW-K178.

● General commands...............................................................................................162
● Dirty transmitter configuration............................................................................... 167
● Channel configuration commands - LE.................................................................174
● Event and frame configuration commands - LE....................................................180
● Channel sounding commands - LE.......................................................................190
● Packet configuration commands - LE....................................................................211
● Test packet configuration commands - LE............................................................ 269
● Channel configuration commands - BR/EDR........................................................272
● Packet configuration commands - BR/EDR.......................................................... 273
● Filter/clipping commands...................................................................................... 282
● Power ramping commands................................................................................... 289
● Trigger commands................................................................................................ 291
● Marker commands................................................................................................ 298
● Clock commands...................................................................................................302

8.1  General commands

Example: To configure time units for timing and delay commands
The default time unit of timing and delay commands is millisecond. You can set time
unit to millisecond or to second.
:SOURce1:BB:BTOoth:UNIT:TIME?
// Response: "MS"
// Change time unit to seconds.
:SOURce1:BB:BTOoth:UNIT:TIME S

Example: To save and recall settings
MMEM:CDIR "/var/user/"
:SOURce1:BB:BTOoth:PRESet
:SOURce1:BB:BTOoth:SETTing:STORe "/var/user/Bluetooth_EDR"
:SOURce1:BB:BTOoth:SETTing:CATalog?
// Response: Bluetooth_EDR,Bluetooth_SCO,BTO_test
:SOURce1:BB:BTOoth:SETTing:DELete "BTO_test"
:SOURce1:BB:BTOoth:SETTing:LOAD "BTO_dl"
:SOURce1:BB:BTOoth:SETTing:CATalog?
// Response: "Bluetooth_EDR,Bluetooth_SCO"

General commands
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Example: To configure general Bluetooth BR/EDR settings
// ******************************************************************
// Set time unit to ms.
// ******************************************************************
:SOURce1:BB:BTOoth:UNIT:TIME MS
// ******************************************************************
// Set frequency and level.
// Set BR/EDR PHY and transport modes.
// Query the version of the digital standard.
// Generate and save a waveform file in the current directory.
// ******************************************************************
SOURce1:FREQuency:CW 2402000000
SOURce1:POWer:POWer -50
:SOURce1:BB:BTOoth:BMODe BAS
:SOURce1:BB:BTOoth:TMODe ACL
// :SOURce1:BB:BTOoth:TMODe SCO
// :SOURce1:BB:BTOoth:TMODe ESCO
:SOURce1:BB:BTOoth:VERSion?
// Supported Bluetooth version, for example, "4.2".
:SOURce1:BB:BTOoth:STATe ON
:SOURce1:BB:BTOoth:WAVeform:CREate "Bluetooth_EDR"

Example: To configure general Bluetooth LE settings
// ******************************************************************
// Set time unit to ms.
// ******************************************************************
:SOURce1:BB:BTOoth:UNIT:TIME MS
// ******************************************************************
// Set frequency and level.
// Set LE PHY and query the version of the digital standard.
// Generate and save a waveform file in the current directory.
// ******************************************************************
SOURce1:FREQuency:CW 2402000000
SOURce1:POWer:POWer -10
:SOURce1:BB:BTOoth:BMODe BLEN
:SOURce1:BB:BTOoth:VERSion?
// Supported Bluetooth version, for example, "5.4".
:SOURce1:BB:BTOoth:STATe ON
:SOURce1:BB:BTOoth:WAVeform:CREate "Bluetooth_LE"

[:SOURce<hw>]:BB:BTOoth:BCText?.............................................................................. 164
[:SOURce<hw>]:BB:BTOoth:BMODe............................................................................... 164
[:SOURce<hw>]:BB:BTOoth:PRESet............................................................................... 165
[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog................................................................. 165
[:SOURce<hw>]:BB:BTOoth:SETTing:DELete...................................................................165
[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD.....................................................................165
[:SOURce<hw>]:BB:BTOoth:SETTing:STORe...................................................................166
[:SOURce<hw>]:BB:BTOoth:STATe................................................................................. 166
[:SOURce<hw>]:BB:BTOoth:TMODe............................................................................... 166

General commands
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[:SOURce<hw>]:BB:BTOoth:UNIT:TIME...........................................................................167
[:SOURce<hw>]:BB:BTOoth:VERSion?............................................................................167
[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate............................................................... 167

[:SOURce<hw>]:BB:BTOoth:BCText?

Queries the state and controller role.

Return values: 
<BcText> string

Connected
(only data channel type)
Advertiser
(only advertising channel type)
ADV_IND, ADV_DIRECT_IND, ADV_NONCONN_IND,
ADV_SCAN_IND
Within R&S SMW-K117 also ADV_EXT_IND, AUX_ADV_IND,
AUX_SYNC_IND, AUX_CHAIN_IND
Scanner
(only advertising channel type)
SCAN_REQ, SCAN_RSP
Within R&S SMW-K117 also AUX_SCAN_REQ,
AUX_SCAN_RSP
Initiator
(only advertising channel type)
CONNECT_IND
Within R&S SMW-K117 also AUX_CONNECT_REQ,
AUX_CONNECT_RSP

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 163.

Usage: Query only

Manual operation: See "Bluetooth Controller State" on page 49

[:SOURce<hw>]:BB:BTOoth:BMODe <BMode>

Sets the Bluetooth mode.

Parameters:
<BMode> BASic | BLENergy

BASic
Sets basic rate (BR) or enhanced data rate (EDR) Bluetooth
mode.
BLENergy
Sets low energy (LE) Bluetooth mode.
*RST: BASic

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 163.

General commands
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Manual operation: See "Bluetooth Mode" on page 37

[:SOURce<hw>]:BB:BTOoth:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:BTOoth:STATe.

Example: See Example"To save and recall settings" on page 162.

Usage: Event

Manual operation: See "Set To Default" on page 35

[:SOURce<hw>]:BB:BTOoth:SETTing:CATalog <Catalog>

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.bto.

Parameters:
<Catalog> string

Returns a string of file names separated by commas.

Example: See Example"To save and recall settings" on page 162.

Manual operation: See "Save/Recall" on page 36

[:SOURce<hw>]:BB:BTOoth:SETTing:DELete <Filename>

Deletes the selected file from the default or specified directory. Deleted are files with
the file extension *.bto.

Parameters:
<Filename> string

file name or complete file path; file extension can be omitted

Example: See Example"To save and recall settings" on page 162.

Manual operation: See "Save/Recall" on page 36

[:SOURce<hw>]:BB:BTOoth:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.bto.

Parameters:
<Filename> string

file name or complete file path; file extension can be omitted

Example: See Example"To save and recall settings" on page 162.

Manual operation: See "Save/Recall" on page 36

General commands
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[:SOURce<hw>]:BB:BTOoth:SETTing:STORe <Filename>

Saves the current settings into the selected file; the file extension (*.bto) is assigned
automatically.

Setting parameters: 
<Filename> string

file name or complete file path

Example: See Example"To save and recall settings" on page 162.

Usage: Setting only

Manual operation: See "Save/Recall" on page 36

[:SOURce<hw>]:BB:BTOoth:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 163.

Manual operation: See "State" on page 35

[:SOURce<hw>]:BB:BTOoth:TMODe <TMode>

Selects the transport mode.

Parameters:
<TMode> ACL | SCO | ESCO

ACL
Asynchronous connection-less (ACL) mode used for a point-to-
point multipoint link between a Central and all Peripherals.
SCO
Synchronous connection-oriented (SCO) mode used for a point-
to-point link between a Central and a specific Peripheral.
ESCO
Enhanced SCO mode used for a symmetric or asymmetric point-
to-point link between a Central and a specific Peripheral.
*RST: ACL

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 163.

Manual operation: See "Transport Mode" on page 37

General commands
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[:SOURce<hw>]:BB:BTOoth:UNIT:TIME <Time>

Sets the time unit for remote control commands.

Parameters:
<Time> S | MS

*RST: MS

Example: See Example"To configure time units for timing and delay com-
mands" on page 162.

[:SOURce<hw>]:BB:BTOoth:VERSion?

Queries the version of the specification for Bluetooth wireless technology underlying
the definitions.

Return values: 
<Version> string

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 163.

Usage: Query only

Options: Version 5.x requires R&S SMW-K117.
Version 5.5 requires R&S SMW-K178.

Manual operation: See "Bluetooth Version" on page 37

[:SOURce<hw>]:BB:BTOoth:WAVeform:CREate <Filename>

Saves the current settings as an ARB signal in a waveform file (*.wv).

Setting parameters: 
<Filename> string

Example: See Example"To configure general Bluetooth BR/EDR settings"
on page 163.

Usage: Setting only

Manual operation: See "Generate Waveform" on page 36

8.2  Dirty transmitter configuration

Example: To configure a dirty transmitter
// ******************************************************************
// Set modulation index mode to stable.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:MIMode STAB

Dirty transmitter configuration
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// ******************************************************************
// Reset dirty transmitter. Set frequency drift rate, start phase, 
// frequency drift deviation and number of packets 
// per dirty transmitter set (LE only). Enable dirty transmitter.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:STDefault
SOURce1:BB:BTOoth:DTTest:FDRate 1.25
SOURce1:BB:BTOoth:DTTest:SPHase 0
SOURce1:BB:BTOoth:DTTest:FDDeviation 50
SOURce1:BB:BTOoth:DTTest:NPPSet NP50

// ******************************************************************
// Enable all long sets for LE or BR dirty transmitter.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET1:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET2:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET3:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET4:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET5:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET6:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET7:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET8:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET9:STATe 1
SOURce1:BB:BTOoth:DTTest:TABLe:LONG:SET10:STATe 1

// ******************************************************************
// Enable dirty transmitter.
// ******************************************************************
SOURce1:BB:BTOoth:DTTest:DTTState 1

[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState..................................................................168
[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation..............................................................169
[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate.................................................................... 169
[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode....................................................................169
[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet.................................................................... 170
[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase....................................................................170
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[:SOURce<hw>]:BB:BTOoth:DTTest:DTTState <DttState>

Activates the "Dirty Transmitter Test".

For EDR packets, the parameter sets apply for 20 packets each.
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Parameters:
<DttState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Dirty Transmitter Test" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:FDDeviation <FdDeviation>

Sets a frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset. The maximum deviation reached during the drift equals the set
frequency drift deviation.

Parameters:
<FdDeviation> integer

Range: -100  to  100
*RST: 25

Example: See Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Frequency Drift Deviation(+/-)" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:FDRate <FdRate>

Sets a frequency drift rate.

A sine wave is used to drift the modulated Bluetooth signal around center frequency +
carrier frequency offset with the set frequency drift rate.

Parameters:
<FdRate> 0.3 KHz | 0.5 KHz | 1.6 KHz | 10 KHz

Range: depends on packet type  to  depends on packet
type

Increment: 0.001
*RST: depends on packet type

Example: See Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Frequency Drift Rate" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:MIMode <MIMode>

Determines standard or stable mode for the modulation index of dirty transmitter
according to the Bluetooth core specification.

Parameters:
<MIMode> STANdard | STABle

*RST: STANdard

Example: See Example"To configure a dirty transmitter" on page 167.
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Options: R&S SMW-K117

Manual operation: See "Modulation Index Mode" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:NPPSet <NumPack>

Specifies the number of packets per dirty transmitter set.

Specifies the number of packets or CS steps per dirty transmitter set.

Bluetooth mode Channel type Number of packets

BR + EDR - 50, 2, 1 packets

LE Advertising, data 50, 2, 1 packets

LE Channel sounding 50, 20, 18, 16, 14, 12, 10, 8, 6, 4, 2, 1 CS steps

Parameters:
<NumPack> NP50 | NP2 | NP1 | NP4 | NP6 | NP8 | NP10 | NP12 | NP14 |

NP16 | NP18 | NP20
*RST: NP50

Example: See Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Number Of Packets Per Set/Number Of Steps Per Set"
on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:SPHase <SPhase>

The command enters a start phase.

The start phase applies to the sine wave that is used to drift the modulated Bluetooth
signal. The drift is around the center frequency plus the carrier frequency offset.

Parameters:
<SPhase> integer

Range: 0  to  359
Increment: 1
*RST: 0
Default unit: degree

Example: SOURce1:BB:BTO:DTT:SPH 0
enters a start phase.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Start Phase" on page 41

[:SOURce<hw>]:BB:BTOoth:DTTest:STDefault

The command calls the default settings for the Dirty Transmitter Test.
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Example: SOURce1:BB:BTO:DTT:STD
calls the default settings.

Example: See also Example"To configure a dirty transmitter" on page 167.

Usage: Event

Manual operation: See "Set To Default" on page 40

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe <Table>

Opens the table settings.

Parameters:
<Table> NOTable | SHORt | LONG

Example: SOURce1:BB:BTO:PTYP DH1
calls the default settings.
SOURce1:BB:BTO:DTT:TABL LONG
See also Example"To configure a dirty transmitter" on page 167.

Example: calls the default settings.

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:CFOFfset <CfOffset>

Sets a carrier frequency offset.

The carrier frequency offset shows the deviation of the transmitted initial center fre-
quency from carrier frequency.

Parameters:
<CfOffset> integer

Range: -150  to  150
*RST: 1
Default unit: kHz

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
sets the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:CFOF 14
sets a carrier frequency offset.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Carrier Frequency Offset (kHz)" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:MINDex <MIndex>

Sets the modulation index, that specifies the frequency deviation.

The modulation index h is defined as:
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with

= "symbol rate" , set with the command [:SOURce<hw>]:BB:BTOoth:SRATe:
VARiation

= "frequency deviation", set with the command [:SOURce<hw>]:BB:BTOoth:
MSETtings:FDEViation
According to the Bluetooth standard, the modulation index is allowed to vary between
0.28 and 0.35.

Parameters:
<MIndex> float

Range: 0.28  to  0.55
Increment: 0.01
*RST: 0.28

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
enters the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:MIND 0.3
enters a modulation index.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Modulation Index" on page 43

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STATe <State>

Activates the corresponding parameter set for the long table.

For basic rate packets, each set applies to 20 ms of signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
sets the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:STAT ON
activates the set 2 in the long table.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "State" on page 42
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[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:LONG:SET<ch>:STERror <StError>

Sets a symbol timing error in ppm.

This parameter modifies the symbol clock frequency by the set value.

Parameters:
<StError> integer

Range: -150  to  150
*RST: 1
Default unit: ppm

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL LONG
sets the table type
SOURce1:BB:BTO:DTT:TABL:LONG:SET2:STER -20
sets a symbol timing error.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Symbol Timing Error (ppm)" on page 43

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:CFOFfset <CfOffset>

Sets a carrier frequency offset.

The carrier frequency offset shows the deviation of the transmitted initial center fre-
quency from carrier frequency.

Parameters:
<CfOffset> integer

Range: -150  to  150
*RST: 1
Default unit: kHz

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL SHOR
sets the table type
SOURce1:BB:BTO:DTT:TABL:SHOR:SET2:CFOF 65
sets a carrier frequency offset.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Carrier Frequency Offset (kHz)" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STATe <State>

Activates the corresponding parameter set in the short table. If a set deactivated, its
parameters are skipped in the sequence. Instead, the next active set is used.

For EDR packets, each set applies to 20 packets.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL SHOR
sets the table type
SOURce1:BB:BTO:DTT:TABL:SHOR:SET2:STAT ON
activates the set 2 in the short table.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "State" on page 42

[:SOURce<hw>]:BB:BTOoth:DTTest:TABLe:SHORt:SET<ch>:STERror <StError>

Sets a symbol timing error in ppm.

The symbol timing error modifies the symbol clock frequency by the set amount.

Parameters:
<StError> integer

Range: -150  to  150
Increment: 1
*RST: 1

Example: SOURce1:BB:BTO:PTYP DH1
sets the packet type.
SOURce1:BB:BTO:DTT:TABL SHOR
enters the table type
SOURce1:BB:BTO:DTT:TABL:SHOR:SET2:STER 20
enters a symbol timing error.

Example: See also Example"To configure a dirty transmitter" on page 167.

Manual operation: See "Symbol Timing Error (ppm)" on page 43

8.3  Channel configuration commands - LE

Example: To configure general channel settings for LE
// ******************************************************************
// Set time unit to ms.
// ******************************************************************
SOURce1:BB:BTOoth:UNIT:TIME MS

// ******************************************************************
// Select channel type, test packet, packet format, sequence length,
// controller role. Enable CRC corruption for every second packet. 
// ******************************************************************
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SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe TPAC
SOURce1:BB:BTOoth:PFORmat L2M
SOURce1:BB:BTOoth:USLength 2
SOURce1:BB:BTOoth:BCRole CENTral
SOURce1:BB:BTOoth:CCRC:STATe 1

// ******************************************************************
// Alternatively set duty cycle for ADV_DIRECT_IND
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADIN
SOURce1:BB:BTOoth:DCYCle LOW

[:SOURce<hw>]:BB:BTOoth:BCRole................................................................................175
[:SOURce<hw>]:BB:BTOoth:CCRC:STATe....................................................................... 176
[:SOURce<hw>]:BB:BTOoth:CTYPe................................................................................ 176
[:SOURce<hw>]:BB:BTOoth:DCYCle............................................................................... 176
[:SOURce<hw>]:BB:BTOoth:PFORmat............................................................................ 177
[:SOURce<hw>]:BB:BTOoth:UPTYpe...............................................................................177
[:SOURce<hw>]:BB:BTOoth:USLength............................................................................ 179
[:SOURce<hw>]:BB:BTOoth:MFORmat............................................................................179
[:SOURce<hw>]:BB:BTOoth:DURation.............................................................................180

[:SOURce<hw>]:BB:BTOoth:BCRole <BcRole>

Sets the Bluetooth controller role.

Depending on the selected channel type different roles are assigned to the controller.
For channel type "Data", you can assign Central or Peripheral.

If the channel type is "Advertising", the parameter is read only and displayed directly
above the graph.

Parameters:
<BcRole> CENTral | PERipheral | ADVertiser | SCANner | INITiator

CENTral
Selects Central as controller role.
PERipheral
Selects Peripheral as controller role.
ADVertiser|SCANner|INITiator
Assigned roles depending on the selected packet type of the
respective channel type.
*RST: CENTral

Example: See Example"To configure general channel settings for LE"
on page 174.

Manual operation: See "Bluetooth Controller Role" on page 48
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[:SOURce<hw>]:BB:BTOoth:CCRC:STATe <State>

Enables/disables the corruption of CRC for every second generated packet. If enabled,
only 50% of packets are generated with correct CRC.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure general channel settings for LE"
on page 174.

Manual operation: See "Corrupted CRC Every 2nd Packet" on page 49

[:SOURce<hw>]:BB:BTOoth:CTYPe <CType>

Determines the channel type. Advertising and data are available.

Parameters:
<CType> ADVertising | DATA | | CS

ADVertising
Selects channel type advertising.
DATA
Selects channel type data. Devices in a connected state transmit
data channel packets in connection events with a start point and
an interval.
CS
Requires R&S SMW-K178.
Selects channel type channel sounding.
*RST: ADVertising

Example: See Example"To configure general channel settings for LE"
on page 174.

Manual operation: See "Channel Type" on page 46

[:SOURce<hw>]:BB:BTOoth:DCYCle <DCycle>

Specifies duty cycle for directed advertising (packet type ADV_DIRECT_IND).

Parameters:
<DCycle> LOW | HIGH

*RST: HIGH

Example: See Example"To configure general channel settings for LE"
on page 174.

Options: R&S SMW-K117

Manual operation: See "Duty Cycle" on page 48
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[:SOURce<hw>]:BB:BTOoth:PFORmat <PFormat>

Selects the packet format that is the format according to the physical layer (PHY) that
supports the packet type or PDU type.

Parameters:
<PFormat> L1M | L2M | LCOD | L2M2B

L1M
LE uncoded PHY with 1 Msymbol/s modulation.
L2M
LE uncoded PHY with 2 Msymbol/s modulation and bandwidth
time product BT = 0.5.
LCOD
LE coded PHY with 1 Msymbol/s modulation.
L2M2B
LE uncoded PHY with 2 Msymbol/s modulation and bandwidth
time product BT = 2.
*RST: L1M

Example: See Example"To configure general channel settings for LE"
on page 174.

Options: L2M and LCOD require option R&S SMW-K117.
L2M2B requires option R&S SMW-K178.

Manual operation: See "Packet Format" on page 48
See "PHY" on page 128

[:SOURce<hw>]:BB:BTOoth:UPTYpe <UpType>

Selects the packet type.

The available packets depend on the selected channel type and installed options. The
tables below provide an overview.
Table 8-1: R&S SMW-K60 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type

AIND

ADINd

ANINd

SREQ

SRSP

CREQ

ADCind

DATA

CUReq

CMReq

TIND

EREQ

ADV_IND

ADV_DIRECT_IND

ADV_NONCONN_IND

SCAN_REQ

SCAN_RSP

CONNECT_IND

ADV_SCAN_IND

DATA

LL_CONNECTION_UPDATE_IND

LL_CHANNEL_MAP_IND

LL_TERMINATE_IND

LL_ENC_REQ

ERSP

SEReq

SERSp

URSP

FREQ

FRSP

TPACket

PEReq

PERSp

VIND

RIND

LL_ENC_RSP

LL_START_ENC_REQ

LL_START_ENC_RSP

LL_UNKNONW_RSP

LL_FEATURE_REQ

LL_FEATURE_RSP

TEST PACKET

LL_PAUSE_ENC_REQ

LL_PAUSE_ENC_RSP

LL_VERSION_IND

LL_REJECT_IND
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Table 8-2: R&S SMW-K117 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type

PREQ

PRSP

PUIN

LREQ

LRSP

SFR

CPR

CPRS

REIN

PIR

PIRS

AEINd

AAINd

LL_PHY_REQ

LL_PHY_RSP

LL_PHY_UPDATE_IND

LL_LENGTH_REQ

LL_LENGTH_RSP

LL_PERIPHERAL_FEATURE_REQ

LL_CONNECTION_PARAM_REQ

LL_CONNECTION_PARAM_RSP

LL_REJECT_EXT_IND

LL_PING_REQ

LL_PING_RSP

ADV_EXT_IND

AUX_ADV_IND

ACINd

ASINd

ASReq

ASPSp

ACRSp

ACReq

MUCH

CONT

CTEQ

CTEP

PSIND

CAReq

CARSp

AUX_CHAIN_IND

AUX_SYNC_IND

AUX_SCAN_REQ

AUX_SCAN_RSP

AUX_CONNECT_RSP

AUX_CONNECT_REQ

LL_MIN_USED_CHANNELS_IND

CONTINUOUS

LL_CTE_REQ

LL_CTE_RSP

LL_PERIODIC_SYNC

LL_CLOCK_ACCURACY_REQ

LL_CLOCK_ACCURACY_RSP

Table 8-3: R&S SMW-K178 packet/PDU types

<UpType> Packet/PDU type <UpType> Packet/PDU type

CSSEq

CSRQ

CSRP

CCRQ

CCRP

COREQ

CORSP

CS_SEQUENCE

LL_CS_SEC_REQ

LL_CS_SEC_RSP

LL_CS_CAPABILITIES_REQ

LL_CS_CAPABILITIES_RSP

LL_CS_CONFIG_REQ

LL_CS_CONFIG_RSP

CSREQ

CSRSP

CSIND

CTI

CFRQ

CFRP

CCMI

LL_CS_REQ

LL_CS_RSP

LL_CS_IND

LL_CS_TERMINATE_IND

LL_CS_FAE_REQ

LL_CS_FAE_RSP

LL_CS_CHANNEL_MAP_IND

For more information, refer to the specifications document.

Parameters:
<UpType> AIND | ADINd | ANINd | SREQ | SRSP | CREQ | ADCind |

DATA | CUReq | CMReq | TIND | EREQ | ERSP | SEReq |
SERSp | URSP | FREQ | FRSP | TPACket | PEReq | PERSp |
VIND | RIND | PREQ | PRSP | PUIN | LREQ | LRSP | SFR |
CPR | CPRS | REIN | PIR | PIRS | AEINd | AAINd | ACINd |
ASINd | ASReq | ASPSp | ACRSp | ACReq | MUCH | CONT |
CTEQ | CTEP | PSINd | CAReq | CARSp | CSSEQ | CSRQ |
CSRP | CCRQ | CCRP | COREQ | CORSP | CSREQ | CSRSP |
CSIND | CTI | CFRQ | CFRP | CCMI
*RST: AIND

Example: IdPDbBtoCsCtrlRfu
See Example"To configure general channel settings for LE"
on page 174.

Manual operation: See "Packet Type" on page 46
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[:SOURce<hw>]:BB:BTOoth:USLength <UsLength>

Selects the number of frames or events depending on the packet type. The signal
repeats after the specified number of frames/events.

For SCAN_REQ and CONNECT_IND packet, the sequence length is expressed in
"Frames".

For AUX_SCAN_REQ and AUX_CONNECT_REQ packet, the sequence length is
expressed in "Frames".

For LL_TERMINATE_IND packets, a default value according to the specification is
given:

Central: PeripheralLatency + 6

Peripheral: 6

For all other packet types the sequence length is expressed in "Events".

Parameters:
<UsLength> integer

Range: depends on the number of states in dirty transmitter
test  to  dynamic

*RST: 1

Example: See Example"To configure general channel settings for LE"
on page 174.

Manual operation: See "Sequence Length" on page 48

[:SOURce<hw>]:BB:BTOoth:MFORmat <ModFmt>

Sets the LE PHY for continuous payload transmission. This transmission requires a
CONTINUOUS packet:

:SOURce1:BB:BTOoth:UPTYpe CONT
Parameters:
<ModFmt> L1M | L2M | LCOD

L1M: LE 1M
L2M: LE 2M
LCOD: LE coded
See also [:SOURce<hw>]:BB:BTOoth:PFORmat
on page 177.
*RST: L1M

Example: See Example"To configure general channel settings for LE"
on page 174.

Options: L2M and LCOD require R&S SMW-K117.

Manual operation: See "Modulation Format" on page 49
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[:SOURce<hw>]:BB:BTOoth:DURation <Duration>

Sets the transmission duration for continuous payload transmission. This transmission
requires a CONTINUOUS packet:

:SOURce1:BB:BTOoth:UPTYpe CONT
Command sets the values in ms. Query returns values in s.

The duration range, increment and default value depend on the modulation format,
symbols per a bit and payload type.

For more information, refer to the specifications document.

Parameters:
<Duration> float

Range: depends on settings
Increment: depends on settings
*RST: depends on settings
Default unit: ms

Example: See Example"To configure general channel settings for LE"
on page 174.

Manual operation: See "Duration" on page 49

8.4  Event and frame configuration commands - LE

Example: Configure event and frame configuration settings
// ******************************************************************
// For ADV_SCAN_IND, select advertising event interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADC
SOURce1:BB:BTOoth:ECONfiguration:AEINterval 20

// ******************************************************************
// Alternatively set advertising event interval for ADV_DIRECT_IND.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADIN
SOURce1:BB:BTOoth:ECONfiguration:ADINterval 3.75
// ******************************************************************
// Set advertising event delay, activate channel 37.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:AEDelay 0
SOURce1:BB:BTOoth:ECONfiguration:ACTable:CHANnel0:STATe 1
// ******************************************************************
// For packet type SCAN_REQ, set length of the window, 
// time interval.
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// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe SREQ
SOURce1:BB:BTOoth:ECONfiguration:SWINdow 10
SOURce1:BB:BTOoth:ECONfiguration:SINTerval 3500

// ******************************************************************
// For packet type CONNECT_IND set transmit window,
// start point of the transmit window,
// LL connection timeout and time interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe CREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe 8.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset 800 
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout 7500
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval 6400

// ******************************************************************
// Alternatively select packet type LL_CONNECTION_UPDATE_IND,
// set transmit window, start point of the transmit
// window, LL connection timeout and time interval.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CUR
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize 8.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset 800
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout 7500
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval 6400

// ******************************************************************
// Set time interval for advertising channel and events.
// Set time delay for advertising events.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:APINterval 1.3
SOURce1:BB:BTOoth:ECONfiguration:AEINterval 15
SOURce1:BB:BTOoth:ECONfiguration:AEDelay 5

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANnel<ch0>:STATe..................... 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnel<ch0>:STATe..................... 182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay.......................................................182
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval................................................... 183
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval....................................................183
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval....................................................184
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode.......................................................184
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval........................... 185
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval............................ 187
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity.........................187
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber.....................................................188
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ACTable:CHANnel<ch0>:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:DCTable:CHANnel<ch0>:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DCMTable:
CHANnel<ch0>:STATe <State>

Indicates used and unused data channels.

Note: The previously used syntax ..:SET<ch>:STATe has been replaced
by ...:CHANnel<ch>:STATe. Compatibility to the previous commands is given.

This parameter is relevant for data event and advertising frame configuration with the
packet types LL_CHANNEL_MAP_IND, CONNECT_IND.

Within the option R&S SMW-K117, the following packet types are also relevant for the
setting: AUX_CONNECT_IND, AUX_EXT_IND, AUX_ADV_IND, AUX_CHAIN_IND,
AUX_SYNC_IND, AUX_SCAN_RSP.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce1:BB:BTO:ECON:ACT:CHAN:STAT ON
State in Advertising Channel Table and Secondary Advertising
Channel Table
SOURce1:BB:BTO:ECON:DCT:CHAN:STAT ON
State in Data Channel Table and Secondary Advertising Chan-
nel Table
SOURce1:BB:BTO:ECON:PCON:DCMT:CHAN:STAT ON
State in Data Channel Map Table

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Channel Table" on page 57

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEDelay <AeDelay>

Sets a time delay between the start times of two consecutive advertising events. The
value is added to the advertising event interval.

Command sets the values in ms. Query returns values in s.
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Parameters:
<AeDelay> float

Range: 0 s to 10E-3 s
Increment: 0.1E-3
*RST: 0
Default unit: ms

Example: SOURce1:BB:BTO:ECON:AEDelay 5
Sets a delay of 5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Advertising Event Delay" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:ADINterval <AdInterval>

Sets the time interval between two consecutive advertising events for packet type
"ADV_DIRECT_IND" and duty cycle high.

Command sets the values in ms. Query returns values in s.

Parameters:
<AdInterval> float

Range: 1.05E-3 s to 3.75E-3 s
Increment: 0.01E-3
*RST: 3.75E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:ADIN 13
Sets a time interval of 13 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Advertising Event Interval" on page 52

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:AEINterval <AeInterval>

Sets the time interval between two consecutive advertising events, with regard to the
starting points.

Command sets the values in ms. Query returns values in s.

Parameters:
<AeInterval> float

Range: 5E-3 s to depends on oversampling
Increment: 0.1E-3
*RST: 20E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:AEIN 15
Sets a time interval of 15 ms.
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Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Advertising Event Interval" on page 52

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:APINterval <ApInterval>

Sets the time interval between packets starting points of two consecutive packets in
the advertising channel.

Parameters:
<ApInterval> float

Range: 1.3E-3  to  28E-3
Increment: 0.1E-3
*RST: 10E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:APIN 1.3
Sets a time interval of 1.3 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Advertising Packet Interval" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LCMode <LcMode>

Selects the link layer connection mode. In order to provide safe transmission of pay-
load data, the data in the packet can be encrypted. If activated, the payload data fol-
lows MIC (Message authentication Code).

Parameters:
<LcMode> UENC | ENC

UENC
Payload data is transmitted without encoding.
ENC
The link layer connection runs in encrypted mode.
*RST: UENC

Example: SOURce1:BB:BTO:ECON:LCM UENC
without encoding.
SOURce1:BB:BTO:ECON:LCM ENC
in encrypted mode.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "LL Connection Mode" on page 55
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:LTKey <LtKey>, <BitCount>

Indicates the time the controller needs to receive the long-term key from the host. After
this time, the controller is ready to enter into the last phase of encryption mode setup.

Parameters:
<LtKey> numeric

*RST: #H0

<BitCount> integer
Range: 128  to  128
*RST: 128

Example: SOURce1:BB:BTO:ECON:LCM ENC
SOURce1:BB:BTO:ECON:LTK
#H00000000000000000000000000000000,128
In encrypted mode, the code can be edited.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Long Term Key(hex)" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval
<MNInterval>

Specifies the minimum allowed connection interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<MNInterval> float

Range: 7.5E-3 s to depending on Max. Interval
Increment: 1.25E-3 s
*RST: 7.5E-3

Example: SOURce1:BB:BTO:ECON:PCON:MNIN 7.5
Sets a time interval of 7.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Options: R&S SMW-K117

Manual operation: See "Min. Interval" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval
<MInterval>

Specifies the maximum allowed connection interval.

Command sets the values in ms. Query returns values in s.
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Parameters:
<MInterval> float

Range: 7.5E-3 s to 4000E-3 s
Increment: 1.25E-3
*RST: 7.5E-3

Example: SOURce1:BB:BTO:ECON:PCON:MXIN 12.5
Sets a time interval of 12.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Options: R&S SMW-K117

Manual operation: See "Max. Interval" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:
STATe <State>

Enables / disables Offset0 to Offset5 of the offset setting table.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 180.

Options: R&S SMW-K117

Manual operation: See "Offset Setting Table" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet<ch0>:
VALue <Offset>

Specifies Offset0 to Offset5 of the offset setting table.

Command sets the values in ms. Query returns values in s.

Parameters:
<Offset> float

Range: 0 s to depending on Max. Interval
Increment: 1.25
*RST: 0
Default unit: ms

Example: SOURce1:BB:BTO:ECON:PCON:OFFSet0:VALue 7
SOURce1:BB:BTO:ECON:PCON:OFFSet0:VALue?
// Response: "7.5"
Sets the Offset0 to 7.5 ms. The setting 7 ms is automatically
changed to the closest multiple of 1.25 ms, which is 7.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.
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Options: R&S SMW-K117

Manual operation: See "Offset Setting Table" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval
<Interval>

Sets the time interval between the start of two AUX_SYNC_IND PDUs from the same
advertising set.

Command sets the values in ms. Query returns values in s.

Parameters:
<Interval> float

Range: 7.5E-3 s to depending on oversampling
Increment: 0.01E-3
*RST: 20E-3
Default unit: ms

Example: SOURce1:BB:BTOoth:ECON:PCON:PAINterval 10
Sets a time interval of 10 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Periodic Advertising Interval" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity
<PPeriodicity>

Specifies a value the connection interval is preferred to be a multiple of.

Parameters:
<PPeriodicity> float

Range: 0  to  depends on Max. Interval
Increment: 0.01E-3
*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 180.

Options: R&S SMW-K117

Manual operation: See "Preferred Periodicity" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount
<RCECount>

Specifies the ReferenceConnEventCount field of LL_CONNECTION_PARAM_REQ.
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Parameters:
<RCECount> integer

Range: 0  to  65535
*RST: 0

Example: See Example"Configure event and frame configuration settings"
on page 180.

Options: R&S SMW-K117

Manual operation: See "Ref. Connection Event Count" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PNUMber <PNumber>

Sets the number of Tx packets per event.

Each connection contains at least one data channel packet. The maximum number of
packets per event is determined by the duration of the connection event interval.

Parameters:
<PNumber> integer

Range: 1  to  depends on connection event interval
*RST: 1

Example: SOURce1:BB:BTO:ECON:PNUM 2580
Sets the number of Tx packets per event.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "No. Of Tx Packets/Event" on page 55

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SDCI?

Queries the number of the first active data channel.

Return values: 
<SelectedChannel> integer

Range: 0  to  36
*RST: 0

Example: SOURce1:BB:BTOoth:ECONfiguration:SDCI?
Example: See also Example"Configure event and frame configuration set-

tings" on page 180.

Usage: Query only

Manual operation: See "Selected Data Channel Index" on page 56

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SINTerval <SInterval>

Sets the time interval between the starting points of two consecutive windows during
which the scanner is operating in an advertising channel.
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Command sets the values in ms. Query returns values in s.

Parameters:
<SInterval> float

Range: 10E-3 s to depends on oversampling and the num-
ber of advertsing channel table states

Increment: 0.625E-3
*RST: 10E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:SINT 3.5
Sets a time interval of 3.5 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Scan Interval" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:SWINdow <SWindow>

Sets the length of the window during which the scanner is operating in the advertising
channel.

Note that the scan window is less or equal to the value of the scan interval.

Command sets the values in ms. Query returns values in s.

Parameters:
<SWindow> float

Range: 10E-3 s to 10240E-3 s
Increment: 0.625E-3
*RST: 10E-3
Default unit: ms

Example: SOURce1:BB:BTO:ECON:SWIN 10
Sets the length of the window to 10 ms.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Manual operation: See "Scan Window" on page 53

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WOINfo?

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Queries the start point of the transmit window.

Return values: 
<WoInfo> string
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Example: SOURce1:BB:BTO:UPTY CREQ
Sets packet type CONNECT_IND
SOURce1:BB:BTO:ECON:PCON:WOIN?
Queries the start point of the transmit window.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Usage: Query only

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:WSINfo?

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Queries the size of the transmit window, regarding to the start point.

Return values: 
<WsInfo> string

Example: SOURce1:BB:BTO:UPTY CREQ
Sets packet type CONNECT_IND
SOURce1:BB:BTO:ECON:PCON:WSIN?
Queries the size of the transmit window.

Example: See also Example"Configure event and frame configuration set-
tings" on page 180.

Usage: Query only

Manual operation: See "Transmit Window Size" on page 54

8.5  Channel sounding commands - LE
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8.5.1  CS general commands

Example: To configure CS sequence settings
:SOURce1:BB:BTOoth:CINTerval 10
// The connection interval is 10 microseconds.
:SOURce1:BB:BTOoth:EINTerval 2
// The number of event intervals is two.
:SOURce1:BB:BTOoth:EOFFset?
// Response: "500"
// The event offset is 500 microseconds.
:SOURce1:BB:BTOoth:CS:ROLE?
// Response: "INITIATOR"
// The instrument initiates a channel sounding procedure.

Commands:

[:SOURce<hw>]:BB:BTOoth:CS:CINTerval....................................................................... 191
[:SOURce<hw>]:BB:BTOoth:CS:EINTerval....................................................................... 191
[:SOURce<hw>]:BB:BTOoth:CS:EOFFset........................................................................ 192
[:SOURce<hw>]:BB:BTOoth:CS:ROLE.............................................................................192

[:SOURce<hw>]:BB:BTOoth:CS:CINTerval <ConnectInterval>

Sets the time of the LE connection interval. The anchor points of two consecutive CS
events define the length of this interval.

Parameters:
<ConnectInterval> float

Range: 7.5  to  4000
Increment: 0.1
*RST: 7.5

Example: See Example"To configure CS sequence settings" on page 191.

Manual operation: See "Connection Interval" on page 50

[:SOURce<hw>]:BB:BTOoth:CS:EINTerval <EventInterval>

Sets the number of LE connection event intervals.

Parameters:
<EventInterval> integer

Range: 1  to  65535
*RST: 1

Example: See Example"To configure CS sequence settings" on page 191.

Manual operation: See "Event Intervals/Event_Interval" on page 50
See "Event_Interval" on page 124
See "Event_Interval" on page 127
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[:SOURce<hw>]:BB:BTOoth:CS:EOFFset <EventOffset>

Sets the time between the anchor point of the LE connection event and the beginning
of the CS event.

Parameters:
<EventOffset> integer

Range: 500  to  4e6
*RST: 500

Example: See Example"To configure CS sequence settings" on page 191.

Manual operation: See "Event Offset" on page 50

[:SOURce<hw>]:BB:BTOoth:CS:ROLE <Role>

Sets the role of the channel sounding device that is the R&S SMW200A.

Parameters:
<Role> INITIATOR | REFLECTOR

INITIATOR
The instrument initiates a CS procedure.
REFLECTOR
The instrument responds to a CS procedure.
*RST: INITIATOR

Example: See Example"To configure CS sequence settings" on page 191.

Manual operation: See "Role" on page 50

8.5.2  CS subevent commands

Example: To configure CS subevent settings
// *****************************************************************************
// Configure general settings of a CS subevent.
// *****************************************************************************
// Configure general subevent settings.
:SOURce1:BB:BTOoth:CS:SLENgth 1250
// CS subevent sequence length is 1250 microseconds.
:SOURce1:BB:BTOoth:CS:INTerval 1875
// CS subevent interval is 1875 microseconds.
:SOURce1:BB:BTOoth:CS:SSCHeduling?
// Response: "AUTO"
// CS step scheduling is automatic.
:SOURce1:BB:BTOoth:CS:SNUMber?
// Response: "1"
// Number of subevents is 1 subevent.
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// *****************************************************************************
// Configure channel selection settings of a CS subevent.
// *****************************************************************************
:SOURce1:BB:BTOoth:CS:CFCHm?
// Response: "#H00000000000000000001,80"
// CSFilteredChM value is 00000000000000000001 in hexadecimal reperesentation.
:SOURce1:BB:BTOoth:CS:CMRepetition 1
// Sets one cycle of the ChM field for non-Mode-0 steps within the CS procedure.
:SOURce1:BB:BTOoth:CS:CSEL?
// Response: "SEL_3B"
// The channel selection algorithm is Algorithm #3b.
// Optionally, enable and configure Algorithm #3c parameters.
:SOURce1:BB:BTOoth:CS:CSEL SEL_3C
:SOURce1:BB:BTOoth:CS:CTCShape HAT
// The channel has a rising ramp and a falling ramp.
:SOURce1:BB:BTOoth:CS:CTCJump JUMP_2

Commands:

[:SOURce<hw>]:BB:BTOoth:CS:SLENgth........................................................................ 193
[:SOURce<hw>]:BB:BTOoth:CS:SINTerval....................................................................... 193
[:SOURce<hw>]:BB:BTOoth:CS:SSCHeduling..................................................................194
[:SOURce<hw>]:BB:BTOoth:CS:SNUMber....................................................................... 194
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:NOSTep...................................................194
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SSPace?................................................. 195
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:TFCS...................................................... 195
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZSTeps................................................. 195

[:SOURce<hw>]:BB:BTOoth:CS:SLENgth <SubLength>

Sets the subevent length that is the duration of a CS subevent.

You can set values in multiples of 625 µs. Settable subevent lengths depend on the
number of event intervals, the connection interval, the event offset and the subevent
interval.

Parameters:
<SubLength> integer

Range: 1250  to  4e6
*RST: 1250

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Subevent Length" on page 92

[:SOURce<hw>]:BB:BTOoth:CS:SINTerval <SubInterval>

Sets the subevent interval. This interval is the time in multiples of 625 µs between the
beginning of a CS subevent and the beginning of the next CS subevent within the
same CS event.

For :SOURce1:BB:BTO:CS:SNUM 1, the subevent interval is 0μs.
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For :SOURce1:BB:BTO:CS:SNUM 2 or higher, settable subevent intervals depend on
the number of event intervals, the connection interval, the event offset and the sube-
vent length.

See also [:SOURce<hw>]:BB:BTOoth:CS:SNUMber on page 194.

Parameters:
<SubInterval> integer

Range: 0  to  2.7e11
*RST: 0

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Subevent Interval" on page 92

[:SOURce<hw>]:BB:BTOoth:CS:SSCHeduling <StepScheduling>

Sets the step scheduling mode.

Parameters:
<StepScheduling> AUTO | MANUAL

AUTO
Automatic CS step scheduling. The subevent length, the sube-
vent interval and the number of subevents are configurable.
The number of CS steps is 2.
MANUAL
Manual CS step scheduling. The subevent length is 1250 µs, the
subevent interval is 0 µs and the number of subevents is 1.
The number of CS steps is configurable.
*RST: AUTO

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Step Scheduling" on page 93

[:SOURce<hw>]:BB:BTOoth:CS:SNUMber <SubNumber>

Sets number of subevents. Settable values depend on the subevent interval.

Parameters:
<SubNumber> integer

Range: 1  to  32
*RST: 1

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Number of Subevents" on page 93

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:NOSTep <NumOfSteps>

Sets or display the number of CS steps.
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Setting requires manual step scheduling. Settable minimum values are 1 or equal to
the number of non-zero Mode-0 steps. See also [:SOURce<hw>]:BB:BTOoth:CS:
SSCHeduling on page 194.

Parameters:
<NumOfSteps> integer

Range: 2  to  160
*RST: 2

Example: See Example"To configure CS steps for subevent 0"
on page 196.

Manual operation: See "Number of Steps" on page 94

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SSPace?

Queries the subevent space in microseconds.

Return values: 
<SubeventSpace> integer

Range: 150  to  65535
*RST: 150

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "Subevent Space (µs)" on page 94

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:TFCS <TFcs>

Sets the frequency change period (T_FCS) between consecutive CS steps. The period
ranges from 15 μs to 150 μs.

Parameters:
<TFcs> TFCS_15 | TFCS_20 | TFCS_30 | TFCS_40 | TFCS_50 |

TFCS_60 | TFCS_80 | TFCS_100 | TFCS_120 | TFCS_150
TFCS_x, x represents values in microseconds.
*RST: TFCS_150

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "T_FCS (µs)" on page 94

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZSTeps <Mode0Steps>

Parameters:
<Mode0Steps> integer

Range: 1  to  3
*RST: 1

Manual operation: See "Mode-0 Steps" on page 94
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8.5.3  CS step configuration commands

Example: To configure CS steps for subevent 0
// *****************************************************************************
// Configure general CS step settings of the first subevent "Subevent 0".
// *****************************************************************************
// Configure general subevent settings.
:SOURce1:BB:BTOoth:CS:SLENgth 1250
// CS subevent sequence length is 1250 microseconds.
:SOURce1:BB:BTOoth:CS:INTerval 1875
// CS subevent interval is 1875 microseconds.
:SOURce1:BB:BTOoth:CS:SSCHeduling?
// Response: "AUTO"
// CS step scheduling is automatic.
:SOURce1:BB:BTOoth:CS:SNUMber?
// Response: "1"
// Number of subevents is 1 subevent.

Commands:

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMODe...................................................196
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMODe................................................... 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMASteps...............................................197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMISteps................................................ 197
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMSTeps?...............................................198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMRepetition...........................................198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMSTep?.................................................198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MONE:TIPO.............................................198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZERo:TIPO........................................... 198
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TSW?........................................199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TSW?...........................................199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:NAP?........................................ 199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:NAP?........................................... 199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TPM.......................................... 199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TPM.............................................199
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TIPT..........................................200
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TIPT.............................................200
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:STYPe.....................................................200
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SEQLength.............................................. 200
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPAYload................................................ 200
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPPattern................................................201

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMODe <mainMode>

Sets the main mode for the first subevent SEVent0. All following subevents use the
same main mode.
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For an overview on available submodes per main mode, see Table 5-8.

Parameters:
<mainMode> MODE1 | MODE2 | MODE3

MODE1
Mode-1 mode with no submode available.
MODE2
Mode-2 mode with submodes Mode-1 and Mode-3 available.
MODE3
Mode-3 mode with submodes Mode-1 and Mode-2 available.
*RST: MODE1

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Main_Mode" on page 100

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMODe <SubMode>

Sets the submode of the main mode.

Parameters:
<SubMode> MODE1 | MODE2 | MODE3 | NONE

See the table Table 5-8 for an overview on available submodes
per main mode.
*RST: NONE

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Sub_Mode" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMASteps <MMMaxSteps>

Sets the maximum number of main mode steps.

Parameters:
<MMMaxSteps> integer

Range: 2  to  255
*RST: 2

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Main_Mode_Max_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMISteps <MMMinSteps>

Sets the minimum number of main mode steps.

Parameters:
<MMMinSteps> integer

Range: 2  to  255
*RST: 2
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Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Main_Mode_Min_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMSTeps?

Queries the number of main mode CS steps.

Return values: 
<MMSTeps> integer

Range: 2  to  160
*RST: 2

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "Main_Mode_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MMRepetition <MMRepetition>

Sets the main mode repetition.

Parameters:
<MMRepetition> integer

Range: 0  to  3
*RST: 0

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Main_Mode_Repetition" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SMSTep?

Sets the number of submode CS steps.

Return values: 
<SubModeStep> integer

Range: 0  to  160
*RST: 0

Example: See Example"To configure CS steps for subevent 0"
on page 196.

Usage: Query only

Manual operation: See "Sub_Mode_Steps" on page 101

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MONE:TIPO <TIPO>
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZERo:TIPO <TIPO>
Sets the time "T_IP1" for Mode-0 and Mode-1 CS steps.
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Parameters:
<TIPO> TIP1_10 | TIP1_20 | TIP1_30 | TIP1_40 | TIP1_50 | TIP1_60 |

TIP1_80 | TIP1_145
TIP1_x, x represents values in microseconds.
*RST: TIP1_145

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "T_IP1" on page 102

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TSW?
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TSW?
Sets the time "T_SW" for Mode-2 or Mode-3 CS steps.

Return values: 
<Tsw> TSW_0 | TSW_1 | TSW_2 | TSW_4 | TSW_10

TSW_x, x represents values in microseconds.
*RST: TSW_0

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "T_SW" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:NAP?
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:NAP?
Sets the number of antenna path in the N_AP field for Mode-2 and Mode-3 CS steps.

Return values: 
<Nap> NAP_1 | NAP_2 | NAP_3 | NAP_4

NAP_x, x represents the path number.
*RST: NAP_1

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "N_AP" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TPM <Tpm>
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TPM <Tmp>
Sets the time "T_PM" for Mode-2 or Mode-3 CS steps.

Parameters:
<Tmp> TPM_10 | TPM_20 | TPM_40 | TPM_652

TPM_x, x represents values in microseconds.
*RST: TPM_40

Example: See Example"To configure CS subevent settings" on page 192.
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Manual operation: See "T_PM" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTHRee:TIPT <TIPT>
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MTWO:TIPT <TIPT>
Sets the time "T_IP2" for Mode-2 or Mode-3 CS steps.

Parameters:
<TIPT> TIP2_10 | TIP2_20 | TIP2_30 | TIP2_40 | TIP2_50 | TIP2_60 |

TIP2_80 | TIP2_145
TIP2_x, x represents values in microseconds.
*RST: TIP2_145

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "T_IP2" on page 105

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:STYPe <SeqType>

Sets the sequence type.

Parameters:
<SeqType> SOUNDING | RANDOM

SOUNDING
Sounding sequence
RANDOM
Random sequence
*RST: SOUNDING

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Sequence Type" on page 103

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:SEQLength <SeqLen>

Sets the sequence length. The length is discrete and depends on the sequence type.

Parameters:
<SeqLen> SL_32 | SL_64 | SL_96 | SL_128

*RST: SL_32

Example: See Example"To configure CS steps for subevent 0"
on page 196.

Manual operation: See "Sequence Length" on page 103

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPAYload <UserPayload>

Selects a data list file as the data source for a random CS sequence.

This sequence uses the CS_SYNC_User_Payload for CS step configuration modes
Mode-1 or Mode-3.
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Select the file from the default instrument directory or a specific directory.

Parameters:
<UserPayload> string

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Select Data List" on page 104

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:UPPattern <Pattern>

Selects the user payload pattern for a random CS sequence.

This pattern is the payload type for CS step configuration modes Mode-1 or Mode-3.

Parameters:
<Pattern> PRBS09 | RE1S | RE2S | PRBS15 | RE3S | RE4S | RE5S |

RE6S | UPLD
PRBS09|PRBS15
Pseudo random bit sequence with 9-bit length or 15-bit length in
accordance with the IUT-T.
RE1S|RE2S|RE3S|RE4S|RE5S|RE6S
Repeated 8-digit sequences of zeroes and ones.
UPLD
Uses the CS_SYNC_User_Payload. Set this payload via a data
list file and the following command:
:SOURce1:BB:BTOoth:CS:SEVent<ch0>:UPAYload
See also [:SOURce<hw>]:BB:BTOoth:CS[:
SEVent<ch0>]:UPAYload on page 200.
*RST: PRBS09

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "User Payload Pattern" on page 104
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8.5.4  CS step info commands

Example: To configure CS step settings for a subevent
// *****************************************************************************
// Configure general settings of a CS subevent.
// *****************************************************************************
// Configure general subevent settings.
:SOURce1:BB:BTOoth:CS:SLENgth 1250
// CS subevent sequence length is 1250 microseconds.
:SOURce1:BB:BTOoth:CS:INTerval 1875
// CS subevent interval is 1875 microseconds.
:SOURce1:BB:BTOoth:CS:SSCHeduling?
// Response: "AUTO"
// CS step scheduling is automatic.
:SOURce1:BB:BTOoth:CS:SNUMber?
// Response: "1"
// Number of subevents is 1 subevent.

Commands:

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:MTYPe?...............................202
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CINDex................................ 203
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CAADdress...........................203
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:SCONtent.............................203
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CSIGnal............................... 204
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DATA.......................................................204
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DLISt.......................................................204
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:PATTern...................................................205
[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CTEXtension........................ 205

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:MTYPe?

Queries the mode type for individual CS steps.

For the first CS step, the mode type is the Mode-0. For the other CS steps, the mode
type is the main mode in the CS step configuration.

Return values: 
<ModeType> MODE0 | MODE1 | MODE2 | MODE3

For a description, see [:SOURce<hw>]:BB:BTOoth:CS[:
SEVent<ch0>]:MMODe on page 196.
*RST: MODE0

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Usage: Query only

Manual operation: See "Mode Type" on page 109
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[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CINDex
<ChannlIndex>

Queries the channel index for individual CS steps.

Parameters:
<ChannlIndex> integer

Range: 0  to  78
*RST: 0

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Channel Index" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CAADdress
<AccessAddress>, <BitCount>

Sets or queries the 32-bit CS access address for individual CS steps.

Setting require manual step scheduling:

:SOURce1::BB:BTOoth:CS:SSCHeduling MANUAL
See also [:SOURce<hw>]:BB:BTOoth:CS:SSCHeduling on page 194.

Parameters:
<AccessAddress> numeric

*RST: #H00000000

<BitCount> integer
Range: 32  to  32
*RST: 32

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "CS Access Address" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:SCONtent
<SeqContent>, <BitCount>

Queries the content and the length of a sounding sequence or random sequence. The
content depends on the subevent mode.

For CS test packets, you can set the content for a sounding sequence and random
sequence.

Parameters:
<SeqContent> numeric

*RST: #H00000000
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<BitCount> integer
Range: 32  to  128
*RST: 32

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Sounding Sequence Content/Random Sequence Content"
on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CSIGnal
<CompanionSignal>

Sets the companion signal.

Parameters:
<CompanionSignal> NONE | P2 | M2 | P4 | M4 | M2P2 | M4P4

NONE
Companion signal is disabled.
P2|P4
Positive companion signal with values 2 or 4.
M2|M4
Negative companion signal with values -2 or -4.
M2P2|M4P4
Positive and negative companion signal with values -2 and 2 or
-4 and 4.
*RST: NONE

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DATA <DataSource>

Sets the data source for the companion signal.

Parameters:
<DataSource> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
*RST: PN09

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:DLISt <DataList>

Selects a data list file as the data source for the companion signal.
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Select the file from the default instrument directory or a specific directory.

Parameters:
<DataList> string

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:PATTern <Pattern>, <BitCount>

Sets the data pattern for the companion signal.

Parameters:
<Pattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "Companion Signal" on page 110

[:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>][:STEP<st0>]:CTEXtension
<CsToneExt>

Enables CS tone extension for mode-2 and mode-3 CS steps.

Parameters:
<CsToneExt> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS step settings for a subevent"
on page 202.

Manual operation: See "CS Tone Ext." on page 112

8.5.5  CS channel table commands

[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CFRequency?............................205
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CINDex?................................... 206
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CTYPe?.................................... 206
[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CALLowed................................ 206

[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CFRequency?

Queries the center frequency of the channel.
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Return values: 
<CenterFreq> float

For a description, see also table Table 2-13.
Range: 2402  to  2480
Increment: 2
*RST: 2402

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "Center Frequency (MHz)" on page 95

[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CINDex?

Queries the channel index of the channel.

Return values: 
<CsChannelIndex> integer

For a description, see also table Table 2-13.
Range: 0  to  78
*RST: 0

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "Channel Index" on page 96

[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CTYPe?

Queries the channel type that is Channel Sounding for all channels.

Return values: 
<ChannelType> CS

CS
Channel type is Channel Sounding.
*RST: CS

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "Channel Type" on page 96

[:SOURce<hw>]:BB:BTOoth:CS:CTABle[:CHANnel<ch0>]:CALLowed
<ChannelAllowed>

Enables transmission of the subevent via the selected channel.

Parameters:
<ChannelAllowed> 1 | ON | 0 | OFF

For a description, see also table Table 2-13.
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1|ON
Enables transmission of the subevent for the selected channel.
0|OFF
Disables transmission of the subevent for the selected channel.
*RST: 0

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Channel Allowed" on page 96

8.5.6  CS security commands

[:SOURce<hw>]:BB:BTOoth:CS:CIVC..............................................................................207
[:SOURce<hw>]:BB:BTOoth:CS:CIVP..............................................................................207
[:SOURce<hw>]:BB:BTOoth:CS:CINC............................................................................. 208
[:SOURce<hw>]:BB:BTOoth:CS:CINP..............................................................................208
[:SOURce<hw>]:BB:BTOoth:CS:CSPVc...........................................................................209
[:SOURce<hw>]:BB:BTOoth:CS:CPVP.............................................................................209

[:SOURce<hw>]:BB:BTOoth:CS:CIVC <CsIvC>, <BitCount>

Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IV_C parameter. The parameter is 64-bit in hexadecimal representation.

Parameters:
<CsIvC> numeric

CS_IV_C value in hexadecimal representation.
*RST: #H0

<BitCount> integer
Fixed bit count of 64 bits.
Range: 64  to  64
*RST: 64

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "CS_IV_C(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CIVP <CsIvP>, <BitCount>

Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IV_P parameter. The parameter is 64-bit in hexadecimal representation.

Parameters:
<CsIvP> numeric

CS_IV_P value in hexadecimal representation.
*RST: #H0
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<BitCount> integer
Fixed bit count of 64 bits.
Range: 64  to  64
*RST: 64

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "CS_IV_P(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CINC <CsInC>, <BitCount>

Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IN_C parameter. The parameter is 32-bit in hexadecimal representation.

Parameters:
<CsInC> numeric

CS_IN_C value in hexadecimal representation.
*RST: #H0

<BitCount> integer
Fixed bit count of 32 bits.
Range: 32  to  32
*RST: 32

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "CS_IN_C(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CINP <CsInP>, <BitCount>

Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_IN_P parameter. The parameter is 32-bit in hexadecimal representation.

Parameters:
<CsInP> numeric

CS_IN_P value in hexadecimal representation.
*RST: #H0

<BitCount> integer
Fixed bit count of 32 bits.
Range: 32  to  32
*RST: 32

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "CS_IN_P(hex)" on page 97
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[:SOURce<hw>]:BB:BTOoth:CS:CSPVc <csPvC>

Parameters:
<csPvC> 64 bits

Manual operation: See "CS_PV_C(hex)" on page 97

[:SOURce<hw>]:BB:BTOoth:CS:CPVP <CsPvP>, <BitCount>

Requires packet type CS SEQUENCE or LL_CS_SEC_REQ.

Sets the CS_PV_P parameter. The parameter is 64-bit in hexadecimal representation.

Parameters:
<CsPvP> numeric

CS_PV_P value in hexadecimal representation.
*RST: #H0

<BitCount> integer
Fixed bit count of 64 bits.
Range: 64  to  64
*RST: 64

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "CS_PV_P(hex)" on page 97

8.5.7  CS channel selection commands

[:SOURce<hw>]:BB:BTOoth:CS:CFCHm?........................................................................209
[:SOURce<hw>]:BB:BTOoth:CS:CMRepetition..................................................................210
[:SOURce<hw>]:BB:BTOoth:CS:CSEL.............................................................................210
[:SOURce<hw>]:BB:BTOoth:CS:CTCJump.......................................................................210
[:SOURce<hw>]:BB:BTOoth:CS:CTCShape......................................................................211

[:SOURce<hw>]:BB:BTOoth:CS:CFCHm? <BitCount>

Queries the value of the field CSFilteredChM.

This value determines the bit map for the Channel Sounding channel map update pro-
cedure. The parameter is 64-bit in hexadecimal representation.

Parameters:
<BitCount> integer

Fixed bit count of 80 bits.
Range: 80  to  80
*RST: 80
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Return values: 
<CsFilteredChM> numeric

CSFilteredChM value in hexadecimal representation.
*RST: #H0

Example: See Example"To configure CS subevent settings" on page 192.

Usage: Query only

Manual operation: See "CSFilteredChM(hex)" on page 98

[:SOURce<hw>]:BB:BTOoth:CS:CMRepetition <ChMRepetition>

Sets the 3-bit ChM_Repetition field.

The value equals the number of cycles of the ChM field for non-Mode-0 steps within a
CS procedure.

Parameters:
<ChMRepetition> integer

Range: 1  to  3
*RST: 1

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "ChM_Repetition" on page 98

[:SOURce<hw>]:BB:BTOoth:CS:CSEL <ChSel>

Sets the algorithm to select the channels.

Parameters:
<ChSel> SEL_3B | SEL_3C

SEL_3B
Sets for Algorithm #3b channel selection algorithm.
SEL_3C
Sets for Algorithm #3c channel selection algorithm.
For related parameters, see Table 5-7.
*RST: SEL_3B

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "ChSel" on page 98

[:SOURce<hw>]:BB:BTOoth:CS:CTCJump <ChThreeCJump>

Determines the number of skipped channels when rendering the channel shapes. The
Ch3cJump field has a length of 1 octet and relates to the channel index values.

Configure this field when using the channel selection algorithm Algorithm #3c:

:SOURce1:BB:BTOoth:CS:CSEL SEL_3C
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Parameters:
<ChThreeCJump> JUMP_2 | JUMP_3 | JUMP_4 | JUMP_5 | JUMP_6 | JUMP_7 |

JUMP_8
For Ch3cJump field parameters, see Table 5-7.
*RST: JUMP_2

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Ch3cJump" on page 99

[:SOURce<hw>]:BB:BTOoth:CS:CTCShape <ChThreeCShape>

Sets the bits of the Ch3cShape field. The field has a length of 4 bits and sets the shap-
ing method of the rising and falling ramps of the channels.

Configure this field when using the channel selection algorithm Algorithm #3c:

:SOURce1:BB:BTOoth:CS:CSEL SEL_3C
Parameters:
<ChThreeCShape> HAT | X

HAT
Channel with a rising ramp and a falling ramp.
X
Channel with interleaved rising and falling ramps.
*RST: HAT

Example: See Example"To configure CS subevent settings" on page 192.

Manual operation: See "Ch3cShape" on page 99

8.6  Packet configuration commands - LE

Example: To configure advertising packets
// ******************************************************************
// Configure packet for ADV_SCAN_IND: switch off whitening,
// set Tx device address type, AdvA, data source and length
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ADC
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe PUBL
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap #H017412,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP #H9E8B00,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DATA PN09
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth 31
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// ******************************************************************
// Alternatively set periodic advertising interval for AUX_SYNC_IND
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe ASIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval 

// ******************************************************************
// Select packet type AUX_ADV_IND. (All parameters of
// extended header are configurable with AUX_ADV_IND packet 
// type.) Set channel selection,
// Tx device address type, advertising mode.  
// Enable extended header for advertising PDUs. Enable all
// flags: AdvA, TargetA, AdvData Info, Aux Ptr, Sync Info,
// TxPow. Set Tx power value and ACAD length and pattern.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe ADV
SOURce1:BB:BTOoth:UPTYpe AAIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection CS1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe PUBL
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe NCNS
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:AADDress:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:TADDress:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:ADINfo:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:APTR:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:SINFo:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:TPOWer:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer -100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth 16
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD PN16

// ******************************************************************
// Alternatively set user-defined pattern.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD PATTern
SOURce1:BB:BTOoth:ECONfiguration:PCON:ACAD:APATtern #B011000011,9
// ******************************************************************
// Alternatively set pattern from data list.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD DLISt
SOURce1:BB:BTOoth:ECON:PCON:ACAD:ASEL "p:/pattern1.dm_iqd

// ******************************************************************
// Enable AdvData Info flag, set advertising data ID and 
// advertising data set ID.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:ADINfo:STATe ON
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SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ADID #H01FF,12
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ASID #H0F,4
// ******************************************************************
// Enable and specify AuxPtr for the secondary advertising 
// channel: select AUX channel, set clock accuracy, offset unit,
// AUX offset, AUX PHY.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:APTR:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:DCTable:CHANnel0:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy T500
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits U30
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:APHY L1M
// ******************************************************************
// Enable and specify SyncInfo field for the AUX_SYNC_IND 
// packet: set sync packet offset, offset unit, periodic adv 
// interval, sleep clock accuracy, access address, CRC initial 
// value. Reset event counter. Configure channel map.
// ******************************************************************
SOURce1:BB:BTOoth:ECONfiguration:PCON:EHFLags:SINFo:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PAINterval 20
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy SCA0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress #HACDE48AC,32
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CIV #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits U30
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset?
// 99.9
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter 0
SOURce1:BB:BTOoth:ECONfiguration:PCON:DCMTable:CHANnel0:STATe 1

// ******************************************************************
// Configure advertiser, scanner and initiator device addresses.
// Company_Assigned and Company_Id in Advertiser´s Device Address
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACAS #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACID #H000000,24
// Company_Assigned and Company_Id in Scanners Device Address
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCAS #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCID #H000000,24
// Company_Assigned and Company_Id in Initiators Device Address
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ICAS #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ICID #H000000,24
// ******************************************************************
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Example: To configure data packets
// ******************************************************************
// Configure signal for DATA: select channel type, packet type,
// packet format, sequence length, role, enable CRC corruption.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CUR
SOURce1:BB:BTOoth:PFORmat L1M
SOURce1:BB:BTOoth:USLength 12
SOURce1:BB:BTOoth:BCRole CENTral
SOURce1:BB:BTOoth:CCRC:STATe 1

// ******************************************************************
// Configure packet type DATA: access address, CRC initial,
// NESN start, SN start values, data source, data length
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe DATA
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress #HDAB85479,32
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DATA PN09
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth 251

// ******************************************************************
// Configure payload of LL_CONNECTION_UPDATE_IND: transmit 
// window size and offset, connection event interval, Peripheral 
// latency, LL connection timeout, connection instant.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CUR
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress #HDAB85479,32
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue #H000000,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize 1.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval 7.5
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PSLatency 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant 0

// ******************************************************************
// Configure the payload of LL_FEATURE_REQ: set packet
// type, feature set length and configure feature set. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe FREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength 8
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit0:STATe 1
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SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit1:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit2:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit3:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit4:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit5:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit6:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit7:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit8:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit9:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit10:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit11:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit12:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit13:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit14:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit15:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit16:STATe 0

// ******************************************************************
// Configure the payload of LL_CONNECTION_PARAM_REQ: max. and min.
// interval, Peripheral latency, LL connection timeout, preferred
// periodicity, reference connection even count
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe CPR
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MXINterval 10
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MNINterval 7.5
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PSLatency 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout 100
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PPERiodicity 1.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RCECount 10
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet0:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet0:VALue 3.75
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet1:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet1:VALue 5
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet2:STATe ON
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet2:VALue 6.25
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet3:STATe OFF
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet4:STATe OFF
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OFFSet5:STATe OFF

// ******************************************************************
// Configure the payload of LL_LENGTH_REQ: max. Rx and TX 
// payload octets, max. time to receive and transmit a packet.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe LREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets 27
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets 27
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime 0.328
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime 0.328
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// ******************************************************************
// Set the payload of LL_PHY_REQ: specify preferred Tx, Rx PHYs. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe PREQ
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:STATe 0

// ******************************************************************
// Set the payload of LL_PHY_UPDATE_IND: specify PHYs for
// Central-to-Peripheral and Peripheral-to-Central direction and instant. 
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe PUIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant 1

// ******************************************************************
// Set the payload of LL_REJECT_EXT_IND: set reject opcode
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe REIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode #H02,8

// ******************************************************************
// Set the payload of LL_MIN_USED_CHANNELS_IND: set the controller 
// role to Peripheral, set the packet type, specify PHYs and minimum
// used channels requirement
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:BCRole PERipheral
SOURce1:BB:BTOoth:UPTYpe MUCH
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels 2

// ******************************************************************
// Set header and payload of LL_PERIODIC_SYNC_IND: enable CTE and 
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// configure CTE method, set event counter properties, specify PHYs
// and address type.
// ******************************************************************
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe PSIN
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe 0.016
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe AOD1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANTNumber 4
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANTGain0?
// Response: "0"
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANTGain1 3
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANTGain2 -3
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ANTGain3 10
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ID #HAAAA,16
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset 245.7
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits U30
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust 1
// Enabling offset adjust sets the Sync packet offset to 300 µs.
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits U300
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CECount 65535
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter 65535
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SID #H1,4
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe PUBL
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy SCA0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe 1
// Enabling another PHY automatically disables the previous PHY.
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe 1
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe? 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe? 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned #H000080,24
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter 65535

● General configuration............................................................................................217
● Header configuration.............................................................................................219
● Payload configuration............................................................................................222
● Cs payload configuration.......................................................................................251

8.6.1  General configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening.......................... 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress............................ 218
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue................................ 218
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DWHitening
<DWhitening>

Activates or deactivates the Data Whitening. Evenly distributed white noise is ideal for
the transmission and real data can be forced to look similar to white noise with different
methods called Data Whitening. Applied to the PDU and CRC fields of all packet types,
whitening is used to avoid long equal seqeunces in the data bit stream.

Parameters:
<DWhitening> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Data Whitening" on page 59

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AADDress
<AAddress>, <BitCount>

Sets the access address of the link layer connection (32-bit string).

Parameters:
<AAddress> numeric

*RST: #HACDE48AC

<BitCount> integer
Range: 32  to  32
*RST: 32

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "Access Address" on page 59

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CIValue <CiValue>,
<BitCount>

Sets the initialization value for the CRC (Cyclic Redundancy Check, 24 bits) calcula-
tion. A packet has been received correctly, when it has passed the CRC check.

Parameters:
<CiValue> numeric

*RST: #H0

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "CRC Initial Value(hex)" on page 60
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8.6.2  Header configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection.......................... 219
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue............................... 219
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue............................... 219
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent.............................220
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe..................................220
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq................................. 220
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe................................. 221
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0>......................................... 221
[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber............................................. 221

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CSELection
<CSelection>

Specifies the algorithm of channel selection.

Parameters:
<CSelection> CS1 | CS2

Algorithm #1 or algorithm #2
*RST: CS1

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Channel Selection" on page 61

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSValue <NsValue>

Sets the start value of the next expected packet from the same device in the LL con-
nection ("N"ext"E"xpected "S"equence"N"umber). This parameter can be set in the first
event. From the second event this field is not indicated.

Parameters:
<NsValue> integer

Range: 0  to  1
*RST: 1

Example: See Example"To configure data packets" on page 214.

Manual operation: See "NESN Start Value" on page 60

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSValue <SsValue>

Sets the sequence number of the packet. This parameter can be set in the first event.
From the second event, this field is not indicated.

Parameters:
<SsValue> integer

Range: 0  to  1
*RST: 0

Packet configuration commands - LE



Remote control commandsR&S®SMW-K60/-K117/-K178

220User Manual 1175.6803.02 ─ 26

Example: See Example"To configure data packets" on page 214.

Manual operation: See "SN Start Value" on page 61

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent <State>

Activates the CTEInfo field in the header of Bluetooth LE data packets in the LE unco-
ded PHY.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "CTEInfo Present" on page 61

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTIMe <CTime>

Sets the CTETime comprising the length of constant tone extension field of the Blue-
tooth LE PDU.

Parameters:
<CTime> float

Range: 16E-6  to  160E-6
Increment: 8E-6
*RST: 16E-6

Example: See Example"To configure data packets" on page 214.

Manual operation: See "CTETime" on page 62

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTReq <CTReq>

Sets the CTE type in the CTETypeReq field of the CtrData field of the LL_CTE_REQ
PDU.

Parameters:
<CTReq> AOD1 | AOA | AOD2

AOA
AoA Constant Tone Extension
AOD1
AoD Constant Tone Extension with 1 µs time slots
AOD2
AoD Constant Tone Extension with 2 µs time slots
*RST: AOA

Example: See Example"To configure data packets" on page 214.

Manual operation: See "CTETypeReq" on page 89
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CTYPe <CType>

Sets the type of constant tone extension. The type specifies the CTE AoA/AoD method
and for AoD the length of the switching and I/Q sampling slots.

Parameters:
<CType> AOD1 | AOA | AOD2

AOA
AoA Constant Tone Extension
AOD1
AoD Constant Tone Extension with 1 µs time slots
AOD2
AoD Constant Tone Extension with 2 µs time slots
*RST: AOA

Example: See Example"To configure data packets" on page 214.

Manual operation: See "CTEType" on page 63

[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTGain<ch0> <AntennaGain>

Specifies the gain of the antenna. You can specify the antenna gain infomation of up
for four individual antennas for direction finding.

Parameters:
<AntennaGain> float

Range: -10  to  10
Increment: 0.01
*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "AntennaX Gain" on page 63

[:SOURce<hw>]:BB:BTOoth:ECONfig:PCONfig:ANTNumber <AntennaNum>

Specifies the number of antenas for angle of departure (AoD) direction finding method.
You select up to four antennas, that are used for direction finding.

Parameters:
<AntennaNum> integer

Range: 1  to  4
*RST: 1

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Antenna Number" on page 63
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8.6.3  Payload configuration

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD...................................224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATtern.................... 224
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection.................225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID....................................225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned......................... 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned......................... 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID....................................225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned.......................... 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID..................................... 225
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID....................................226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP................................... 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP.....................................226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP................................... 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP................................... 226
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth...............................227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe................................ 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap................................. 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap.................................. 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap................................. 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap................................. 227
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset...............................228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits...............................228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY...................................228
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID.................................... 229
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy.......................... 229
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID......................................230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant.............................. 230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval............................. 230
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA................................... 231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATtern.....................231
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection................. 232
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth.............................. 232
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe................................ 232
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter............................. 233
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier.......................... 233
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe.................... 233
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:AADDress:STATe....234
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:STATe.........234
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:STATe.......... 234
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFo:STATe..........235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFo:STATe..........235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TADDress:STATe.... 235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TPOWer:STATe...... 235
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe................ 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength..............................236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth.............................. 236
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout............................237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector...............................237
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVector............................... 237
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets............................ 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets.............................238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD.................................. 238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD...................................238
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime............................... 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime................................239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels........................ 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:STATe..............239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:STATe..............239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:STATe........... 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:STATe..............239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:STATe..............239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:STATe........... 239
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval............................240
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout......................... 240
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency............................241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset............................ 241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize................................241
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust...............................242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe................. 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe................. 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe...............242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe................................ 242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYpe................................242
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode.............................243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe................243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe................243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:STATe.............243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe................243
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe................244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:STATe............. 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor...............................244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy......................... 244
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency............................. 245
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits...............................245
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset..............................246
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber............................246
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer............................... 246
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe................................. 247
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber............................. 247
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset..............................247
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe..................................248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe..................................248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount.............................. 248
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID........................................ 249
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter..........................249
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq...............................249
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe....................250
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe....................250
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe................. 250
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter......................... 250
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID...................................... 251

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD <Data>

Specifies the pattern source used for additional controller advertising data (ACAD).

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
ALL0 / ALL1
All 0 or all 1 pattern
PATTern
User-defined pattern. The pattern can be specified via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:ACAD:APATtern on page 224
PNxx
Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9, 11, 15, 16, 20, 21, or 23.
DLISt
Internal ACAD data list is used. The data list can be specified
via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:ACAD:ASELection on page 225
*RST: PN09

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "ACAD" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:APATtern
<DPattern>, <BitCount>

Specifies user-defined pattern. The settings is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD
PATTern
Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117
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Manual operation: See "AList / Pattern" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACAD:ASELection
<DSelection>

Specifies data list file. The settings is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACADDLISt
Parameters:
<DSelection> string

Path and file name.

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "AList / Pattern" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACID <Acid>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ACASsigned
<AcAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCASsigned
<ScAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCID <Scid>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICASsigned
<IcAssigned>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ICID <Icid>,
<BitCount>

Sets the advertiser´s device address. For advertising channel packets, the format of
the device address differs, depending on the selected address type.

● "Public Address Types"
The public address is given from the registration authority IEEE and is composed
of:
– LSB: 24 bits = company_assigned
– MSB: 24 bits = company_id

● "Random Address Type" is a 48-bits random static device address.
● "Private Address Type"

A private address is optional and composed of:
– LSB: 24 bits = hash
– MSB: 24 bits = random

Parameters:
<Icid> numeric

*RST: #HACDE48
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<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "Initiator's Device Addr" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ADID <Adid>,
<BitCount>

Specifies "Advertising Data ID" in hexadecimal format to be signaled within an exten-
ded header.

Parameters:
<Adid> numeric

*RST: #H000

<BitCount> integer
Range: 12  to  12
*RST: 12

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Advertising Data ID(hex)" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ILAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLAP <Lap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TLAP <Lap>,
<BitCount>

Sets the lower address part (LAP) of Bluetooth device address. Commands for the
advertising ..:ALAP, initiating ..:ILAP, scanning ..:SLAP PDUs of advertising
channel type are provided. In addition, a command is provided for scanner’s or initia-
tor’s target device address to which the advertisement is directed ..:TLAP.

Parameters:
<Lap> numeric

*RST: #H000080

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117
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Manual operation: See "Target's Device Addr" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ALENgth <Length>

Specifies the length of ACAD data pattern.

Parameters:
<Length> integer

Range: 0  to  62
*RST: 27

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "ACAD Length" on page 70

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AMODe <AMode>

Indicates the mode of the advertisement.

Parameters:
<AMode> NCNS | CNS | NCS

NCNS: Non-connectable, non-scannable
CNS: Connectable, non-scannable
NCS: Non-connectable, non-scannable
*RST: NCNS

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Advertising Mode" on page 67

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ANUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:INUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SNUap <NapUap>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TNUap <NapUap>,
<BitCount>

Sets the non-significant address part (NAP) and upper address part (UAP) of Bluetooth
device address. Commands for the advertising ..:ANUap, initiating ..:INUap, and
scanning ..:SNUap PDUs of advertising channel type are provided. In addition, a
command is provided for scanner’s or initiator’s target device address to which the
advertisement is directed ..:TNUap.

Parameters:
<NapUap> numeric

*RST: #HACDE48
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<BitCount> integer
Range: 24  to  24
*RST: 24

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Target's Device Addr" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset <AOffset>

Specifies the time from the start of the packet containing the AuxPtr field to the approx-
imate start of the auxiliary packet. The offset is determined by multiplying the value by
the unit, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits
Parameters:
<AOffset> float

Range: 0 to 245.7 or 246 to 2457 depending on offset unit

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "AUX Offset" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOUNits <Unit>

Indicates the units used by the "Aux Offset" parameter, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:AOFFset
Parameters:
<Unit> U30 | U300

U30: 30 µs
U300: 300 µs
*RST: U30

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Offset Units" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:APHY <APhy>

Sets the physical layer (PHY) to transmit the auxiliary packet.
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Parameters:
<APhy> L1M | L2M | LCOD | L2M2B

For a description, see [:SOURce<hw>]:BB:BTOoth:PFORmat
on page 177.
*RST: L1M

Example: See Example"To configure advertising packets" on page 211.

Options: L2M and LCOD require option R&S SMW-K117.
L2M2B requires option R&S SMW-K178.

Manual operation: See "AUX PHY" on page 72

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ASID <Asid>,
<BitCount>

Specifies the "Advertising Set ID" in hexadecimal format to be signaled within an
extended header.

Parameters:
<Asid> numeric

*RST: #H0

<BitCount> integer
Range: 4  to  4
*RST: 4

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Advertising Set ID(hex)" on page 71

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CACCuracy
<CAccuracy>

Specifies the clock accuracy of the advertiser used between the packet containing this
data and the auxiliary packet.

Parameters:
<CAccuracy> T500 | T50

T500: 51 ppm to 500 ppm
T50: 0 ppm to 50 ppm
*RST: T500

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Clock Accuracy" on page 72
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CID <Cid>,
<BitCount>

Sets the company identifier of the manufacturer of the Bluetooth Controller. A 16 bit
value is set.

Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.

Parameters:
<Cid> numeric

*RST: 0

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Company Id(hex)" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINStant
<CInstant>

Sets a connection instant for indicating the connection event at which the new connec-
tion parameters are taken in use.

Parameters:
<CInstant> integer

Range: 1  to  depends on sequence length
*RST: 1

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Connection Instant" on page 82
See "Connection Instant" on page 129

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CINTerval
<CInterval>

Sets the time interval between the start points of two consecutive connection events for
the packet type DATA and all CONTROL_DATA packet types.

Command sets the values in ms. Query returns values in s.

Parameters:
<CInterval> float

Range: 7.5E-3 s to depends on oversampling
Increment: 1.25E-3 s
*RST: 7.5E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 214.
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Manual operation: See "Connection Event Interval" on page 55

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA <Data>

Selects the pattern source used for the payload.

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
ALL0 / ALL1
All 0 or all 1 pattern
PATTern
User-defined pattern. The pattern can be specified via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DPATtern on page 231
PNxx
Pseudo-random bit sequences (PRBS) of a length of xx bits.
The length in bit can be 9, 11, 15, 16, 20, 21, or 23.
DLISt
Internal data list is used. The data list can be specified via:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DSELection on page 232
*RST: PN09

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "Data Source" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DPATtern
<DPattern>, <BitCount>

Specifies the user-defined pattern. The setting is relevant for

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA
PATTern
Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Data Source" on page 65
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DATA:DSELection
<DSelection>

Selects a data list file from the default directory or from the specific directory.

Using data list (DLISt) data requires one of the following commands:
● BB:BTO:ECON:PCON:DATA DLISt

See [:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:
DATA on page 231.

● BB:BTO:DTT:TPC:UPS DLISt
See [:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource
on page 271.

Parameters:
<DSelection> string

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "Data Source" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:DLENgth
<DLength>

Sets the payload data length in bytes.

Parameters:
<DLength> integer

Range: 0  to  255 (advertiser) or 251 (data)
*RST: 31

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "Data Length" on page 65

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECODe <ECode>,
<BitCount>

Sets the error code value to inform the remote device why the connection is about to
be terminated in case of LL_TERMINATE_IND packet. On the other hand, this param-
eter for LL_REJECT_IND packet is used for the reason a request was rejected. A 8 bit
value is set.

Note: This parameter is relevant for data frame configuration and the packet type:

● LL_TERMINATE_IND
● LL_REJECT_IND

Parameters:
<ECode> numeric

*RST: #H00
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<BitCount> integer
Range: 8  to  8
*RST: 8

Example: SOURce1:BB:BTO:ECON:PCON:ECOD #H00,8
Sets the error code.

Manual operation: See "Error Code(hex)" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ECOunter
<ECounter>

Counts the AUX_SYNC_IND packets that the SyncInfo field describes.

Parameters:
<ECounter> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Event Counter" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EDIVersifier
<EDiversifier>, <BitCount>

Sets the encrypted diversifier of the Central for device identification. The parameter is
an initialization vector provided by the host in the HCI_ULP_Start_Encryption com-
mand.

Parameters:
<EDiversifier> numeric

*RST: #H0000

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: SOURce1:BB:BTO:ECON:PCON:EDIV #H0000,16
Sets the encrypted diversifier of the Central.

Manual operation: See "Encrypted DIVersifier(hex)" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHEader:STATe
<State>

Enables / disables extended header for advertising packets with scanning PDUs.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1
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Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Extended Header" on page 67

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
AADDress:STATe <State>

If enabled, the R&S SMW200A includes the signaling of non-significant advertising
address part (NAP) and upper address part (UAP).

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "AdvA" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:ADINfo:
STATe <State>

Enables / disables the signaling of advertising data information consisting of "Advertis-
ing Data ID" and "Advertising Set ID".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "AdvDataInfo" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:APTR:
STATe <State>

Enables / disables secondary advertising channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "AuxPtr" on page 69
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:CINFo:
STATe <State>

Activates the CTEInfo field in the extended header of Bluetooth LE advertising packets
in the LE uncoded PHY.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Manual operation: See "CTEInfo" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:SINFo:
STATe <State>

Enables / disables the signaling of SyncInfo field for periodic advertisement.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "SyncInfo/SyncInfo Configuration" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:
TADDress:STATe <State>

Enables / disables the signaling of non-significant address part (NAP) and upper
address part (UAP) of a target address.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "TargetA" on page 68

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:EHFLags:TPOWer:
STATe <State>

Enables the signaling of required transmit power.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "TxPow(dBm)" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSBit<ch0>:STATe
<State>

Requires link layer control PDUs LL_FEATURE_REQ, LL_FEATURE_RSP or
LL_PERIPHERAL_FEATURE_REQ, see [:SOURce<hw>]:BB:BTOoth:UPTYpe
on page 177.

Enables features of the feature set within the the link layer control PDU. See also
Table 5-5.

Suffix: 
<ch0>

.
0 to 27
Bit number that relates to a feature

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "FeatureSet configuration table" on page 90

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:FSLength
<FsLength>

Enables that the feature set length is indicated.

Parameters:
<FsLength> integer

Range: 1 to 26
*RST: 8

Example: See Example"To configure data packets" on page 214.

Manual operation: See "FeatureSet Length" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:HLENgth
<HLength>

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Sets the difference from the current channel to the next channel.
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The Central and Peripherals determine the data channel in use for every connection
event from the channel map. Hop_length is set for the LL connection and communica-
ted in the CONNECT_IND and LL_CHANNEL_MAP_IND packets.

Parameters:
<HLength> integer

Range: 5  to  16
*RST: 5

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Hop Length" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LCTimeout
<LcTimeout>

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost for the packet type CON-
NECT_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<LcTimeout> float

Range: 100E-3 s to 32000E-3 s
Increment: 10E-3 s
*RST: 100E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 214.

Manual operation: See "LL Connection Timeout" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MIVector
<MiVector>, <BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SIVector
<SiVector>, <BitCount>

Sets the portion of Central or the portion of the Peripheral of the initialization vector
(IVm/IVs).

Parameters:
<SiVector> numeric

*RST: #H0

<BitCount> integer
Range: 32  to  32
*RST: 32
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Example: SOURce1:BB:BTO:ECON:PCON:MIV
#H0000000000000000,32
(Central).
SOURce1:BB:BTO:ECON:PCON:SIV
#H0000000000000000,32
(Peripheral).

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MROCtets
<MROctets>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTOCtets
<MTOctets>

Specifies the maximum allowed payload length of a packet to be received
(..:MROCtets) or transmitted (..:MTOCtets). Information is signaled via
LL_LENGTH_REQ and LL_LENGTH_RSP.

Parameters:
<MTOctets> integer

Range: 27  to  251
*RST: 27

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "MaxRxOctets/MaxTxOctets" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MSKD <Mskd>,
<BitCount>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SSKD <Sskd>,
<BitCount>

Sets the portion of Central or the portion of the Peripheral of the session key diversifier
(SKDm/SKDs).

Parameters:
<Sskd> numeric

*RST: #H0

<BitCount> integer
Range: 64  to  64
*RST: 64

Example: SOURce1:BB:BTO:ECON:PCON:MSKD
#H0000000000000000,64
(Central).
SOURce1:BB:BTO:ECON:PCON:SSKD
#H0000000000000000,64
(Peripheral).
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MRTime <MRTime>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTTime <MTTime>
Specifies the maximum allowed time to receive (..:MRTime) or transmit (..:MTTime)
a packet. Information is signaled via LL_LENGTH_REQ and LL_LENGTH_RSP.

Parameters:
<MTTime> float

Range: 0.328E-3  to  17.04E-3
Increment: 0.001E-3
*RST: 17.04E-3

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "MaxRxTime/MaxTxTime" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MUCHannels
<Muchannels>

Specifies the minimum number of channels to be used on the specified PHYs, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:
STATe etc.

Parameters:
<Muchannels> integer

Range: 2  to  37
*RST: 2

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "Min Used Channels" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L1M:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:L2M:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MTSPhy:LCOD:
STATe <MTSP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L1M:
STATe <STMP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:L2M:
STATe <STMP>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:STMPhy:LCOD:
STATe <STMP>

Specifies the physical layers in Central-to-Peripheral (..:MTSPhy:..) or Peripheral-
to-Central (..:STMPhy:..) direction. Information is signaled via
LL_PHY_UPDATE_IND.

Packet configuration commands - LE



Remote control commandsR&S®SMW-K60/-K117/-K178

240User Manual 1175.6803.02 ─ 26

You can enable one or more PHYs:
● L1M: for LE uncoded 1 Msymbol/s PHY.
● L2M: for LE uncoded 2 Msymbol/s PHY.
● LCOD: for LE coded 1 Msymbol/s PHY.

Parameters:
<STMP> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "M_TO_S_PHY/S_TO_M_PHY" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NCINterval
<NcInterval>

Sets the time interval new connection events for the packet types CONNECT_IND and
LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NcInterval> float

Range: 7.5E-3 s to depends on oversampling
Increment: 1.25E-3 s
*RST: 7.5E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Connection Event Interval" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NLCTimeout
<NlcTimeout>

Defines the maximum time between two correctly received Bluetooth LE packets in the
LL connection before the connection is considered lost only for the packet type
LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NlcTimeout> float

Range: 100E-3 s to 32000E-3 s
Increment: 10E-3 s
*RST: 100E-3 s
Default unit: ms

Example: See Example"To configure data packets" on page 214.

Manual operation: See "LL Connection Timeout" on page 78

Packet configuration commands - LE



Remote control commandsR&S®SMW-K60/-K117/-K178

241User Manual 1175.6803.02 ─ 26

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NSLatency
<NsLatency>

Requires a data event and advertising frame configuration with the packet type
LL_CONNECTION_UPDATE_IND.

Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.

Parameters:
<NsLatency> integer

Range: 0  to  depends on LL connection timeout and con-
nection event interval

*RST: 0

Example: SOURce1:BB:BTO:UPTY CUR
sets packet type LL_CONNECTION_UPDATE_IND
SOURce1:BB:BTO:ECON:PCON:NSLatency 10
sets the number of consecutive connection events.

Manual operation: See "Peripheral Latency" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWOFfset
<NwOffset>

Sets the start point of the transmit window for data event and advertising frame config-
uration with the packet type LL_CONNECTION_UPDATE_IND.

Command sets the values in ms. Query returns values in s.

Parameters:
<NwOffset> float

Range: 0 s to depends on connection event interval
Increment: 1.25E-3 s
*RST: 0
Default unit: ms

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Transmit Window Offset" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:NWSize <NwSize>

Sets the size of the transmit window, regarding to the start point for data event and
advertising frame configuration with the packet type LL_CONNEC-
TION_UPDATE_IND.

Parameters:
<NwSize> float

Range: 1.25E-3  to  depends on connection event interval
Increment: 1.25E-3
*RST: 1.25E-3
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Example: See Example"To configure data packets" on page 214.

Manual operation: See "Transmit Window Size" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:OADJust <State>

Adjusts the "Sync Packet Offset" automatically to the next value, which is a multiple of
the ""Offset Units".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Offset Adjust" on page 74

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L1M:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:L2M:STATe
<State>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHYS:LCOD:STATe
<State>

Specifies the physical layers for which the Peripheral has a minimum number of used
channels requirement. Information is signaled via LL_MIN_USED_CHANNELS_IND.

You can enable one or more PHYs:
● L1M: for LE uncoded 1 Msymbol/s PHY.
● L2M: for LE uncoded 2 Msymbol/s PHY.
● LCOD: for LE coded 1 Msymbol/s PHY.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "PHYs" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TATYpe <TaType>
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RATYpe <RaType>
Selects the address type of the controller device.
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Depending on the Bluetooth controller role either Tx or Rx or both address types are
assigned. Subdivided into private and random, a Bluetooth LE device address consits
of 48 bits. The format of the device address differs depending on the selected address
type.

Parameters:
<RaType> PUBLic | RANDom

PUBlic
Allocates a unique 48 bit address to each Bluetooth LE device.
The public address is given from the registration authority IEEE.
RANDom
Allocates a 48-bit address to each Bluetooth LE device. A ran-
dom address is optional.
*RST: PUBLic

Example: SOURce1:BB:BTO:ECON:PCON:TATY PUBL
SOURce1:BB:BTO:ECON:PCON:RATY RAND

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ROPCode
<ROpcode>, <BitCount>

Specifies the Opcode of rejected LL control PDU. information is signaled via
LL_REJECT_EXT_IND.

Parameters:
<ROpcode> numeric

*RST: #H00

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "Reject Opcode" on page 85

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L1M:STATe
<RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:L2M:STATe
<RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RPHYs:LCOD:
STATe <RPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L1M:STATe
<TPhys>
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:L2M:STATe
<TPhys>

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPHYs:LCOD:
STATe <TPhys>

Specifies preferred physical layers in Rx (..:RPHYs:..) or Tx (..:TPHYs:..) direc-
tion. Information is signaled via LL_PHY_REQ and LL_PHY_RSP.

You can enable one or more PHYs: :L1M: for LE uncoded 1 Msymbol/s PHY, :L2M:
for LE uncoded 2 Msymbol/s PHY, and :LCOD: for LE coded 1 Msymbol/s PHY.

Parameters:
<TPhys> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Options: R&S SMW-K117

Manual operation: See "TX PHYS/RX PHYS" on page 86

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:RVECtor
<RVector>, <BitCount>

Sets the random vector of the Central for device identification.

The parameter is an initialization vector provided by the Host in the
HCI_ULP_Start_Encryption command.

Parameters:
<RVector> numeric

*RST: #H0

<BitCount> integer
Range: 64  to  64
*RST: 64

Example: SOURce1:BB:BTO:ECON:PCON:RVEC
#H0000000000000000,64
Sets the random vector of the Central.

Manual operation: See "Random Vector(hex)" on page 82

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCACcuracy
<ScAccuracy>

Defines the clock accuracy of the Central with specified encoding.

This parameter is used by the Peripheral to determine required listening windows in
the LL connection. It is a controller design parameter known by the bluetooth controller.

Parameters:
<ScAccuracy> SCA0 | SCA1 | SCA2 | SCA3 | SCA4 | SCA5 | SCA6 | SCA7

*RST: SCA0
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Example: SOURce1:BB:BTO:ECON:PCON:SCAC SCA1
Sets the encoding value.

Manual operation: See "Sleep Clock Accuracy" on page 79

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SLATency
<SLatency>

Requires data event and advertising frame configuration with the packet type CON-
NECT_IND.

Sets the number of consecutive connection events the Peripheral can ignore for asym-
metric link layer connections.

Parameters:
<SLatency> integer

Range: 0  to  depends on LL connection timeout and con-
nection event interval

*RST: depends on LL connection timeout and connection
event interval

Example: SOURce1:BB:BTO:UPTY CREQ
Sets packet type CONNECT_IND.
SOURce1:BB:BTO:ECON:PCON:SLAT 10
Sets the number of consecutive connection events.

Manual operation: See "Peripheral Latency" on page 78

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits <Unit>

Indicates the units used by the "Sync Packet Offset" parameter, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
Parameters:
<Unit> U30 | U300

U30
30 µs
U300
300 µs
*RST: U30

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Offset Units" on page 74
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPOFfset
<SPOffset>

Specifies the time from the start of the AUX_ADV_IND packet containing the SyncInfo
field to the start of the AUX_SYNC_IND packet. The offset is determined by multiplying
the value by the unit, see

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SOUNits
Parameters:
<SPOffset> float

Range: 0 to 245.7 or 246 to 2457 depending on offset unit

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117

Manual operation: See "Sync Packet Offset" on page 73

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SVNumber
<SvNumber>, <BitCount>

Sets a unique value for each implementation or revision of an implementation of the
Bluetooth Controller. A 16-bit value is set.

Note: This parameter is relevant for data frame configuration and for the packet type:

LL_VERSION_IND.

Parameters:
<SvNumber> numeric

*RST: 0

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: SOURce1:BB:BTO:ECON:PCON:SVN #H0000,16
Sets the sub version number.

Manual operation: See "SubVersion Number(hex)" on page 84

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:TPOWer <TPower>

Sets the required transmit power to be signaled within an extended header.

Parameters:
<TPower> integer

Range: -127  to  126
*RST: 0

Example: See Example"To configure advertising packets" on page 211.

Options: R&S SMW-K117
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Manual operation: See "TxPow(dBm)" on page 69

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:UTYPe <UType>,
<BitCount>

Enables that an invalid control packet is indicated.

The CtrType field indicates the value of the LL control packet that caused the transmis-
sion of this packet.

Parameters:
<UType> numeric

*RST: #H0

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: SOURce1:BB:BTO:ECON:PCON:UTYP #H00,8
Enables that an invalid control packet is indicated.

Manual operation: See "Unknown Type(hex)" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:VNUMber
<VNumber>, <BitCount>

Sets the company identifier of the manufacturer of the Bluetooth controller. An 8-bit
value is set.

Note: This parameter is relevant for data frame configuration and for the packet type
LL_VERSION_IND.

Parameters:
<VNumber> numeric

*RST: 0

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: SOURce1:BB:BTO:ECON:PCON:VNUM #H00,8
Sets the version number.

Manual operation: See "Version Number(hex)" on page 83

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WOFFset
<WOffset>

Sets the start point of the window transmit for data event and advertising frame config-
uration with the packet type CONNECT_IND.

Command sets the values in ms. Query returns values in s.
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Parameters:
<WOffset> float

Range: 0 s to depending on connection event interval
Increment: 1.25E-3 s
*RST: 0 s
Default unit: ms

Example: See Example"Configure event and frame configuration settings"
on page 180.

Manual operation: See "Transmit Window Offset" on page 54
See "Transmit Window Offset" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:WSIZe <WSize>

Sets the size of the transmit window, regarding to the start point for data event and
advertising frame configuration with the packet type CONNECT_IND.

Parameters:
<WSize> float

Range: 1.25E-3  to  depends on connection event interval
Increment: 1.25E-3
*RST: 1.25E-3

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Transmit Window Size" on page 77

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ATYPe <AType>

Sets the address type in the payload of Bluetooth LE LL_PERIODIC_SYNC_IND pack-
ets.

Parameters:
<AType> PUBLic | RANDom

*RST: PUBLic

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Address Type" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:CECount
<CECount>

Specifies the connection event count in the CtrData field of the LL_PERI-
ODIC_SYNC_IND control data PDU.

Parameters:
<CECount> integer

Range: 0  to  65535
*RST: 0
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Example: See Example"To configure data packets" on page 214.

Manual operation: See "Connection Event Count" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:ID <Id>, <BitCount>

Specifies the ID in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<Id> numeric

*RST: #HAAAA

<BitCount> integer
Range: 16  to  16
*RST: 16

Example: See Example"To configure data packets" on page 214.

Manual operation: See "ID(hex)" on page 87

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:LPECounter
<LPECounter>

Specifies the lastPaEventCounter field in the CtrData field of the LL_PERI-
ODIC_SYNC_IND PDU.

Parameters:
<LPECounter> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Last Pa Event Counter" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:MCLReq
<MCLReq>

Specifies the minimum CTE length in the CtrData field of the LL_CTE_Req PDU.

Parameters:
<MCLReq> float

Range: 16E-6  to  160E-6
Increment: 8E-6
*RST: 16E-6

Example: See Example"To configure data packets" on page 214.

Manual operation: See "MinCTELenReq" on page 89
See "CTETypeReq" on page 89
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L1M:STATe
<State>

Sets the LE 1M PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "PHY" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:L2M:STATe
<State>

Sets the LE 2M PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "PHY" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:PHY:LCOD:STATe
<State>

Sets the LE Coded PHY in the CtrData field of the LL_PERIODIC_SYNC_IND PDU.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "PHY" on page 88

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SCECounter
<SCECounter>

Parameters:
<SCECounter> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure data packets" on page 214.

Manual operation: See "Sync Connection Event Counter" on page 89
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[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SID <Sid>,
<BitCount>

Specifies the SID in the CtrData field of the LL_PERIODIC_SYNC_IND.

Parameters:
<Sid> numeric

*RST: #H0

<BitCount> integer
Range: 4  to  4
*RST: 4

Example: See Example"To configure data packets" on page 214.

Manual operation: See "SID(hex)" on page 88

8.6.4  Cs payload configuration

Example: To configure CS control PDUs
// *****************************************************************************
// Configure settings of an LE uncoded PHY test packet.
// *****************************************************************************
// Set for a data channel test packet in the LE uncoded PHY.
:SOURce1:BB:BTOoth:CTYPe  CS
:SOURce1:BB:BTOoth:UPTYpe CCRQ
// Sets for an LL_CS_CAPABILITIES_REQ control PDU.
:SOURce1:BB:BTOoth:PFORmat L2M

// *****************************************************************************
// Configure and check LL_CS_CONFIG_REQ PDU settings.
// *****************************************************************************
:SOURce1:BB:BTOoth:CS:CDATa:CID 1
// The Config_ID is one.
:SOURce1:BB:BTOoth:CS:CMRepetition 1
// Sets one cycle of the ChM field for non-Mode-0 steps within the CS procedure.
:SOURce1:BB:BTOoth:CS:CDATa:MMODe MODE1
// The main mode is Mode-1.
:SOURce1:BB:BTOoth:CS:CDATa:MMRepetition 0
// The main mode repetition bit is zero.
:SOURce1:BB:BTOoth:CS:CDATa:MMISteps 2
// The minimum number of main mode steps is two.
:SOURce1:BB:BTOoth:CS:CDATa:MMASteps 2
// The maximum number of main mode steps is two.
// Enable the companion signal.
:SOURce1:BB:BTOoth:CS:CDATa:MZSTeps 1
// There is one Mode-0 step.
:SOURce1:BB:BTOoth:CS:CDATA:CSIGnal 1
:SOURce1:BB:BTOoth:CS:CDATA:RFU 0
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// *****************************************************************************
// Configure and check LL_CS_CAPABILITIES_REQ PDU settings.
// *****************************************************************************
:SOURce1:BB:BTOoth:CS:CDATA:CSPCapability?
// Response: "LE2M"
// The PHY is LE 2M.
:SOURce1:BB:BTOoth:CS:CDATa:MAPath 1
:SOURce1:BB:BTOoth:CS:CDATa:MPSupported 1
:SOURce1:BB:BTOoth:CS:CDATa:MTYPe?
// Response: "MODE3"
// The mode type is Mode-3.
:SOURce1:BB:BTOoth:CS:CDATa:NANT?
// Response: "1"
// The number of antenna elements is 1.
:SOURce1:BB:BTOoth:CS:CDATa:NCONfig?
// Response: "1"
// There is one unique Cs configuration. You can have up to four independent
// Cs configurations.
:SOURce1:BB:BTOoth:CS:CDATa:NFAE 1
// The transmitting LE device only supports an FAE of zero.
:SOURce1:BB:BTOoth:CS:CDATa:SPEStimate?
// Response: "0"
// The device does not support PCT estimates from a sounding sequence.
:SOURce1:BB:BTOoth:CS:CDATa:TSW TSW_1
// The duration of the antenna switch period is one microsecond.

// Configure timing capabilities.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition0:TIPO:CAPabitility 1
// Enables the T_IP1 capability for bit position 0. The T_IP1 time is 10 microseconds.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition1:TIPO:CAPabitility?
// Response: "0"
// The T_IP1 capability for bit position 1 is disabled.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition0:TIPT:CAPabitility 1
// Enables the T_IP2 capability for bit position 0. The T_IP2 time is 10 microseconds.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition1:TIPT:CAPabitility?
// Response: "0"
// The T_IP2 capability for bit position 1 is disabled.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition0:TFCAPabitility 1
// Enables the T_FCS capability for bit position 0. The T_FCS time is 15 microseconds.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition1:TFCAPabitility?
// Response: "0"
// The T_FCS capability for bit position 1 is disabled.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition0:TPCAPabitility 1
// Enables the T_PM capability for bit position 0. The T_PM time is 10 microseconds.
:SOURce1:BB:BTOoth:CS:CDATa:BPOSition1:TPCAPabitility?
// Response: "0"
// The T_PM capability for bit position 1 is disabled.

// *****************************************************************************
// Configure and check LL_CS_TERMINATE_IND PDU settings.
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// *****************************************************************************
:SOURce1:BB:BTOoth:CS:CDATa:ECODe #HFF,8
// Sets the error code "FF" in hexadecimal representation.

// *****************************************************************************
// Configure and check LL_CS_IND PDU settings.
// *****************************************************************************
:SOURce1:BB:BTOoth:CS:CDATa:EOFFset 500
// Sets an event offset of 500 microseconds.

// *****************************************************************************
// Configure and check LL_CS_REQ PDU settings.
// *****************************************************************************
:SOURce1:BB:BTOoth:CS:CDATa:MPLength 2.5
// The maximum procedure length is 2.5 milliseconds.

Commands:

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TFCapability..............................254
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPO:CAPability........................ 254
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPT:CAPability......................... 255
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TPCapability............................. 255
[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:CHANnel<ch0>]:CFAE.........................................255
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ACI..................................................................... 256
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CECount............................................................. 256
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CCID:STATe........................................................ 256
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID.....................................................................256
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSAThreec..........................................................257
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSIGnal.............................................................. 257
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ECODe............................................................... 257
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:EOFFset............................................................. 257
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MAPath...............................................................258
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMASteps...........................................................258
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMISteps............................................................258
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMODe.............................................................. 258
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMRepetition...................................................... 259
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPLength............................................................259
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPSupported.......................................................259
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MTYPe?..............................................................260
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MZSTeps.............................................................260
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NANT..................................................................260
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NCONfig............................................................. 260
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NFAE..................................................................261
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NRSCapability..................................................... 261
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NSCapability........................................................261
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMAX.................................................................262
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMIN..................................................................262
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PCOunt...............................................................262
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PDELta............................................................... 262
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PHY?..................................................................263
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PINTerval............................................................ 263
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PPANtenna..........................................................263
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RAONly...............................................................263
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RCAPability......................................................... 264
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU....................................................................264
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RTYPe................................................................ 264
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TFCS..................................................................265
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TIONe.................................................................265
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TITWo.................................................................265
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TPM....................................................................265
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TSW................................................................... 266
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RRSequence....................................................... 266
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RSOunding..........................................................266
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SINTerval............................................................ 267
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SLENgth............................................................. 267
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SNUMber............................................................ 267
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SPEStimate.........................................................268
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SMODe...............................................................268
[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSPCapability?....................................................268

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TFCapability
<TfcsCapability>

Enables the T_FCS capability including the T_FCS time per bit position.

Suffix: 
BPOSition<ch0>

.
0 to 9
Bit position (optional suffix)

Parameters:
<TfcsCapability> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_FCS_Capability Table" on page 118

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPO:CAPability
<TIOCapability>

Enables the T_IP1 capability including the T_IP1 time per bit position.

See also [:SOURce<hw>]:BB:BTOoth:CS[:SEVent<ch0>]:MZERo:TIPO
on page 198.

Suffix: 
BPOSition<ch0>

.
0 to 7
Bit position (optional suffix)

Parameters:
<TIOCapability> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.
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Manual operation: See "T_IP1_Capability Table" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TIPT:CAPability
<TITCapability>

Enables the T_IP2 capability including the T_IP2 time per bit position.

Suffix: 
BPOSition<ch0>

.
0 to 7
Bit position (optional suffix)

Parameters:
<TITCapability> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_IP2_Capability Table" on page 118

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:BPOSition<ch0>]:TPCapability
<TpmCapability>

Enables the T_PM capability including the T_PM time per bit position.

Suffix: 
BPOSition<ch0>

.
0 to 2
Bit position (optional suffix)

Parameters:
<TpmCapability> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_PM_Capability Table" on page 119

[:SOURce<hw>]:BB:BTOoth:CS:CDATa[:CHANnel<ch0>]:CFAE <ChFae>

Sets the value of the fractional frequency offset actuation error (FAE) value per chan-
nel.

Suffix: 
CHANnel<ch0>

.
0 to 71
Channel number (optional suffix)

Parameters:
<ChFae> integer

Range: -128  to  127
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Channel FAE Table" on page 129
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ACI <ACI>

Sets the antenna configuration index (ACI) field. The value has a length of 1 octet or 0
to 7 in decimal representation.

Parameters:
<ACI> ACI0 | ACI1 | ACI2 | ACI3 | ACI4 | ACI5 | ACI6 | ACI7

*RST: ACI0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "ACI" on page 125
See "ACI" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CECount <ConnEventCount>

Sets the 16-bit connEventCount field bits in hexadecimal representation.

Parameters:
<ConnEventCount> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "connEventCount" on page 123
See "connEventCount" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CCID:STATe <State>

Enables the CS configuration ID. Set this ID with the following command:

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID on page 256

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "State" on page 119

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CID <ConfigId>

Sets the 6-bit Config_ID field that is the CS configuration ID. Settable ID values are 2
bits in decimal representation. All other values are for future use.

Parameters:
<ConfigId> integer

Range: 0  to  3
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.
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Manual operation: See "Config_ID" on page 119

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSAThreec <CsaThreec>

Enables the channel selection algorithm #3c.

Parameters:
<CsaThreec> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Channel Selection Algorithm #3c" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSIGnal <CompanionSignal>

Enables the companion signal.

See also "Companion Signal" on page 110.

Parameters:
<CompanionSignal> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Companion_Signal" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:ECODe <ECode>, <BitCount>

Sets an 8-bit error code. For an LL_CS_TERMINATE_IND packet, informs the remote
device about the termination of the connection.

Parameters:
<ECode> numeric

*RST: #H00

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Error Code(hex)" on page 128

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:EOFFset <EventOffset>

Sets the time value of the Offset field. The value has a length of three octets or 9 bits.

Parameters:
<EventOffset> integer

Range: 500  to  4e6
*RST: 500
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Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Offset" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MAPath <MaxAntPath>

Sets the maximum Num_Ant paths.

Parameters:
<MaxAntPath> integer

Range: 1  to  4
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Max_Ant_Path" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMASteps <MMMaxSteps>

Sets the maximum number of main mode steps.

Parameters:
<MMMaxSteps> integer

Range: 2  to  255
*RST: 2

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Main_Mode_Max_Steps" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMISteps <MMMinSteps>

Sets the minimum number of main mode steps.

Parameters:
<MMMinSteps> integer

Range: 2  to  255
*RST: 2

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Main_Mode_Min_Steps" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMODe <MainMode>

Sets the main mode of the CS LL Control PDU.

For an overview on available submodes per main mode, see Table 5-8.
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Parameters:
<MainMode> MODE1 | MODE2 | MODE3

For a description, see [:SOURce<hw>]:BB:BTOoth:CS[:
SEVent<ch0>]:MMODe on page 196.
*RST: MODE1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Main_Mode" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MMRepetition <MMRepetition>

Sets the main mode repetition.

Parameters:
<MMRepetition> integer

Range: 0  to  3
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Main_Mode_Repetition" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPLength <MPLength>

Sets the time value of the Max_Procedure_Len field. The value has a length of two
octets or 6 bits.

Parameters:
<MPLength> float

Range: 2.5  to  40959375
Increment: 0.001
*RST: 2.5

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Max_Procedure_Len" on page 124

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MPSupported <MPSupported>

Sets the bits of the Max_Procedures_Supported field.

Parameters:
<MPSupported> integer

Range: 0  to  4
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Max_Procedures_Supported" on page 117
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MTYPe?

Queries the CS LL control packet mode type that is Mode-3.

Return values: 
<ModeType> MODE3

*RST: MODE3

Example: See Example"To configure CS control PDUs" on page 251.

Usage: Query only

Manual operation: See "Mode_Types" on page 114

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:MZSTeps <Mode0Steps>

Sets the number of Mode-0 steps.

Parameters:
<Mode0Steps> integer

Range: 1  to  3
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Mode_0_Steps" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NANT <NumAnt>

Sets the bits of the Num_Ant field. This field indicates the number of antenna elements
of the channel sounding device.

Parameters:
<NumAnt> integer

Range: 1  to  4
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Num_Ant" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NCONfig <NumConfig>

Sets the Num_Configs field that relates to the number of independent CS configura-
tions.

Parameters:
<NumConfig> integer

Range: 1  to  4
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Num_Configs" on page 117
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NFAE <NoFae>

Sets the No_FAE bit. This bit indicates if the transmitting LE device supports a frac-
tional frequency offset actuation error (FAE) or not.

Parameters:
<NoFae> 1 | ON | 0 | OFF

1|ON
The transmitting LE device only supports an FAE of zero.
0|OFF
The transmitting LE device supports FAE values as listed in an
FAE table.
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "No_FAE" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NRSCapability <NRSCapability>

Sets the NADM random sequence capability.

Parameters:
<NRSCapability> NONADM | NADM

NONADM
NADM disabled
NADM
NADM enabled
*RST: NONADM

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "NADM_Random_Sequence_Capability" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:NSCapability <NSCapability>

Sets the NADM sounding sequence capability.

Parameters:
<NSCapability> NONADM | NADM

NONADM
NADM disabled
NADM
NADM enabled
*RST: NONADM

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "NADM_Sounding_Capability" on page 115
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMAX <OffsetMax>

Sets the time value of the Offset_Max field. The value has a length of 3 octets or 9 bits.

Parameters:
<OffsetMax> integer

Range: 500  to  16777215
*RST: 500

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Offset_Max" on page 124

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:OMIN <OffsetMin>

Sets the time value of the Offset_Min field. The value has a length of 3 octets or 9 bits.

Parameters:
<OffsetMin> integer

Range: 500  to  4e6
*RST: 500

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Offset_Min" on page 123

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PCOunt <ProcCount>

Sets the bits in the Procedure_Count field. The value has a length of 2 octets.

Parameters:
<ProcCount> integer

Range: 1  to  65535
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Procedure_Count" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PDELta <PwrDelta>

Sets the bits in the Pwr_Delta field. The value has a length of 1 octets or 3 bits.

Parameters:
<PwrDelta> integer

Range: 0  to  255
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Pwr_Delta" on page 126
See "Pwr_Delta" on page 128
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[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PHY?

Queries the PHY field value.

This value indicates the TX PHY of the remote device to which the Pwr_Delta field in
this PDU applies.

Return values: 
<Phy> L1M | L2M | LCOD | L2M2B

For a description, see [:SOURce<hw>]:BB:BTOoth:PFORmat
on page 177.
*RST: L1M

Example: See Example"To configure CS control PDUs" on page 251.

Usage: Query only

Manual operation: See "PHY" on page 120
See "PHY" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PINTerval <ProcInterval>

Sets the procedure interval in the Procedure_Interval field. The value has a length of
two octets or 6 bits.

Parameters:
<ProcInterval> integer

Range: 0  to  65535
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Procedure_Interval" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:PPANtenna <PPAntenna>

Sets the bits in the Preferred_Peer_Ant field. The value has a length of one octet or 3
bits.

The table Table 5-11 lists all possible values and their meaning.

Parameters:
<PPAntenna> ANT0 | ANT1 | ANT2 | ANT3

*RST: ANT0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Preferred_Peer_Ant" on page 125

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RAONly <RttAaOnly>

Queries or sets the time values of the RTT_AA_Only_N field.

Setting the value depends on the bits of the RTT_Capability field via the command:
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:SOURce1:BB:BTOoth:CS:CDATa:RCAPability
See also the table Table 5-9 for an overview.

Parameters:
<RttAaOnly> AR150 | AR10 | AR0

*RST: AR150

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "RTT_AA_Only" on page 114

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RCAPability <RttCapability>

Sets the bits in the RTT_Capability field.

These bits determine the time values for the RTT_AA_Only_N field, the RTT_Sound-
ing_ N field and the RTT_Random_Sequence_N field.

Parameters:
<RttCapability> CAP0 | CAP1 | CAP2

See the table Table 5-9 for an overview.
*RST: CAP0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "RTT_Capability" on page 114

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RFU <RFU>

Sets the bits that are reserved for future use (RFU).

The number of RFU bits can vary depending on the CS_Control_Data PDU.

Parameters:
<RFU> integer

Range: 0  to  3
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "RFU" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RTYPe <RttType>

Sets the RTT type determined by the 4-bit RTT_Type field. This field indicates the
round trip time (RTT) variant within the CS procedure.

Parameters:
RttType RAAOT | R32SS | R96SS | R32RS | R64RS | R96RS | R128RS

For a description, see the table Table 5-10.
*RST: RAAOT

Example: See Example"To configure CS control PDUs" on page 251.
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Manual operation: See "RTT_Type" on page 121

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TFCS <TFcs>

Sets the frequency change period (T_FCS) between consecutive CS steps. The period
ranges from 15 μs to 150 μs.

Parameters:
<TFcs> TFCS_15 | TFCS_20 | TFCS_30 | TFCS_40 | TFCS_50 |

TFCS_60 | TFCS_80 | TFCS_100 | TFCS_120 | TFCS_150
TFCS_x, x represents values in microseconds.
*RST: TFCS_150

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_FCS" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TIONe <TipOne>

Sets the time "T_IP1" in microseconds.

Parameters:
<TipOne> TIP1_10 | TIP1_20 | TIP1_30 | TIP1_40 | TIP1_50 | TIP1_60 |

TIP1_80 | TIP1_145
TP1_x, x represents values in microseconds.
*RST: TIP1_145

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_IP1" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TITWo <TipTwo>

Sets the time "T_IP2" in microseconds.

Parameters:
<TipTwo> TIP2_10 | TIP2_20 | TIP2_30 | TIP2_40 | TIP2_50 | TIP2_60 |

TIP2_80 | TIP2_145
TIP2_x, x represents values in microseconds.
*RST: TIP2_145

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_IP2" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TPM <TPM>

Sets the time "T_PM" in microseconds.
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Parameters:
<TPM> TPM_10 | TPM_20 | TPM_40 | TPM_652

TPM_x, x represents values in microseconds.
*RST: TPM_40

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_PM" on page 122

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:TSW <Tsw>

Sets the T_SW field values that relate to the duration of the antenna switch period.

The local controller uses this period when switching antennas during active transmis-
sions.

Parameters:
<Tsw> TSW_0 | TSW_1 | TSW_2 | TSW_4 | TSW_10

Duration of the antenna switch period is 0, 1, 2, 4 or 10 micro-
seconds.
*RST: n.a. (no preset. default: TSW_0)

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "T_SW" on page 117

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RRSequence <RRSequence>

Queries or sets the time values of the RTT_Random_Sequence_N field.

Setting the value depends on the bits of the RTT_Capability field via the command:

:SOURce1:BB:BTOoth:CS:CDATa:RCAPability
See also the table Table 5-9 for an overview.

Parameters:
<RRSequence> AR150 | AR10 | AR0

*RST: AR150

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "RTT_Random_Sequence_N" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:RSOunding <RSOunding>

Queries or sets the time values of the RTT_Sounding_N field.

Setting the value depends on the bits of the RTT_Capability field via the command:

:SOURce1:BB:BTOoth:CS:CDATa:RCAPability
See also the table Table 5-9 for an overview.
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Parameters:
<RSOunding> AR150 | AR10 | AR0

*RST: AR150

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "RTT_Sounding_N" on page 115

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SINTerval <SubInterval>

Sets or queries the subevent interval.

Setting requires BB:BTOoth:CS:SNUMber 2 or higher. Query is for
BB:BTOoth:CS:SNUMber 1.

See [:SOURce<hw>]:BB:BTOoth:CS:CDATa:SNUMber on page 267.

Parameters:
<SubInterval> integer

Range: 0  to  2.7e11
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Subevent_Interval" on page 124
See "Subevent_Interval" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SLENgth <SubLength>

Sets the subevent length in the Subevent_Len field. The value has a length of three
octets or 9 bits.

Parameters:
<SubLength> integer

Range: 1250  to  4e6
*RST: 1250

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Subevent_Len" on page 125
See "Subevent_Len" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SNUMber <SubNumber>

Sets the number of subevents per event.

Parameters:
<SubNumber> integer

Range: 1  to  32
*RST: 1

Example: See Example"To configure CS control PDUs" on page 251.
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Manual operation: See "Subevent_Per_Event" on page 124
See "Subevents_Per_Event" on page 127

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SPEStimate <SPEstimate>

Sets the Sounding_PCT_Estimate bit. This bit indicates if the device supports phase
correction term (PCT) estimates from a sounding sequence or not.

Parameters:
<SPEstimate> 1 | ON | 0 | OFF

1|ON
The Sounding_PCT_Estimate bit is 1. The device supports PCT
estimates from a sounding sequence.
0|OFF
The Sounding_PCT_Estimate bit is 0. The device does not sup-
port PCT estimates from a sounding sequence.
*RST: 0

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Sounding_PCT_Estimate" on page 116

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:SMODe <SubMode>

Sets the submode of the main mode.

Parameters:
<SubMode> MODE1 | MODE2 | MODE3 | NONE

See the table Table 5-8 for an overview on available submodes
per main mode.
*RST: NONE

Example: See Example"To configure CS control PDUs" on page 251.

Manual operation: See "Sub_Mode" on page 120

[:SOURce<hw>]:BB:BTOoth:CS:CDATa:CSPCapability?

Queries the value of the CS_SYNC_PHY_Capability field that is the LE 2M PHY.

Return values: 
<SyncPhy> LE2M

*RST: LE2M

Example: See Example"To configure CS control PDUs" on page 251.

Usage: Query only

Manual operation: See "CS_SYNC_PHY_Capability" on page 115
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8.7  Test packet configuration commands - LE

Example: To configure test packets
// *****************************************************************************
// Configure settings of an LE uncoded PHY test packet.
// *****************************************************************************
// Set for a data channel test packet in the LE uncoded PHY.
SOURce1:BB:BTOoth:CTYPe DATA
SOURce1:BB:BTOoth:UPTYpe TPAC
SOURce1:BB:BTOoth:PFORmat L1M

// Configure packet interval and header settings.
SOURce1:BB:BTOoth:DTTest:TPConfiguration:TPINterval 12.5
// Sets a test packet interval of 12.5 ms.
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:CPResent 0
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SWORd SW
// Fixed sync word value of 0x94826E8E.
// Alternatively, set a user-defined sync word.
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SWORd UPAT
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:USER FFFFFFFFF
// Sync word is 0xFFFFFFFFF.

// Configure payload settings.
SOURce1:BB:BTOoth:DTTest:TPConfiguration:UPSource PAT3
// Sets a fixed pattern 11111111 as payload.
SOURce1:BB:BTOoth:DTTest:TPConfiguration:UPLength 255
// Sets a payload length of 255 bytes.

// *****************************************************************************
// Also, configure LE coded PHY test packet settings.
// *****************************************************************************
SOURce1:BB:BTOoth:PFORmat LCOD
SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit TWO
// Sets 2 symbols per bit for forward erroc correction coding. 

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit................................... 269
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword............................270
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt............................. 270
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval........................................271
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength.........................................271
[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource........................................ 271

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SPBit <SPB>

Specifies a coding for LE coded packets. The specification for Bluetooth wireless tech-
nology defines two values S for forward error correction: S = 2 symbol/bit and S = 8
symbol/bit.
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Parameters:
<SPB> TWO | EIGHt

*RST: TWO

Example: See Example"To configure test packets" on page 269.

Options: R&S SMW-K117

Manual operation: See "Symbols per a Bit" on page 130

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword
<syncWord>

Sets the 32-bit Sync Word in the packet header field in hexadecimal representation.

Parameters:
<syncWord> SW | UPAT

SW
Fixed value of 0x94826E8E.

UPAT
User-defined pattern allowing 8-digit hexadecimal input via the
following command:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:USERpatt on page 270
*RST: SW

Example: See Example"To configure test packets" on page 269.

Manual operation: See "Sync Word" on page 131

[:SOURce<hw>]:BB:BTOoth:ECONfiguration:PCONfiguration:USERpatt
<userPatt>, <BitCount>

Sets a user-defined pattern of the 32-bit Sync Word.

Using this Sync Word requires the following setting:

SOURce1:BB:BTOoth:ECONfiguration:PCONfiguration:SYNCword UPAT
Parameters:
<userPatt> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  32
*RST: 1

Example: See Example"To configure test packets" on page 269.

Manual operation: See "User Pattern(hex)" on page 131
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[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:TPINterval <TpInterval>

Sets the time interval between two consecutive test packets, regarding the starting
points.

Command sets the values in ms. Query returns values in s.

Parameters:
<TpInterval> float

Range: 0.625E-3 s to 27.5E-3 s - depends on packet char-
acteristics

Increment: 0.625E-3 s
*RST: 0.625E-3 s
Default unit: ms

Example: See Example"To configure test packets" on page 269.

Manual operation: See "Packet Interval" on page 130

[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPLength <UpLength>

Sets the payload length.

Parameters:
<UpLength> integer

Range: 0  to  255
*RST: 37

Example: See Example"To configure test packets" on page 269.

Manual operation: See "Payload Length" on page 132

[:SOURce<hw>]:BB:BTOoth:DTTest:TPConfiguration:UPSource <UpSource>

Selects the data source used for the payload test packets.

Parameters:
<UpSource> PN09 | PAT1 | PAT2 | PN15 | PAT3 | PAT4 | PAT5 | PAT6 | DLIS

PN9|PN15
Pseudo random bit sequences (PRBS) with length in bits. The
length can be 9 bits or 15 bits.
PAT1
Predefined pattern: 11110000
PAT2
Predefined pattern: 10101010
PAT3
Predefined pattern: 11111111
PAT4
Predefined pattern: 00000000
PAT5
Predefined pattern: 00001111
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PAT6
Predefined pattern: 01010101
DLISt
Binary data from data lists as a data source. Set the data list file
via the following command:
[:SOURce<hw>]:BB:BTOoth:ECONfiguration:
PCONfiguration:DATA:DSELection on page 232
*RST: PN09

Example: See Example"To configure test packets" on page 269.

Manual operation: See "Payload Type" on page 131

8.8  Channel configuration commands - BR/EDR

[:SOURce<hw>]:BB:BTOoth:PTYPe................................................................................ 272
[:SOURce<hw>]:BB:BTOoth:SLENgth..............................................................................272
[:SOURce<hw>]:BB:BTOoth:STIMing...............................................................................273

[:SOURce<hw>]:BB:BTOoth:PTYPe <PType>

The available packets depend on the selected transport mode. All packet types as
defined in the Bluetooth specifications are supported.

Parameters:
<PType> ID | NULL | POLL | FHS | DM1 | DH1 | DM3 | DH3 | DM5 | DH5 |

AUX1 | ADH1 | ADH3 | ADH5 | AEDH1 | AEDH3 | AEDH5 |
HV1 | HV2 | HV3 | DV | EV3 | EV4 | EV5 | EEV3 | EEV5 |
EEEV3 | EEEV5
*RST: DH1

Example: BB:BTO:PTYP NULL
Sets a null packet.

Manual operation: See "Packet Type" on page 134

[:SOURce<hw>]:BB:BTOoth:SLENgth <SLength>

Sets the sequence length of the Bluetooth signal in number of frames. This signal is
calculated in advance and output in the arbitrary waveform generator.

Parameters:
<SLength> integer

Range: depends on the number of states in dirty transmitter
test  to  dynamic

*RST: 1

Example: BB:BTO:SLEN 10
sets the sequence length to 10 frames.

Channel configuration commands - BR/EDR



Remote control commandsR&S®SMW-K60/-K117/-K178

273User Manual 1175.6803.02 ─ 26

Manual operation: See "Sequence Length" on page 134

[:SOURce<hw>]:BB:BTOoth:STIMing <SlotTiming>

Selects the Rx slot timing mode.

Parameters:
<SlotTiming> TX | LOOPback

*RST: TX

Example: BB:BTO:PTYP DH3
sets the packet type.
BB:BTO:STIM LOOP
selects loopback test mode.

Manual operation: See "Slot Timing" on page 134

8.9  Packet configuration commands - BR/EDR

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement.......................................274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap....................................................... 274
[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap.......................................................274
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:ACKNowledgement
<Acknowledgement>

Sets the ARQN bit of the packet header..

Parameters:
<Acknowledgement> NAK | ACK

NAK
Request to retransmit the previous payload.
ACK
Previous payload has been received successfully.
*RST: ACK

Example: BB:BTO:PTYP DH1
selects the packet type DH1.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:ACKN ACK
sets positive acknowledgement

Manual operation: See "Acknowledgment" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDALap <BdaLap>, <BitCount>

Sets the lower address part of Bluetooth Device Address. The length of LAP is 24 bits
or 6 hexadecimal figures.

Parameters:
<BdaLap> numeric

Range: #H000000  to  #HFFFFFF
*RST: 80

<BitCount> integer
Range: 8  to  24
*RST: 24

Example: BB:BTO:PCON:BDAL #H000000,24
Sets the lower address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDANap <BdaNap>, <BitCount>

Enters the non-significant address part of Bluetooth Device Address. The length of
NAP is 16 bits or 4 hexadecimal figures.

Parameters:
<BdaNap> numeric

Range: #H0000  to  #HFFFF
*RST: ABCD
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<BitCount> integer
Range: 16  to  16
*RST: 16

Example: BB:BTO:PCON:BDAN #H0000,16
Sets the non-significant address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:BDAUap <BdaUap>, <BitCount>

Enters the upper address part of Bluetooth Device Address. The length of UAP is 8 bits
or 2 hexadecimal figures.

Parameters:
<BdaUap> numeric

Range: #H00  to  #HFF
Increment: 1
*RST: 48

<BitCount> integer
Range: 8  to  8
*RST: 8

Example: BB:BTO:PCON:BDAN #H00,8
Sets the non-significant address part.

Manual operation: See "Bluetooth Device Address (BD_ADDR)" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:CODevice <CoDevice>, <BitCount>

A parameter received during the device discovery procedure, indicates the type of
device and which types of service that are supported.

Parameters:
<CoDevice> numeric

Range: #H000000  to  #HFFFFFF
*RST: #H0

<BitCount> integer
Range: 24  to  24
*RST: 24

Example: BB:BTO:PTYP FHS
Sets the packet type.
BB:BTO:PCON:DSFP PED
Enables the packet editor under data source for the packet.
BB:BTO:PCON:COD #H020104,24
Sets the class of device.

Manual operation: See "Class of Device" on page 140
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA <Data>

Selects the data source used for the payload.

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
*RST: PN09

Example: BB:BTO:PTYP FHS
sets the packet type
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:DATA ALL1
sets the data type.

Manual operation: See "Data Source" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DPATtern <DPattern>,
<BitCount>

Selects the data for a pattern.

Parameters:
<DPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: BB:BTO:PCON:DATA PATT
Sets the data type.
BB:BTO:PCON:DATA:DPAT #B010101,6
Selects the data for a pattern with the length of 6 bits.

Manual operation: See "Data Source" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:DSELection <DSelection>

The command selects data list file.

Parameters:
<DSelection> string

Increment: 1

Example: BB:BTO:PCON:DATA DLIS
selects the data type.
BB:BTO:PCON:DSEL bluetooth_1
selects the file for the data.

Manual operation: See "Data Source" on page 138
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDPAttern <VdPattern>,
<BitCount>

Sets the bit pattern for the voice data.

Parameters:
<VdPattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: BB:BTO:PCON:DATA:PATT
Selects the data type.
BB:BTO:PCON:DATA:VDPA #B010101,6
Selects the bit pattern for the voice data with the length of 24
bits.

Manual operation: See "Data Source (Voice Field)" on page 140

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DATA:VDSElection <VdSelection>

Selects the data list for voice data.

Parameters:
<VdSelection> string

Example: BB:BTO:PCON:VDAT DLIS
selects the data type.
BB:BTO:PCON:VDSE bluetooth_1
selects the file for the data.

Manual operation: See "Data Source (Voice Field)" on page 140

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DLENgth <DLength>

Sets the payload data length in bytes.

Parameters:
<DLength> integer

Range: 0  to  depends on packet type
Increment: 1
*RST: depends on packet type

Example: BB:BTO:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:DLEN 25
sets the data length.

Manual operation: See "Data Length" on page 139
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[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DSFPacket <DsfPacket>

Selects the data source for the selected packet type.

Parameters:
<DsfPacket> PEDit | ADATa

PED
Enables the "Packet Editor". All packet fields can be configured
individually.
ADAT
Fills the generated packets with the selected data source. Useful
if predefined data contents are loaded with a data list file or the
data contents of the packet are not of interest.
*RST: PEDit

Example: BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.

Manual operation: See "Data Source for Packet" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:DWHitening <DWhitening>

Activates the "Data Whitening".

Parameters:
<DWhitening> 1 | ON | 0 | OFF

*RST: 0

Example: BB:BTO:PCON:DWH ON
activates data whitening.

Manual operation: See "Data Whitening" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:EIRPacketfollows <EirPacketFollow>

Indicates that an extended inquiry response packet can follow.

Parameters:
<EirPacketFollow> YES | NO

YES
Indicates that EIR packet follows.
NO
Indicates that EIR packet does not follow.
*RST: NO

Example: BB:BTO:PCON:PTYP FHS
sets the packet type.
BB:BTO:PCON:DSFP PED
enables the packet editor under data source for the packet
BB:BTO:PCON:EIRP YES
the EIR packet follows.
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Manual operation: See "EIR packet follows" on page 139

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:HFControl <HfControl>

The command sets the FLOW bit in the header. This bit indicates start or stop of trans-
mission of packets over the ACL logical transport.

Parameters:
<HfControl> GO | STOP

GO
Allows the other devices to transmit new data.
STOP
Stops the other devices from transmitting data temporarily.
*RST: GO

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet.
BB:BTO:PCON:HFC GO
allows the other devices to transmit new data.

Manual operation: See "Flow Control" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LFSWord <LapForSW>, <BitCount>

Sets the lower address part (LAP) of the sync word for FHS packets. The length of
LAP is 24 bits or 6 hexadecimal figures.

Parameters:
<LapForSW> numeric

Range: #H000000  to  #HFFFFFF
*RST: #H000080

<BitCount> integer
Range: 8  to  24
*RST: 24

Example: BB:BTO:PCON:LFSW #H000080,24

Sets the lower address part.

Manual operation: See "LAP for Sync Word" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:LTADdress <LtAddress>

The command enters the logical transport address for the header. Each Peripheral
active in a piconet is assigned a primary logical transport address (LT_ADDR). The all-
zero LT_ADDR is reserved for broadcast messages.

Packet configuration commands - BR/EDR



Remote control commandsR&S®SMW-K60/-K117/-K178

280User Manual 1175.6803.02 ─ 26

Parameters:
<LtAddress> integer

Range: 0  to  7
Increment: 1
*RST: 0

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:LTAD 0
sets the logical transport address equal zero.

Manual operation: See "Logical Transport Address" on page 137

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PFControl <PfControl>

The command sets the FLOW bit in the payload (flow control per logical link).

Parameters:
<PfControl> GO | STOP

GO
Indicates the start of transmission of ACL packets after a new
connection has been established.
STOP
Indicates the stop of transmission of ACL packets before an
additional amount of payload data is sent.
*RST: GO

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enable packet editor under data source for packet
BB:BTO:PCON:PFC GO
allows the flow per logical link.

Manual operation: See "Flow Control" on page 139

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:PLENgth <PLength>

Sets the packet length in symbols.

Parameters:
<PLength> integer

Range: 1  to  depends on packet type
Increment: 1
*RST: depends on packet type
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Example: BB:BTO:PCON:DSFP ADAT
fills the all data under data source for packet.
BB:BTO:PCON:PLEN 1
sets the packet length.

Manual operation: See "Packet Length" on page 142

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SLAP <State>

Activates synchronization of the lower address part (LAP) of the sync word and Blue-
tooth device address.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: BB:BTO:PCON:SLAP 0

deactivates LAP synchronization.
BB:BTO:PCON:LFSW #H000080,24

sets LAP of the sync word separately.

Manual operation: See "Synchronize LAP with BD_ADDR" on page 136

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SNSValue <SnSvalue>

Sets the start value of the header SEQN bit. The SEQN bit is present in the header to
filter out retransmissions in the destination. The signal generator is altering this bit
automatically on consecutive frames, if a sequence length of at least 2 frames is set.

Parameters:
<SnSvalue> integer

Range: 0  to  1
*RST: 1

Example: BB:BTO:PCON:PTYP DH1
sets the packet type.
BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.
BB:BTO:PCON:SNSV ONE
sets the SEQN bit of the first CRC data packet at the start of a
connection.

Manual operation: See "SEQN Start Value" on page 138

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:SRMode <SrMode>

The command indicates the interval between two consecutive page scan windows,
determines the behavior of the paging device.

Parameters:
<SrMode> R0 | R1 | R2
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R0
The scan interval is equal to the scan window T w page scan
(continuous nscan) and maximal 1.28s.
R1
The scan interval is maximal 1.28s.
R2
The scan interval is maximal 2.56s.
*RST: R0

Example: BB:BTO:PCON:PTYP FHS
sets the packet type.
BB:BTO:PCON:DSFP PED
enables packet editor under data source for packet.
BB:BTO:PCON:SRM R0
sets the scan repetition mode.

Manual operation: See "Scan Repetition Mode" on page 140

[:SOURce<hw>]:BB:BTOoth:PCONfiguration:VDATa <VData>

Selects the data source for the voice field.

Parameters:
<VData> ALL0 | ALL1 | PATTern | PN09 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt
*RST: PN09

Example: BB:BTO:PCON:VDAT ALL1
sets the voice data type.

Manual operation: See "Data Source (Voice Field)" on page 140

8.10  Filter/clipping commands
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[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs.....................................................287
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs......................................................288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss....................................................288
[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine..................................................288
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[:SOURce<hw>]:BB:BTOoth:CLIPping:LEVel <Level>

Sets the limit for level clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Parameters:
<Level> integer

Range: 1  to  100
Increment: 1
*RST: 100
Default unit: PCT

Example: SOURce1:BB:BTO:CLIP:LEV 80
Sets the limit for level clipping to 80% of the maximum level.
SOURce1:BB:BTO:CLIP:STAT ON
Activates level clipping.

Manual operation: See "Clipping Level" on page 148

[:SOURce<hw>]:BB:BTOoth:CLIPping:MODE <Mode>

The command sets the method for level clipping.

Parameters:
<Mode> VECTor | SCALar

VECTor
The reference level is the amplitude | i+jq |.
SCALar
The reference level is the absolute maximum of the I and Q val-
ues.
*RST: VECTor

Example: SOURce1:BB:BTO:CLIP:MODE VECT
Sets the amplitude as reference level.

Manual operation: See "Clipping Mode" on page 149

[:SOURce<hw>]:BB:BTOoth:CLIPping:STATe <State>

Activates level clipping.

The value is defined with the command BB:BTO:CLIPping:LEVel, the mode of cal-
culation with the command BB:BTO:CLIPping:MODE.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: OFF

Example: SOURce1:BB:BTO:CLIP:STAT ON
Activates level clipping.

Manual operation: See "Filter/Clipping" on page 37
See "State" on page 148

[:SOURce<hw>]:BB:BTOoth:FILTer:FILTers?

Queries all configured baseband filters.

These filters are the common GFSK baseband filter and, for some EDR packets, a
DPSK filter. See also Table 7-1.

Return values: 
<filters> string

Example: SOURce1:BB:BTO:FILT:FILT?
// Response: "GFSK, Root Raised Cosine (RRC)"
GFSK is a common baseband filter. Root raised cosine (RRC) is
the π/4 DQPSK filter.
SOURce1:BB:BTO:TMOde?
// Response: "ESCO"
SOURce1:BB:BTO:PTYPe?
// Response: "EEV3"
SOURce1:BB:BTO:PTYPe EV3
SOURce1:BB:BTO:FILT:FILT?
// Response: "GFSK"
GFSK is the only filter.

Usage: Query only

Manual operation: See "Filter/Clipping" on page 37

[:SOURce<hw>]:BB:BTOoth:FILTer:TYPE <Type>

Selects the filters used for π/4 DQPSK and 8DPSK modulations. This opens a selec-
tion window containing all the filters available to the instrument.

Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape
*RST: RCOSine

Example: SOURce1:BB:BTO:FILT:TYPE RCOS
Sets the filter type RCOSine.

Manual operation: See "Filter" on page 146
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[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth <ILength>

Sets the impulse length (the number of filter taps).

Parameters:
<ILength> integer

Range: 1  to  depends on oversampling
*RST: 32

Example: SOURce1:BB:BTO:FILT:ILEN 10
Sets the number of filter tabs to 10.

Manual operation: See "Impulse Length" on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:ILENgth:AUTO[:STATe] <State>

Activates the impulse length state.

If activated, the most sensible parameter values are selected. The value depends on
the coherence check.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:BTO:FILT:ILEN:AUTO ON
Selects the most sensible parameters automatically.

Manual operation: See "Impulse Length" on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling <OSampling>

Sets the upsampling factor.

Parameters:
<OSampling> integer

Range: 1  to  32
*RST: 10

Example: SOURce1:BB:BTO:FILT:OSAM 10
Sets the upsampling factor to 10.

Manual operation: See "Oversampling" on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:OSAMpling:AUTO[:STATe] <State>

Activates the upsampling factor state. If activated, the most sensible parameter values
are selected. The value depends on the coherence check. If deactivated, the values
can be changed manually.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1
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Example: SOURce1:BB:BTO:FILT:OSAM:AUTO ON
The most sensible parameters are selected automatically.

Manual operation: See "Oversampling" on page 145

[:SOURce<hw>]:BB:BTOoth:FILTer:MINDex <MIndex>

Queries the modulation index resulting from the entered frequency deviation value.

Parameters:
<MIndex> string

Example: SOURce1:BB:BTO:FILT:MIND?
Queries the modulation index
// Response: "0.5"

Manual operation: See "Modulation Index" on page 147

[:SOURce<hw>]:BB:BTOoth:FILTer:MTYPe <MType>

Queries the modulation type used for the current packet selection.

Parameters:
<MType> string

Example: SOURce1:BB:BTO:FILT:MTYP?
Queries the modulation type

Manual operation: See "Modulation Type" on page 147

[:SOURce<hw>]:BB:BTOoth:MSETtings:FDEViation <FDeviation>

Sets the frequency deviation.

Parameters:
<FDeviation> float

Range: Depends on Bluetooth mode
Increment: 0.1
*RST: depends on Bluetooth mode

Example: SOURce1:BB:BTO:MSET:FDEV 160
Sets a frequency deviation of 160 kHz.

Manual operation: See "Frequency Deviation" on page 147

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:APCO25 <Apco25>

Sets the roll-off factor for filter type APCO25.
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Parameters:
<Apco25> float

Range: 0.05  to  0.99
Increment: 0.01
*RST: 0.2

Example: SOURce1:BB:BTO:FILT:PAR:APCO25 0.2
Sets the roll-off factor to 0.2 for filter type APCO25.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:COSine <Cosine>

Sets the roll-off factor for the Cosine filter type.

Parameters:
<Cosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.1

Example: SOURce1:BB:BTO:FILT:PAR:COS 0.35
Sets the roll-off factor to 0.35 for filter type Cosine.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:FGAuss <FGauss>

Sets the B x T for the Gauss filter type.

Parameters:
<FGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:FGA 0.5
Sets B x T to 0.5 for the Gauss filter type for the GFSK section
of the packet.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:GAUSs <Gauss>

Sets the B x T for the Gauss filter type.
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Parameters:
<Gauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:GAUS 0.5
Sets B x T to 0.5 for the Gauss filter type for π/4 DQPSK or
8DPSK sections.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:LPASs <LPass>

Sets the cut off frequency factor for a lowpass filter (ACP Opt.).

Parameters:
<LPass> float

Range: 0.05  to  2
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:LPAS 1
Sets the cut off frequency factor for a lowpass filter.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146
See "Cut Off Frequency Factor" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:PGAuss <PGauss>

Sets the B x T for the Pure Gauss filter type.

Parameters:
<PGauss> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.5

Example: SOURce1:BB:BTO:FILT:PAR:PGA 0.5
Sets B x T to 0.5 for the Pure Gauss filter type.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:RCOSine <RCosine>

Sets the roll-off factor for the Root Cosine filter type.
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Parameters:
<RCosine> float

Range: 0  to  1
Increment: 0.01
*RST: 0.4

Example: SOURce1:BB:BTO:FILT:PAR:RCOS 0.22
Sets the roll-off factor to 0.22 for filter type Root Cosine.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:FILTer:PARameter:SPHase <SPhase>

Sets the BxT for the split phase filter type.

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: SOURce1:BB:BTO:FILT:PAR:SPH 0.5
Sets B x T to 0.5 for the Split Phase filter type.

Manual operation: See "B*T" on page 144
See "Roll Off Factor/B*T" on page 146

[:SOURce<hw>]:BB:BTOoth:SRATe:VARiation <Variation>

Sets the symbol rate.

Parameters:
<Variation> float

Range: 4E2  to  15E6
Increment: 1E-3
*RST: 1E6

Example: BB:BTO:SRAT:VAR 1
sets the symbol rate variation to 1 MHz.

Manual operation: See "Symbol Rate Variation" on page 148

8.11  Power ramping commands

[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset..............................................................290
[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction.......................................................... 290
[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset............................................................. 290
[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe.................................................................291
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[:SOURce<hw>]:BB:BTOoth:PRAMping:FOFFset <FOffset>

Sets the offset of the falling edge of a burst. The offset is specified by the selected
number of symbols.

Negative values shift the falling edge to earlier positions, which results in a correspond-
ing number of skipped symbols at the end of the burst.

Positive values shift the falling edge to later positions, which results in a corresponding
number of added 0 padding symbols following the burst.

Parameters:
<FOffset> integer

Range: -32  to  32
Increment: 1
*RST: 0

Example: BB:BTO:PRAM:FOFF 8
Adds eight symbols at the end of the burst.

Manual operation: See "Fall Offset" on page 150

[:SOURce<hw>]:BB:BTOoth:PRAMping:RFUNction <RFunction>

The command selects the form of the transmitted power, i.e. the shape of the rising
and falling edges during power ramp control.

Parameters:
<RFunction> LINear | COSine

*RST: COSine

Example: BB:BTO:PRAM:RFUN LIN
sets linear shape for the rising and falling edges during power
ramp control.

Manual operation: See "Ramp Function" on page 150

[:SOURce<hw>]:BB:BTOoth:PRAMping:ROFFset <ROffset>

Sets the offset of the rising edge of a burst. The offset is specified by the selected num-
ber of symbols.

Negative values shift the rising edge to earlier positions, which results in a correspond-
ing number of added 0 padding symbols before the burst.

Positive values shift the rising edge to later positions, which results in a corresponding
number of skipped symbols at the beginning of the burst.

Parameters:
<ROffset> integer

Range: -32  to  32
Increment: 1
*RST: -2
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Example: BB:BTO:PRAM:ROFF 8
Skips eight symbols at the beginning of the burst.

Manual operation: See "Rise Offset" on page 150

[:SOURce<hw>]:BB:BTOoth:PRAMping:RTIMe <RTime>

Sets the ramp time, which extends the burst by a corresponding number of 0 padding
symbols at the beginning and the end of a burst. During this period of time, power
ramping is based on the specified ramp function.

Parameters:
<RTime> integer

Range: 1  to  32
Increment: 1
*RST: 2

Example: BB:BTO:PRAM:TIME 2
Extends the burst by 2 symbols at the beginning and end of the
burst.

Manual operation: See "Ramp Time" on page 150

8.12  Trigger commands

Example: To configure an external trigger
// ******************************************************************
// Configure trigger in armed retrigger mode, set source, enable
// synchronization to external trigger, set external
// inhibit and delay.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:SEQuence ARET
SOURce1:BB:BTOoth:TRIGger:SOURce EGT1
SOURce1:BB:BTOoth:TRIGger:EXTernal:SYNChronize:OUTPut 1
SOURce1:BB:BTOoth:TRIGger:EXTernal:INHibit 100
SOURce1:BB:BTOoth:TRIGger:EXTernal:DELay 10
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Example: To configure an internal trigger
// ******************************************************************
// Configure trigger in single mode.
// Set source to internal, specify signal duration 
// unit and duration.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:SEQuence SING
SOURce1:BB:BTOoth:TRIGger:SOURce INT
SOURce1:BB:BTOoth:TRIGger:SLUNit SEQ

SOURce1:BB:BTOoth:TRIGger:SLUNit FRAMe
SOURce1:BB:BTOoth:TRIGger:SLENgth 2

// ******************************************************************
// Alternatively configure trigger in armed retrigger  mode.
// Set source to internal. Enable Bluetooth signal, start 
// the trigger - signal generation starts.  
// Stop signal generation and wait for a trigger 
// event to restart signal generation.
// Query the current trigger signal generation status.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:SEQuence ARETrigger
SOURce1:BB:BTOoth:TRIGger:SOURce INT
SOURce1:BB:BTOoth:STATe 1
SOURce1:BB:BTOoth:TRIGger:EXEcute

SOURce1:BB:BTOoth:TRIGger:ARM:EXECute
// trigger event restarts signal generation
SOURce1:BB:BTOoth:TRIGger:RMODe?
// 1 (running)
SOURce1:BB:BTOoth:TRIG:SOUR OBAS
// sets triggering by the other path
SOURce1:BB:BTOoth:TRIG:INH 200
// sets a restart inhibit for 200 chips following a trigger event
SOURce1:BB:BTOoth:TRIG:OBAS:DEL 50
// sets a delay of 50 symbols for the trigger

[:SOURce<hw>]:BB:BTOoth[:TRIGger]:SEQuence............................................................293
[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce.................................................................293
[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe..................................................................294
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE............................................................ 294
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME............................................................. 294
[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe]..........................................................295
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth................................................................ 295
[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit................................................................... 296
[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute........................................................296
[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute................................................................ 296
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut............................. 296
[:SOURce<hw>]:BB:BTOoth:TRIGger:OBASeband:DELay.................................................296
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[:SOURce<hw>]:BB:BTOoth:TRIGger:OBASeband:INHibit.................................................297
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay....................................................297
[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:INHibit....................................................297

[:SOURce<hw>]:BB:BTOoth[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode:
● AUTO = auto
● RETRigger = retrigger
● AAUTo = armed auto
● ARETrigger = armed retrigger
● SINGle = single

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: See Example"To configure an internal trigger" on page 292.

Manual operation: See "Mode" on page 152

[:SOURce<hw>]:BB:BTOoth:TRIGger:SOURce <Source>

Selects the trigger signal source and determines the way the triggering is executed.
Provided are the following trigger sources:
● INTernal: Internal manual triggering of the instrument
● INTA|INTB: Internal triggering by a signal from the other basebands
● External trigger signal via one of the local or global connectors:

– EGT1|EGT2: External global trigger
– EGC1|EGC2: External global clock
– ELTRigger: External local trigger
– ELCLock: External local clock

● For secondary instruments (SCONfiguration:MULTiinstrument:MODE SEC),
triggering via the external baseband synchronization signal of the primary instru-
ment:
SOURce1:BB:ARB:TRIGger:SOURce BBSY

● OBASeband|BEXTernal|EXTernal: Setting only
Provided only for backward compatibility with other Rohde & Schwarz signal gener-
ators. The R&S SMW200A accepts these values and maps them automatically as
follows:
EXTernal = EGT1, BEXTernal = EGT2, OBASeband = INTA or INTB
(depending on the current baseband)

Parameters:
<Source> INTB|INTernal|OBASeband|EGT1|EGT2|EGC1|EGC2|ELTRig-

ger|INTA|ELCLock|BEXTernal|EXTernal | BBSY
*RST: INTernal
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Example: See Example"To configure an external trigger" on page 291.

Example: See Example"To configure an internal trigger" on page 292.

Options: ELTRigger|ELCLock require R&S SMW-B10
BBSY require R&S SMW-B9

Manual operation: See "Source" on page 154

[:SOURce<hw>]:BB:BTOoth:TRIGger:RMODe <RMode>

Queries signal generation status for all trigger modes with Bluetooth modulation on.

Parameters:
<RMode> RUN | STOP

*RST: STOP

Example: See Example"To configure an internal trigger" on page 292.

Manual operation: See "Running/Stopped" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:DATE <Year>, <Month>, <Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> Range: 1  to  31
Increment: 1

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMW200A user manual.

Manual operation: See "Trigger Time" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME:TIME <Time>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe

Trigger commands



Remote control commandsR&S®SMW-K60/-K117/-K178

295User Manual 1175.6803.02 ─ 26

<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Time> string

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMW200A user manual.

Manual operation: See "Trigger Time" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:TIME[:STATe] <Hour>, <Minute>, <Second>

Activates time-based triggering with a fixed time reference. If activated, the
R&S SMW200A triggers signal generation when its operating system time matches a
specified time.

Specify the trigger date and trigger time with the following commands:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:TIME
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> integer
Range: 0  to  59

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMW200A user manual.

Manual operation: See "Time Based Trigger" on page 153

[:SOURce<hw>]:BB:BTOoth:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence that is output in the SINGle trigger mode.

Parameters:
<SLength> integer

Range: 1  to  7000
*RST: 1

Example: See Example"To configure an internal trigger" on page 292.

Manual operation: See "Signal Duration" on page 153
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[:SOURce<hw>]:BB:BTOoth:TRIGger:SLUNit <SlUnit>

Defines the unit for the entry of the signal sequence length.

Parameters:
<SlUnit> FRAMe | SEQuence | EVENt

FRAMe
A single frame is generated after a trigger event.
SEQuence
A single sequence is generated after a trigger event.
*RST: SEQuence

Example: See Example"To configure an internal trigger" on page 292.

Manual operation: See "Signal Duration Unit" on page 152

[:SOURce<hw>]:BB:BTOoth:TRIGger:ARM:EXECute

Stops signal generation; a subsequent trigger event restarts signal generation.

Example: See Example"To configure an internal trigger" on page 292.

Usage: Event

Manual operation: See "Arm" on page 154

[:SOURce<hw>]:BB:BTOoth:TRIGger:EXECute

Executes a trigger.

Example: See Example"To configure an internal trigger" on page 292.

Usage: Event

Manual operation: See "Execute Trigger" on page 154

[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:SYNChronize:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To configure an external trigger" on page 291.

Manual operation: See "Sync. Output to Ext. Trigger/Sync. Output to Trigger"
on page 154

[:SOURce<hw>]:BB:BTOoth:TRIGger:OBASeband:DELay <Delay>

Sets the trigger delay (expressed as a number of samples) for triggering by the trigger
signal from the second path.
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Parameters:
<Delay> float

Range: 0  to  2147483647
Increment: 0.01
*RST: 0

Example: See Example"To configure an internal trigger" on page 292.

Manual operation: See "External Delay/Trigger Delay" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger:OBASeband:INHibit <Inhibit>

For triggering via the other path, specifies the duration by which a restart is inhibited.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: See Example"To configure an internal trigger" on page 292.

Manual operation: See "External Inhibit/Trigger Inhibit" on page 155

[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:DELay <Delay>

Sets the trigger delay.

Parameters:
<Delay> float

Range: 0  to  2147483647
Increment: 0.01
*RST: 0

Example: See Example"To configure an external trigger" on page 291.

Manual operation: See "External Delay/Trigger Delay" on page 156

[:SOURce<hw>]:BB:BTOoth:TRIGger[:EXTernal]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following an exter-
nal trigger event.

Parameters:
<Inhibit> integer

Range: 0  to  21.47*symbRate
*RST: 0

Example: See Example"To configure an external trigger" on page 291.

Manual operation: See "External Inhibit/Trigger Inhibit" on page 155

Trigger commands



Remote control commandsR&S®SMW-K60/-K117/-K178

298User Manual 1175.6803.02 ─ 26

8.13  Marker commands

Example: To configure a marker signal
// ******************************************************************
// Configure marker mode: set a marker at ARB sequence start.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE RESTart
// SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE STARt
// SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE ACTive

// ******************************************************************
// Alternatively configure pulse marker. Set pulse 
// divider and frequency
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE PULSe
SOURce1:BB:BTOoth:TRIGger:OUTPut1:PULSe:DIVider 2
SOURce1:BB:BTOoth:TRIGger:OUTPut1:PULSe:FREQuency?
// 500000

// ******************************************************************
// Alternatively configure bit pattern marker. Specify pattern.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE PATTern
SOURce1:BB:BTOoth:TRIGger:OUTPut1:PATTern #H2,2
// ******************************************************************
// Alternatively configure on/off ratio marker. Set on/off time.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:MODE RAT
SOURce1:BB:BTOoth:TRIGger:OUTPut1:ONTime 40000
SOURce1:BB:BTOoth:TRIGger:OUTPut1:OFFTime 20000

Example: To configure marker delay
// ******************************************************************
// Enable fixed marker delay. Query the limit for minimum and maximum
// marker delay. Set delay for the marker signal output.
// ******************************************************************
SOURce1:BB:BTOoth:TRIGger:OUTPut1:DELay 1600

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay................................................299
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift.............................................. 299
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE................................................299
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime..............................................300
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:OFFTime............................................ 300
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern............................................. 300
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex.............................................. 301
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:DIVider....................................301
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:FREQuency?........................... 301
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift.............................................. 302
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[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.

Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 0.001
*RST: 0

Example: See Example"To configure marker delay" on page 298.

Manual operation: See "Delay" on page 158

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:FESHift <Shift>

Shifts the falling edge of the marker the specified number of samples.

Negative values result in a shift back of the marker edge.

Parameters:
<Shift> float

Range: dynamic  to  dynamic
Increment: 1E-6
*RST: 0

Example: SOURce1:BB:BTO:TRIG:OUTP1:FESH 10
Shifts the falling edge of marker 1 by 75 samples.

Example: See also Example"To configure a marker signal" on page 298.

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> RESTart | STARt | ACTive | PULSe | PATTern | RATio | IACTive

RESTart
A marker signal is generated at the start of each signal
sequence.
STARt
A marker signal is generated at the start of each event/frame.
ACTive
The marker masks the active part of the event/frame. At the start
of each burst, the marker signal changes to high. It changes
back to low after the end of each burst.
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PULSe
A regular marker signal is generated. The clock frequency is
defined by entering a divider. The frequency is derived by divid-
ing the symbol rate by the divider. The input box for divider
opens when "Pulse" is selected, and the resulting pulse fre-
quency is displayed below.
PATTern
A marker signal that is defined by a bit pattern is generated. The
pattern has a maximum length of 32 bits and is defined in an
input field which opens when pattern is selected.
RATio
A regular marker signal corresponding to the "Time Off" / "Time
On" specifications in the commands
SOURce1:BB:BTO:TRIGger:OUTPut:OFFTime and
SOURce1:BB:BTO:TRIGger:OUTPut:ONTime is generated.
IACTive
The marker masks the inactive part of the event/frame. At the
start of each burst, the marker signal changes to low. It changes
back to high after the end of each burst.
*RST: RESTart

Example: See Example"To configure a marker signal" on page 298.

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:OFFTime <OffTime>
Sets the duration of the ON and OFF periods.
*) If R&S SMW-B9 is installed, the minimum marker duration depends on the sample/
symbol rate.

See chapter "Basics on ..." in the R&S SMW200A user manual.

Parameters:
<OffTime> integer

Range: 1 (R&S SMW-B10) / 1* (R&S SMW-B9)  to 
16777215

*RST: 1

Example: See Example"To configure a marker signal" on page 298.

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PATTern <Pattern>, <BitCount>

Selects the data for a pattern.
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Parameters:
<Pattern> numeric

*RST: #H2

<BitCount> integer
Range: 1  to  64
*RST: 2

Example: See Example"To configure a marker signal" on page 298.

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PINDex <PIndex>

For Bluetooth LE data packets higher than one, sets the packet index. The index corre-
sponds to the transmitted Tx event during the connection interval.

Parameters:
<PIndex> integer

Range: 1  to  depends on "No. Of Tx Packets/Event"
parameter

*RST: 1

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for the clock frequency.
*) If R&S SMW-B9 is installed, the minimum marker duration depends on the sample/
symbol rate.

See chapter "Basics on ..." in the R&S SMW200A user manual.

Parameters:
<Divider> integer

Range: 2 (R&S SMW-B10) / 2* (R&S SMW-B9)  to  1024
*RST: 2

Example: See Example"To configure a marker signal" on page 298.

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the marker pulse frequency.

Return values: 
<Frequency> float

Range: 2  to  1024
Increment: 1E-3
*RST: 2
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Example: See Example"To configure a marker signal" on page 298.

Usage: Query only

Manual operation: See "Mode" on page 157

[:SOURce<hw>]:BB:BTOoth:TRIGger:OUTPut<ch>:RESHift <Shift>

Shifts the rising edge of the marker the specified number of samples.

Negative values result in a shift back of the marker edge.

Parameters:
<Shift> float

Range: dynamic  to  dynamic
Increment: 1E-6
*RST: 0

Example: SOURce1:BB:BTO:TRIG:OUTPut2:RESH -20
Shifts back the rising edge of marker 2 by 20 samples.

Example: See also Example"To configure a marker signal" on page 298.

Manual operation: See "Mode" on page 157

8.14  Clock commands

This section lists the remote control commands to configure the clock.

Example: To configure clock settings
// ******************************************************************
// Select internal clock. 
// ******************************************************************
SOURce1:BB:BTOoth:CLOCk:SOURce INTernal
// ******************************************************************
// Alternatively select external clock. Set its mode.
// ******************************************************************
SOURce1:BB:BTOoth:CLOCk:SOURce ELCL
SOURce1:BB:BTOoth:CLOCk:MODe SAMP

[:SOURce<hw>]:BB:BTOoth:CLOCk:MODE..................................................................... 302
[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce.................................................................. 303

[:SOURce<hw>]:BB:BTOoth:CLOCk:MODE <Mode>

Sets the type of externally supplied clock.

Parameters:
<Mode> SAMPle

*RST: SAMPle

Clock commands
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Example: See Example"To configure clock settings" on page 302.

Options: R&S SMW-B10

Manual operation: See "Clock Mode" on page 160

[:SOURce<hw>]:BB:BTOoth:CLOCk:SOURce <Source>

Selects the clock source:
● INTernal: Internal clock reference
● ELCLock: External local clock
● EXTernal = ELCLock: Setting only

Provided for backward compatibility with other Rohde & Schwarz signal generators

Parameters:
<Source> INTernal|ELCLock|EXTernal

*RST: INTernal

Example: See Example"To configure clock settings" on page 302.

Options: ELCLock requires R&S SMW-B10

Manual operation: See "Clock Source" on page 159

Clock commands
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Glossary: Specifications
Symbols

[1]: Bluetooth SIG: Bluetooth Core Specification, version 5.4
https://www.bluetooth.com/specifications/specs/

[2]: Bluetooth SIG: Channel Sounding, revision CR_PR
https://www.bluetooth.com/specifications/specs/

 

https://www.bluetooth.com/specifications/specs/
https://www.bluetooth.com/specifications/specs/
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[:SOURce<hw>]:BB:BTOoth:BCRole............................................................................................................ 175
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[:SOURce<hw>]:BB:BTOoth:CLOCk:MODE................................................................................................. 302
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